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Guide to Lisa Manuals 

Set up your Lisa following the setup procedures in the 
Lisa accessories box or in Appendix 1, Setup 
Procedures, in the Lisa Owner's Guide. 

Go through Section A, LisaGuide, in the Lisa Owner's 
Guide, for an introduction to the Lisa. 

If your dealer or service representative did not set your 
system Preferences so that the Lisa knows what external 
devices are attached, follow the instructions in Section 
D, Desktop Manager Reference Guide, under Set, in the 
Lisa Owner's Guide. 

~ Go to Section A, Getting Started, in the manual for each 
office tool that you want to learn, for the essentials of 
using that tool. 

Go to Section B, Lisa Fundamentals, in the Lisa Owner's 
Guide, for the background information you need before 
beginning long-term work on the Lisa. 

You are now ready to start doing your own work on the 
Lisa: 
• If you want self-paced instructions for using a tool, go 

to Section B, Tutorial, in that tool manual. 
• If you want instructions for performing specific tasks 

with a tool, go to Section C, Reference Guide, in that 
tool manual. 

For specific instructions on filing and desktop 
management, go to Section D, Desktop Manager 
Reference Guide, in the Lisa Owner's Guide. 

For more information on the Lisa hardware, tips on 
caring for the Lisa, and suggestions for troubleshooting 
when the system isn't working properly, go to the other 
sections of the Lisa Owner's Guide. 
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Customer Satisfaction 
If you discover physical defects in the 
manuals distributed with a Lisa product 
or in the media on which a software 
product is distributed, Apple will 
replace the documentation or media at 
no charge to you during the 90-day 
period after you purchased the product. 

In addition, if Apple releases a 
corrective update to a software product 
during the 90-day period after you 
purchased the software, Apple will 
replace the applicable diskettes and 
documentation with the revised version 
at no charge to you during the six 
months after the date of purchase. 

In some countries the replacement 
period may be different; check with 
your authorized Lisa dealer. Return any 
item to be replaced with proof of 
purchase to Apple or to an authorized 
Lisa dealer. 

Limitation on Warranties and Liability 

All implied warranties concerning this 
manual and media, including implied 
warranties of merchantability and 
fitness for a particular purpose, are 
limited in duration to ninety (90) days 
from the date of original retail 
purchase of this product. 

Even though Apple has tested the 
software described in this manual and 
reviewed its contents, neither Apple 
nor its software suppliers make any 
warranty or representation, either 
express or implied, with respect to 
the software described in this manual, 

© 1983 by Apple Computer, Inc. 
20525 Mariani Avenue 
Cupertino, California 95014 
(408) 996-1010 

its quality, performance, 
merchantability, or fitness for any 
particular purpose. As a result, this 
software is sold "as is," and you the 
purchaser are assuming the entire 
risk as to its quality and performance. 

In no event will Apple or its software 
suppliers be liable for direct, indirect, 
special, incidental, or consequential 
damages resulting from any defect in 
the software or manual, even if they 
have been advised of the possibility of 
such damages. In particular, they shall 
have no liability for any programs or 
data stored in or used with Apple 
products, including the costs of 
recovering or reproducing these 
programs or data. 

The warranty and remedies set forth 
above are exclusive and in lieu of all 
others, oral or written, express or 
implied. No Apple dealer, agent, or 
employee is authorized to make any 
modification, extenSion, or addition to 
this warranty. 

Some states do not allow the exclusion 
or limitation of implied warranties or 
liability for incidental or consequential 
damages, so the above limitation or 
exclusion may not apply to you. This 
warranty gives you specific legal rights, 
and you may also have other rights that 
vary from state to state. 

License and Copyright 

This manual and the software 
(computer programs) described in it are 
copyrighted by Apple or by Apple's 
software suppliers, with all rights 
reserved, and they are covered by the 

Lisa Software License Agreement 
signed by each Lisa owner. Under the 
copyright laws and the License 
Agreement, this manual or the 
programs may not be copied, in whole 
or in part, without the written consent of 
Apple, except in the normal use of the 
software or to make a backup copy. 
This exception does not allow copies to 
be made for others, whether or not 
sold, but all of the material purchased 
(with all backup copies) may be sold, 
given, or loaned to other persons if they 
agree to be bound by the provisions of 
the License Agreement. Copying 
includes translating into another 
language or format. 

You may use the software on any 
computer owned by you, but extra 
copies cannot be made for this 
purpose. For some products, a multi­
use license may be purchased to allow 
the software to be used on more than 
one computer owned by the purchaser, 
including a shared-disk system. 
(Contact your authorized Lisa dealer for 
information on multiuse licenses.) 

Product Revisions 

Unless you have purchased the product 
update service available through your 
authorized Lisa dealer, Apple cannot 
guarantee that you will receive notice of 
a revision to the software described in 
this manual, even if you have returned a 
registration card received with the 
product. You should check periodically 
with your authorized Lisa dealer. 

Apple, Lisa, and the Apple logo are trademarks of Apple Computer, Inc. 
Simultaneously published in the USA and Canada. 

Reorder Apple Product #A6L0144 
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Preface 

LisaWrite is a word processing tool for creating reports, 
memos, letters, and any other kind of writing you do. You 
enter, edit, and format your documents by using the 
mouse and menus. You can then print the document 
using several different type styles. 

This manual contains three kinds of documentation of 
LisaWrite: 

• Section A, Getting Started with LisaWrite, is a quick 
introduction to the tool. It is designed to give you the 
basic skills for using LisaWrite. 

• Section B, LisaWrite Tutorial, is a step-by-step guide to 
the major features of LisaWrite. It includes suggestions 
on how to use LisaWrite efficiently and effectively. 

• Section C, LisaWrite Reference Guide, is a complete 
reference section. It contains instructions for 
performing specific tasks, including the details of how 
each feature works. 

The material in this manual assumes that you have used 
LisaGuide, which teaches you the fundamentals of using 
the Lisa. The LisaGuide diskette came in the front pocket 
of the Lisa Owner's Guide, and instructions for using it 
appear in Section A of that manual. 

Section B, Lisa Fundamentals, of the Lisa Owner's 
Guide, contains important background information 
about setting up and using the Lisa for long-term work. 
Make sure you understand the concepts in that section 
before going on to either the Tutorial or the Reference 
Guide. Refer to Section D, Desktop Manager Reference 
Guide, of the Lisa Owner's Guide, when you need to 
know how to do filing or how to perform any of the other 
tasks outlined in Section B, Lisa Fundamentals. 

· . ·1" 
• •• VII · .. 



... viii I : : : 

The material in this manual can be used in either short or 
long blocks of time. You can complete Getting Started in 
about 30 minutes. Then you can either go through the 
Tutorial one chapter at a time or start creating your own 
documents, looking up procedures in the Reference 
Guide as you need them. 
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Getting Started 
with Lisa Write 

With LisaWrite you can produce all kinds of documents: 
memos, letters, reports - and if you want to make 
revisions, you can do so without having to retype the 
entire document. 

LisaWrite can help you communicate important 
information quickly and effectively, in the format you 
choose. 

Getting Started with LisaWrite is a hands-on exercise. By 
going step by step through an easy example, you will 
quickly become familiar with the basic skills for using 
LisaWrite, and afterward be able to create, edit, file, and 
print your own LisaWrite documents. 

Getting Started ::: I A 1 
with LisaWrite ••• 



Here's what you need 

What You Need 
to Get Started 

• A Lisa set up and plugged in, with the keyboard and mouse attached. 
• A ProFile set up and plugged in, with the Office System and LisaWrite tool on it. 
• A Printer set up and plugged in if you want to print. Make sure your printer is hooked 

up to your Lisa and turned on. Printing is optional. 
• About 30 minutes. 

Note: If your system is not already set up and configured, refer to the Lisa Owner's 
Guide, Appendix 1, Setup Procedures. 

ProFile 

Keyboard 

Mouse 

... A21 : : : Section A 



If you haven't yet gone through LisaGuide, in which Lisa introduces Lisa, now is a good 
time to do so - it will make Getting Started even easier. For instructions on starting 
LisaGuide, refer to the Lisa Owner's Guide, Section A, LisaGuide. 

If you've already gone through a Getting Started for another Lisa tool, you'll see many 
similarities in using LisaWrite - the basic concepts for using each Lisa tool are the 
same. 

Getting Started 
with LisaWrite 
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Starting Up 

What You're About To Do 

Follow the numbered steps below and on the next page to: 

• Turn on and start up your ProFile and Lisa . 
• Learn how to brighten the screen if it has dimmed automatically. 

Note: If your ProFile and Lisa are already on, skip to step 3. The red ProFile light is lit 
when the ProFile is on, and the Lisa on-off button is lit when the Lisa is on. 

Do This 

1 Turn on your ProFile by 
pressing the on-off switch 
on the back, left-hand 
side of the ProFile, as 
shown. 

2 Turn on your Lisa by 
pressing the on-off 
button, at the lower, right­
hand side of the Lisa, as 
shown. 

A41: : : Section A ... 



Do This 

3 After several minutes, 
when the red ProFile light 
stops flashing, your 
screen should look 
something like the one to 
the right. (See something 
different? Refer to the 
Lisa Owner's Guide, 
Section G, 
Troubleshooting.) 

4 If your Lisa has been on ...... 
for a period of time with 
no activity, the screen 
may have automatically 
dimmed. If your screen is 
dim, just move the mouse 
to brighten it. 

Getting Started ::: I AS 
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The Desktop and the Mouse 

What You're About To Do 

The gray area of your screen is called the desktop. Like the desktop of an office desk, 
it's where you do your work. 

The mouse is what you use to communicate with your Lisa - you use it to point out 
what it is you want done. 

To get familiar with your Lisa's desktop and how to use the mouse, follow the steps 
below. 

Do This 

1 Hold the mouse as 
shown. (Don't press the 
mouse button yet.) 

... A61 : : : Section A 



Do This 

2 Slide the mouse on your 
desk to move the pointer 
around the Lisa desktop 
- the gray part of your 
screen. 

Notice the menu bar across the 
top of your screen - it contains 
menus of different actions you 
can take. Along the bottom of 
your screen are various icons -
graphic symbols that stand for 
different things. 

3 To get oriented, move the 
pointer to the different 
spots shown to the right. 
(Trouble making the 
pointer go where you 
want it to go? Lift up and 
reposition the mouse.) 

Getting Started 
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Seeing What's on a Disk 

What You're About To Do 

To get at the document you'll work with, you first need to open the ProFile disk icon as 
descri bed in the steps below. 

The way you'll open the disk will illustrate your Lisa's most general principle: 

• First you select something . 
• Then you do something to what you've selected. 

Do This 

1 Select (highlight) the 
ProFile disk icon by 
placing the tip of the 
pointer on it and clicking 
the mouse button, as 
shown. (Icon not 
highlighted? Try again.) 

... A81: : : Section A 



Do This 

2 Open the selected disk 
icon by choosing Open 
"ProFile" from the File/ 
Print menu. 

Here's how 
• Press and hold with the 
pointer's tip on File/Print 
in the menu bar . 
• Move the pointer down 
and release when Open 
"ProFile" is highlighted. 
(Is the Open menu item 
dim? You probably 
cl icked somewhere else 
on the gray part of the 
screen and deselected 
the ProFile icon. Go back 
to step 1 and make sure 
the ProFile icon is 
selected.) 

3 Notice the window to the 
ProFile that zooms open 
on your Lisa's desktop. 
Your ProFile is like a very 
large file drawer - it's 
where you'll keep most of 
your work. 

~ illJ 
L1SacalC P3jler Lls.aWnte P3jler LlsaPrOJect P3jler LlsaL1St P."er 

LJ LJ LJ 
LlsaGr3jlh E,~ampleS LlsaWnte Examples LlsaPrOJect Examples LlSaL1St Examples 

Getting Started 
with LisaWrite 

e· e el A9 e e e 
e e e 



Pulling a Document 

What You're About To Do 

Inside the ProFile window you should see several stationery pads and folders. The 
LisaWrite Examples folder contains the example you'll be working on here. In the steps 
below, you will: 

• Open the LisaWrite Examples folder. 
• Tear off a sheet from the Getting Started stationery pad that's inside the folder. 
• Move the new sheet, or document, to a clear spot in the folder. 
• Give the new document the name Sales Strategy. 
• Open the document. 

Do This 

• To open the LisaWrite 
Examples folder: 

1 Select the LisaWrite 
Examples folder by 
clicking on it. 

2 Choose Open "LisaWrite 
Examples" from the File/ 
Print menu. 

Notice the window to the 
Lisa Write Examples folder that 
zooms open, and its contents, as 
shown. The "writing" patterns 
on some of the icons in the 
folder show they are Lisa Write 
icons. 

... A 10 I : : : Section A 
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Do This 

• Copies of the Getting 
Started example are on 
the Getting Started 
stationery pad. To tear off 
a sheet from the pad: 

1 Select the Getting 
Started pad icon. 

2 Choose Tear Off 
Stationery from the File/ 
Print menu and wait a 
moment until the new 
document appears, as 
shown. 

• To move the new icon out 
of the way, to a clear spot 
in the folder: 

1 Place the pointer on the 
icon. 

2 Press and hold down the 
mouse button and move 
the icon as shown; then 
release the mouse 
button. 

• To rename the new 
document: 

1 Make sure the untitled 
document icon is still 
selected (highlighted). If 
you've deselected the 
icon by clicking 
elsewhere on the screen, 
select it again by clicking 
on it. 

2 Type the name Sales 
Strategy. (Typing 
mistake? Use the 
(Backspace) key to correct 
it.) 

111I LlsaWllte Examples !IIII 

~ ~ 
cnapter z cnapter 3 cnapter 4 - ~ 
Furmture Memo 

·1111 LlsaW, Ite Examples 1I1I11 

~~___ ~ II II 
Gettmg startea -"'i~r.a_ cnapter 3 Chapter 4 

~ II ---~---~ 
Customers Fl.lrmture Memo _ 

Type Sales Strategy 

~ ~ 
cnapter z cnapter 3 cnapter 4 

til ~ • Furmture Memo Sales 
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Do This 

• To open the Sales 
Strategy document: 

1 Make sure the document 
icon is selected 
(highlighted). 

2 Choose Open "Sales 
Strategy" from the File/ 
Print menu. 

Notice how the icon zooms open 
into a window. Wait a minute -
the hourglass, ~, means wait -
until the LisaWrite tool displays 
the Sales Strategy document, as 
shown. 

... A 121 : : : Section A 
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---Memo -------------------------------------------

To: 

From: 
Subject: 

Date: 

Regional Managers 

Vi ce-Presi dent of Sal es 

Sales Strategy for Next Duarter 

April 5, 1983 

The sales figures are in, Overall sales were were quite 
respect abl e, but not as hi gh as some of us ex pect ed, What 
else is there that we can do? This quarter we are 
implementing two general strategies to increase our sales: 

1) We are strengthening our ad campaign and lowering the 
base price of our standard business phone system, 

2) Starting this quarter, we are providing higher bonuses 
for the top-selling retailers from each region, 

These changes shaul d make us even more compet it i v'e wit h 
similar phone sllstems that are now appearing on the market, 
I wi 11 send out more det ai I s nex t week, PI ease communi cat e Ii] 

1o--;;:""",==thiS information to the retailers in your region as soon ~asIIIIIO~~~ 



The LisaWrite Document 

The Sales Strategy document is now open on your Lisa's desktop. 

Across the menu bar at the top of the screen are the LisaWrite menu names. Each 
menu conatains a list of actions you can take with a LisaWrite document. 

Without pressing the mouse button, move the pointer around the screen and notice 
how the shape of the pointer changes to an arrow pointer, " when it's over the menu 
bar and to a text pointer, I, when it's over the LisaWrite document. 

LisaWrite menu names 

Text Pointer 

--- Memo -------------------------------------------

To: 

From: 

Subject: 

Date: 

Regi onal Managers 

Vi ce-Presi dent of Sal es 

Sales Strategy for Next Quarter 

April 5, 1983 

The sal es fi gures are in. Overall sal es were were quit e 
respectable, but not as high as some of us expected. What 
else is there that we can do? This quarter we are 
implementing two general strategies to increase our sales: 

1) I~e ere strengthening our ad campaign and lowering the 
base pri ce of our st andard busi ness phone S~lst em. 

2) Starting this quarter, we are providing higher bonuses 
for the top-selling retailers from each region. 

These changes should make us even more competitive with 
simI ar phone syst ems t hat are now appeari ng on t he market. 
I 'i.'ill send out more details next week. Please communicate 
this lnformation to the retailers in your region as soon as 

Getting Started A 13 
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What You Are Going To Do 

Imagine you work for a fictional company called Switch­
On Communications, Inc. You have a memo outlining 
next quarter's sales strategy that needs to go out to 
Regional Sales Managers. You want to edit the memo 
first. 

In the next several pages you will learn to: 

1. Add text to the memo. 

2. Replace text in the memo. 

3. Cut text from the memo. 

4. Adjust the margins to indent some text. 

5. Move text by first cutting it, and then pasting it where 
you want it to go. 



When you are finished, your memo will look like the one 
below. Compare it with the memo now on your screen. 

Add text 

Replace text 

File/Print Edit Search Type Style Format U Page layout 

LJ 

--- Memo -------------------------------------------

To: Regional Sales Managers 
r+---....,"""~--your Name 

Subject: Sales Strateg·y for Next Quarter 
~---....,'I'!m!!"!'""--Today 

The sales figures for last quarter are in. Overall sales 
----------------I----were quite respectable, but not as high as some of us 
Cut text expected. This quarter we are implementing two general 

strat egi es to increase our sal es: 

1) ~Ie are strengthening our ad campaign and ________________ 1-______ lowering the base price of our standard 
business phone system. Adjust margins 

2) Starting this quarter, we are providing 
higher bonuses for the top-selling retailers 
from each regi on. 

----------------I---_These changes should make us even more competitive '1lith ~ 
Cut and Paste to move text similar phone systems that are now appearing on the market. () w.___ ."~O~~ 

Getting Started 
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Selecting Text 

What You're About To Do 

The editing you'll do requires that you first be able to select the text you want to work 
on. (First you select something; then you do something to it.) Follow the steps below to 
learn how to quickly select: 

• A word. 
• A paragraph. 
• Text of any length - from a single character, to an entire document. 

Do This 

1 Select (highlight) the 
word "figures" in the first 
sentence of the memo, as 
shown. 

Here's how 
• Place the middle of the 
text painter on the word 
and click twice quickly 
(double-click). (Word not 
selected? Try again -
hold the painter still and 
click twice lightly and 
rapidly.) 

... A161::: Section A 

Double-click on word 

--- Memo ------f-----·----------·---------·------·------

To: 

From: 

Subject: 

Date: 

are in. Overall sal es were were quit e 
respectable, not as high as some of us expected. What 
else is there that we can do? This quarter we are 
implementing two general strategies to increase our sales: 

1) We are strengthening our ad campaign and lowering the 
base price of our standard business phone system. 

2) Starting this quarter, we are providing higher bonuses 
for the top-selling retailers from each region. 

These changes should make us even more competitive with 
similar phone systems that are now appearing on the market. 
I will send out more details next week. Please communicate 
this. information to the retailers in your region as soon as 

~ _1Ga 



Do This 

2 Now select the whole first 
paragraph of the memo, 
as shown. 

Here's how 
• Place the text pointer 
anywhere in the 
paragraph and click three 
times quickly (triple­
click). 

Notice how selecting something 
new cancels the previous 
selection. 

3 Select the second 
sentence of the first 
paragraph, as shown. 

Here's how 
• Place the text pointer 
at the beginning of the 
sentence, right before the 
"0" in "Overall". 
• Hold down the mouse 
button and move the 
pointer directly to the 
beginning of the third 
sentence, right before the 
"W" in "What"; then 
release. (Selection not 
what you want? Just try 
again.) 

Notice that when you selected 
the sentence, you didn't need to 
move the pOinter through every 
word. All you needed to do was 
press at the beginning, move 
directly to the end, and release. 
You can select any amount of 
text this way. 

Triple-click in paragraph 

--- Memo ------------------- -----------------------

To: Regi onal t1anager 

From: 
Subject: 
Date: 

Vice-President 0 Sales 
Sal es Strat egl;' f Nex t Quart er 
April 5,. 1983 

~-Ie ~jle~ fHlure~ jl-e HI. I)"er,jll ~5Ie~ "'ere I,"ere qUIte 
-e~pect:d)le -but not ~~ ~-'I'~lh ~~ ~Dnle of I.I~ e'pecteci. 1,',lh8t 
eLe I~ n,818 th,~~ ",'8 can clDr ITtu~ qual·ter '''8 aloe 
ImplementHII~1 t'''o gener81 ~tnfe'~ae~ tD Incre,3~e c,ur ~8Ie:: 

1) I,~e are strengthening our ad campaign and lowering the 
base price of our standard business phone system. 
2) St art i ng t hi s quart er,. we are provi di ng hi gher bonuses 
for the top-selling retailers from each region. 
These changes should make us even more competitive with 
similar phone systems that are now appearing on the market. 
I will send out more details next week. Please communicate 

Press here Release here 

--- Memo --------------- ------------------.----~-.--

To: 
From: 
Subject: for Next Quarter 
Date: 

else is there that we can do? This quarter we are 
implementing two general strategies to increase our sales: 

1) \~e are strengt heni ng our ad campai gn and 1 o','Ieri ng the 
base price of our standard business phone system. 
2) Starting this quarter, we are providing higher bonuses 
for the top-selling retailers from each region. 
These changes should make us even more competitive with 
simil ar phone syst ems t hat are now appeari ng on t he market. 
I will send out more details next week_ Please communicate 

Getting Started 
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Adding Text 

What You're About To Do 

Follow the steps below to: 

• Insert the word "Sales" between the words "Regional Managers" in the first line of 
the memo . 

• Insert the phrase "for last quarter" after the word "figures" in the first sentence of 
the memo. 

Do This 

1 Select an insertion point, 
a blinking vertical line, 
after the word "Regional" 
by clicking once just after 
the "I", as shown. (Miss? 
Try again.) 

2 Press the (Spacebar) and 

To: 
From: 
Subject: 
Date; 

Click hereJ 

Regiona1 Managers 
Vice-President of Sales 
Sal es Strat egy' for Nex t Quart er 
April 5,. 1983 

The sales figures are in. Overall sales were were quite 
respectabl~ but not as high as some of us expected. What 
else is there that v.Je can do? This quarter \~Ie are 
implementing two general 'strategies to increase our sales; 

type Sales. (Typing To: Regional Managers 

Vice-President of Sales 
mistake? Use the 
(Backspace) key to correct From: 
it.) Subj ect ; Sales Strateg'y' for ~~ext Quarter 

April 5,. 1983 

... A18j: :: Section A 

Date: 

The sal es fi gures are in. Overall sal es v.Jere were quit e 
respectabl~ but not as high as some of us expected. What 
else is there that we can do? This quarter li.Je are 
implementing two general strategies to increase our sales; 



Do This 

3 Follow the same 
procedure to insert the To: 
phrase for last quarter From: 
after the word "figures" 
in the first sentence of the Subject: 
memo, as shown. Date: 

Type this 

Regional Sale ~lanagers 

Vice-Presiden of Sales 
Sales Strateg for Next Quarter 
April 5, 1983 

Notice that as you type, the rest 
of the paragraph adjusts 
automatically between the left 
and right margins. 

The sales figures';'iti~ jil~~i.i~.~ are in. Overall sales 
were were quite respectable, but not as high as some of us 
expected. ~Ihat else is there that we can do? This quarter 
we are implementing two general strategies to increase our 

Getting Started ::: I A 19 
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Replacing Text 

What You're About To Do 

Follow the steps below to replace "Vice-President of Sales" with "your name", and 
"April 5, 1983" with "today's date". 

Do This 

1 Select "Vice-President of 
Sales", as shown. To: 

2 Type your name and 
notice how it 
automatically replaces 
"Vice-President of 
Sales". 

... A20 I : : : Section A 

From: 
Subject: 
Date: 

Sal es Strat eg'y' for Nex t Quart er 
April 51 1983 

The sales figures for last quarter are in. Overall sales 
were were quite respectable l but not as high as some of us 
expected. What else is there that we can do? This quarter 
we are implementing two general strategies to increase our 

To: 
From: 

TYP8t 
Regional ales Managers 

Your Nam~ 
Subject: Sales Strategy for Next Quarter 
Date: April 51 1983 

The sales figures for last quarter are in. Overall sales 
were were quite respectabl~ but not as high as some of us 
expected. What else is there that we can do? This quarter 
we are implementing two general strategies to increase our 



Do This 

3 Follow the same 
procedure of selecting 
and typing to replace 
"April 5, 1983" with 
"today's date". 

To: 

From: 

Subject: 

Date: 

Regional Sales Managers 

Your Name 

Sales Strategy for Next Quarter 

Todayj 

The sales figures for last quarter are in. Overall sales 
were were quite respectable; but not as high as some of us 
expected. 'rihat else is there that we can do? This quarter 
v~e ere implementing two general strategies to increase our 

Getting Started ::: I A21 
with LisaWrite ••• 



Cutting Text 

What You're About To Do 

You need to cut the extra word "were" from the second sentence of the memo and 
then cut the entire third sentence, as described in the steps below. 

Do This 

1 Double-click to select the Double-click to select 

extra word "were" in the T 
second sentence of the F om: 

Regi one.l Sal es Managers 
Your Neme 

memo, as shown. 
S bject: 
D te: 

Sales Strategy for Next Ouarter 
Today' 

T e sales figures for last quarter are in. Overall sales 
were quite respectable, but not as high as some of us 

expected. lA!hat else is there that we can do? This quarter 
we are implementing two general strategies to increase our 

2 Choose Cut from the Edit To; 
menu. (Press and hold on 
Edit in the menu bar; 

From: 
Subject: 

Regional Sales Managers 
Your ~~ame 

Sales Strategy for Next Ouarter 
Today 

move down and release 
on Cut.) 

... A221 : : : Section A 

Date: 

The sales figures for last quarter are in. Overall sales 
were qui t e respect abl e, but not as hi gh as some of us 
expected. What else is there that we can do? This quarter 
we are implementing two general strategies to increase our 
Word is cut 



Do This 

3 Select the entire third To: Regional Sales Managers 
Your Name sentence of the memo, as From: 

shown. (Press before the 
"W" in "What", release Subject: Sales Strategy for Next Quarter 

Today' before the "T" in "This".) Date: 

The sales figures for last quarter are in. Overall sales 
were quite res ectable but not as hi h as some of us 
expected. his quarter 
we are impl menting two general strategies to ncrease our 

Press here Release here 

4 Choose Cut from the Ed it To: Regional Sales Managers 

Your Name menu. From: 
Subject: 
Date: 

Sales Strat eg'y for Next Quarter 

Toda'y' 

The sales figures for le,st querter ere in. Overall sales 
were quite respectable; but not as high as some of us 
expected. ~his querter INe ere implementing tINO general 
strat egi es ~ 0 increase our sal es: 

ISentence is cut 
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Adjusting Margins 

What You're About To Do 

Now you want to adjust the margins of the two numbered paragraphs of the memo so 
that they're indented. You'll start by adjusting the margins of the first numbered 
paragraph, as described below. 

Do This 

1 Triple-click to select the 
first numbered 
paragraph, as shown. 

A241 : : : Section A ... 

Fi Ie/Print Edit Search Type Style Format 1f Page layout 
~ ~~~=-------------, 

111I11 Sales Strategy 111111 

---- Memo ---------------------------------------------

To: 

From: 

Sut1ject: 

Date: 

f=;'e9ional Se.les ~18.na';lers 

Your Name 

Sales Strete'Jy' for Next Quarter 

Today 

The sales figures for last quarter are in. Dveral1 sales 
Viere quite respectable but not 8.S hl'JI", as some of LIS 
expected. This qLI,e.rter we ere implementing two general 
strate9ies to increase our sales: 

Tf",ese CI",8nges should make us even more competitive 'Iii t I", 
slfniler phone s\"steITIs that ere nOI,' 8.ppearin'J on the market. 
I viill senei out more clete.ils ne\t ~'eek. Plea.se communicate 
this infol"rl1e.tion to the retaIlers in ':lour re'Jion as SOOI1 as 



Do This 

2 Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. (The ~ is 
a symbol that stands for 
paragraph.) 

Notice the ruler that pops up 
across your document. The three 
small triangles on the bottom 
half of the ruler are called 
margin markers. They show 
where the margins for the 
selected paragraph are currently 
set. The £. marks the margin of 
the First line of the paragraph, 
the .& marks the Left margin of 
the remaining lines, and the &. 
marks the Right margin of the 
paragraph. 

3 Adjust the First line 
margin marker, £" to 2 
inches, as shown. 

Here's how 
• Place the tip of the 
pointer on the £, . 
• Hold down the mouse 
button and move the 
marker to the right, just 
under the 2 inch mark; 
then release. (Didn't get it 
right the first time? Just 
try again.) 

Notice how the first line of the 
paragraph immediately adjusts 
to the new margin setting. 

First line margin marker 

IIIII Sales Strategy IIIIII 

Regional Sales Menager.; 

Your Name 

Sales Strs.tel~\/ for t'lext Duarter 

Today 

he sales figures for la.st quarter are ill. Dverall sales 
ere quite respectable but not as higrl as some of us 

ed. This qU.'ITter we are implementing two gener.91 
es to increase our sales: 

were quit e respectable, but 'not 8S high as some of us 
expected. Trlis quarter we ere implementing two general 
strs,tegies to increase our sales: 
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Do This 

4 Follow the same 
procedure to adjust the 
left margin marker, &, to 
2 1/4 inches, and the 
right margin marker, .&, 
to 6 inches, as shown. 

5 In order to adjust the 
margins of the second 
numbered paragraph, 
you first need to scroll it 
into view. 

Here's how 
• Place the pointer on 
the bottom scroll arrow 
of the vertical scroll bar. 
The arrow is pOinting 
down, in the direction you 
want to see. 
• Press and hold down 
the mouse button until 
you see the second 
numbered paragraph, as 
shown. 

... A261 : : : Section A 

were quite respectable, but not as higl", as some of us 
expected. This querter we ere implementing two general 
strategies to increase IJur sales: 

Adjust left and right margins 

File/Print Edit Search Type Style Format 1r Page Layout Ruler 

Ll IIIIII Sales Strategy IIIIII 
To: Pegi onal Sal es t1an8.gers 

From: Your N8me 

Subject: S81es Strateg'y' for Next Cluerter 

Date: Today 

The sales figl.lre;:, for lest querter ere In. O\ler8.11 s8les 
were qui te respectat,le, tlUt not 8S I",igh es some of us 
e·(per::ted. This querter we ere lrnplementing two genera1 
strateQ1% to increase our sales: 

These changes shaull] make us e\len more competitive with 
Slmllar phone systems that ere now appearing on the merket. 

'11 ' , ' I ' " '" I ' , '31 ' , ' I ' I I 41 ' I ' I ' , '51 ' I ' I ' , '61 ' I ' I ' I '71 ' I ' I 

Press on bottom scroll arrow 



Do This 

6 Now select the second 
numbered paragraph and 
adjust its margins to the 
same setting as the first 
numbered paragraph. 
Adjust the first line 
margin to 2 inches, the 
left margin to 2 1/4 
inches, and the right 
margin to 6 inches. 

7 When you're finished, 
choose Hide Margin/Tab 
Ruler from the Format ~ 
menu. 

File/Print Edit Search Type Style Format lr Page layout Ruler 

El 
To: 

From: 

111I11 Sales Strategy 11I111 

Regional Sales Managers 

Your Name 

Subject: Sales Strategy for Hext QU8J:ter 

Tocla~i Date: 

The sales figures for last qllarter are in. 01l8rall se.les 
were qlJHe respectaljle, but not as h1(lh as some of :.IS 

expected. Tl"lis qU8l·ter 'N8 a1"8 implementin';1 t\yO genen.l 
stnJe';lies to incre8.se our se.les: 

1) ~IJe are strengthening our ad campe1gn and 
lowering the base price of ollr standard 
business phone sy'stem. 

These changes sholild mal(e LIS even more competitive with 

Adjust all margins 

File/Print Edit Search Type Style Format lr Page layout 
El ~~~~----------~ 

111I11 Sales Strategy 11I111 

To: Reg10nal Sales Managers 

From: Your Name 

Sales Strategy for ~Iext Quarter 

The :-ale8 i1'~lIres for last qU81"ter are in. Overall sales 
were quite respectable. but not as 1"ligl'l as some of us 
e:(pectad. This quarter 'Na ·91"e implementing t\yO ';Ienerel 
strete'Jie, to increase our s."les: 

1) We are stren,~tllemn~1 our ad CernpEt1gn and 
lowering the base price of our standard 
busi neSi phone sy st em. 

The.s.e chenqes competitive wi th 
sinn18r phone systems that '';J:e nmv appe81"lng on the market. 
I "Jlll send out more det8.1ls next \·ieek. Please commIJniu!.te 
thlS 1nformetion to n"le retailer:, 111 'your region 8.S soon as 
possible. Good luci:, for '.·,'het look.s like our best q1l6rter 
':let. 
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Moving Text by Cutting 
and Pasting 

What You're About To Do 

You need to switch the second and third sentences in the last paragraph. You'll do this 
the same way you would move text if you were working with paper - by cutting and 
pasting. 

Do This 

1 If you cannot see the 
entire last paragraph of 
the memo, scroll it into 
view using the bottom 
scroll arrow of the vertical 
scroll bar. 

2 Select the second 
sentence of the last 
paragraph, as shown. 
(Press before "I"; release 
before the "P" in 
"Please" .) 

3 Choose Cut from the Ed it 
menu. 

... A281 : : : Section A 

1) We are strengthening our ad campaign and 
lowering the base price of our standard 
business phone system. 

2) Starting this quarter, we are providing 
higher bonuses for the top-selling retailers 
from each re gi on . 

These changes should make us eli'en more competitive with 
~Siiimr.illar.PI~holneiUSYliislteims.thiailt iarle.nioilw ja.OOleariing on the market. 
Jl lease communicate 
this information to the retailers in you region as soon as 
possible. Good luck for what looks like lJur best quarter 
yet. 

Press herel "IRelease here 

1) We are strengthening our ad campaign and 
lowering the base price of our standard 
business phone system. 

2) Starting this quarter, we are providing 
higher bonuses for the top-selling retailers 
from each regi on. 

These changes should make us even more competitive with 
similar phone systems that are now appearing on the market. 
please communicate this information to the retailers in liour 
region as soon as possible. Good luck for what looks like 
our best quart er yet. IJ 

Sentence is cut 

'0 
OB1 



Do This 

4 Select an insertion point 
before the last sentence 
of the last paragraph, 
where you want the cut 
sentence to be pasted. 
(Click just before the "G" 
in "Good", as shown.) 

5 Choose Paste from the 
Edit menu and notice how 
the sentence you cut is 
pasted into place. 
(Sentence pasted to the 
wrong place? Choose 
Undo Last Change from 
the Ed it menu and go 
back to step 4 to try 
again.) 

1) We are strengthening our ad camplngn 8.nd 
lowering the base price of our standard 
busi ness phone syst em. 

2) Starting this quarter, we are providing 
higher bonuses for the top-selling retailers 
from each regi on. 

These changes should make us even more competitive with 
similar phone systems that are now appearing on the market. 
Please communicate this information to the retailers in ',lour 
region as soon as possible. ~ood luck for what looks like 
our best quarter yet. 

Click here 

1) We are strengt heni ng our ad campai gn and 
1 oweri ng t he base pri ce of our st andard 
busi ness phone syst em. 

2) Starting this quarter, 11e 8.l'8 PIQI·/lding 
higher bonuses for the top-selling retailers 
from each regl on. 

These changes should make us e'v'en more competiti',Je Iinth 
swilar phone s'ystems that are now on the m81'ket. 
Please communicate this 

as possible. ;:Jfi11~f~jMfpjl,i:"gff~¥~r~~t~!t~;~ 
luck for 
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Do This 

6 Your memo is now 
complete. Scroll back up 
to the top of the memo 
using the top scroll arrow 
of the vertical scroll bar, 
as shown. 

... A30 I : : : Section A 

Fi Ie/Print Edit Search Type Style Format 1r Page Layout 

U 

--- Memo -------------------------------------------

To: Regional Sales 11e.nagers 

From: Your ~'8me 

Subject: Sales StrateI~'y for Next Quarter 

Today Date: 

The sales figures for last quarter are in. Overall sales 
were quit e respect abl e, but not as hi gh as some of us 
expected. This quarter we are implementing two general 
strategies to increase our sales: 

1) 1,',1e are strengthening our ad campaign and 
1 oweri ng t he base pri ce of our st andard 
busi ness phone syst ern. 

2) Starting this quarter, we are providing 
higher bonuses for the top-selling retailers 
from each regi on. 

These changes should make us even more competitive with ~ 
similar phone systems that are now appearing on the market. '0 

GBai "E~~~ 



Printing Your Document 
(Optional) 

What You're About To Do 

If you don't want to print your document now, or don't have a printer available, you can 
skip this section and go on to Putting Your Document Away. 

To print a copy of your finished document, follow the steps below. 

Do This 

1 To ensure that your work 
is saved on the ProFile 
before you print, choose 
Save & Continue from the 
File/Print menu. 

2 Make sure your printer is 
hooked up and turned on. 
(Refer to the manual that 
came with your printer for 
information on 
connecting the printer 
and loading paper and 
print ribbons.) 

Getting Started ::: I A31 
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Do This 

3 Choose Print from the 
File/Print menu to bring 
up the Print dialog box 
shown to the right. (See a 
different message on the 
screen? Go to the next 
page and read the 
"Trouble with printing?" 
section.) 

4 The current settings in 
the Print dialog box are 
fine, so use the mouse to 
check "OK", as shown. 
(Trouble? See "Trouble 
with printing?" on the 
next page.) 

Notice that the hourglass 
appears for a few moments -
the hourglass means wait - as 
your Lisa records the 
information necessary to print 
the document. 

5 When your document 
begins printing and you 
see the Monitor the 
Printer dialog box, check 
"Proceed", as shown. 
(Trouble? See "Trouble 
with printing?" on the 
next page.) 

Notice that once the hourglass 
disappears and printing begins, 
you can use your Lisa to do other 
work. 

... A321 : : : Section A 

Edit Search Type Style Format 1f Page Layout 

Print... • Finished Qualit·y 0 Quick Draft (Text Onl'y') 

o While You Wait • ~yhile You Work 

• All Pages 0 Only 

Number of Copies: amwCDITJIIl01Il[]§] 

From: 

Subject: 

Date: 

Your Name 

Sales StrategY' for Next Quarter 

TodaY' 

Edit Search Type Style Format 1r Page Layout 

Print... • Finished Qualit~1 DQuick Draft (Text OnlY') 

o While 'r'ou Viait • While You Work 

• All Pages 0 Only PBoes:; :: : : 

Number of Copies: amwCDITJIIl01Il[]§] 

From: 

Subject: 

Date: 

Your Name 

Sales StrategY' for I~ext Quarter 

TodaY' 

Edit Search Type Style Format 1f Page Layout 

Cancel 

Click OK 

Monitor the Printer.. (Terminate) 

Document being printed: Sales StrateQV 
Copy being printed: 0 Of 0 
Page being printed: 0) Of 2 

If iOU y,'ant to do other work while the document is being printed, 
cllck ProceecL Otl',er<liise, just wait. 

If )IOU do decide to Proceed, you can get back here by chOOSing 
r"1onitor tl',8 Printer from the File/Print menu. You should do that if 
I/O'J hea.r a whistle or if' you want to terminate printing. 

• • --I 

Click Proceed 

I 



Trouble with printing? 

• If you see the alert 
message to the right, 
refer to the Lisa Owner's 
Guide, Section D, 
Desktop Manager 
Reference Guide, under 
Set Printer Configuration. 

• If you see any other alert 
message, follow its 
instructions. If needed, 
refer to the Lisa Owner's 
Guide, Section G, 
Troubleshooting, under 
Printers, or see the 
manual that came with 
your printer. 

• To learn more about 
printing, refer to Section 
C, LisaWrite Reference 
Guide, Chapter 2, under 
Print. 

Edit Search Type Style Format If Page layout 

The document cannot be printed because the 
intended printer does not appear to be 
avai lable. Before you try to print again, 
make sure that your printer is set up the 
way you want and that it is accurately 
described in the Preferences window's 
Device Connections. 

( Cancel 
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Putting Your 
Document Away 

What You're About To Do 

Now that you've finished working on your document, follow the steps below to put it 
away. Even if you chose to print your document and it's still printing, you can continue 
to use your Lisa to do other work. 

Do This 

1 Choose Save & Put Away 
from the File/Print menu. 
(Is the Save & Put Away 
menu item dim? Then you 
need to click in the 
document to make the 
window active.) 

Notice how the window zooms 
down to a document icon back 
in its filing home in the Lisa Write 
Examples folder. 

... A341 : : : Section A 

a, ... : •.• :.:.: •.• m 
L1SacalC Paper 

~ ~ ~ lID 
usaGraph Paper Llsai'lnte P_per UsaPro,leet Paper LlSaLlst Paper 

LJ LJ LJ 
L1SaGr aph Examples Llsal';'nte E:xamples LlsaProJect Examples L1SaList Examples 

LJ 
Tools 

11111', LlsaWllte Examples 111111 

~ ~ 
Chapter 2 Chapter 3 Chapter 4 

~ 
Furmture Memo 
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Starting from Scratch 

What You're About To Do 

In order to start a new document, you need to get a piece of LisaWrite stationery, as 
described below. Blank LisaWrite stationery is in a pad called LisaWrite Paper, in the 
ProFile window. 

Do This 

1 Tear off a sheet from the 
LisaWrite Paper pad at 
the top of the ProFile 
window. (Select the pad 
icon; choose Tear Off 
Stationery from the File/ 
Print menu.) 

2 Don't worry right now 
about moving the untitled 
document out of the way. 
Change the name of the 
untitled document to 
Monthly Goals. (Make 
sure the icon is selected; 
then type.) 

File/Print Edit View Disk 

~I 
• I 

2380 blocks free out of 9690. Backed u : never. 

~ ~ 
Lls>Dalc Paper LlSaGraph Paper LlsaPrOJect Paper 

LJ LJ 
L1SaDalC Examples LlsaGr aph Examples LlsaPro Jeet Examples 

L:J LJ 
Empty Folders Tools 

Type Monthly Goals 

File/Print Edit View Disk 

2380 blocks free out of 9690. Backe up: never. 

LlsaDale Paper 
~ Mont!~~ 

LlsaGraph Paper Llsavinte Paper 
~ 

LlsaProJect Paper 

LJ LJ LJ 
LlsaDalC Examples 

LJ LJ 
Empty Folders Tools 

L1SailSt Paper 

L1SailS t Examples 

L1SailS t Paper 

LJ 
L1Sailst Exarrples L1SaDr aw EXalT 

Getting Started 
with LisaWrite · · ·IA35 ... ... 



Do This 

3 Open the piece of 
LisaWrite paper you 
named Monthly Goals as 
you would any document. 
(Choose Open "Monthly 
Goals" from the File/Print 
menu.) 

4 Once the blank piece of 
LisaWrite stationery 
appears, you are ready to 
begin typing. Some 
things you should know 
about typing into a 
LisaWrite document are 
described in the next 
several pages. 

... A361 : : : Section A 



Starting a New 
Lisa Write Document 

What You're About To Do 

There are several nice things to know about typing into a LisaWrite document: 

• When you're typing, you don't have to press the (Return) key at the end of each line 
like you do when using a typewriter. As you type along, LisaWrite automatically 
"wraps" your words down to the next line for you. This feature is called "word wrap." 
You only need to press (Return) when you want to start a new paragraph . 

• You can quickly correct typing mistakes. Even if you find a typing mistake after 
typing several sentences, you can quickly correct the mistake, and then resume 
typing where you left off. 

These features are illustrated in the steps below. 

Do This 

1 Type a few sentences, or, 
if you're unfamiliar with 
typing, just type anything, 
pressing the (Spacebar) 
now and then. Don't 
press the (Return) key, 
but type enough so you 
can see how the words 
automatically wrap 
around to the next line 
once you reach the right 
margin that's set for 
blank LisaWrite Paper. 

File/Print Edit Search Type Style Forniat 1r Page La1!0ut 

Ll 
One of my goals for next month is. to produqe s. status report for 8s.cll of tl",8 ~ 
tl','O projects I'm working on. I mll 8Iso reI/leW our updatecl customer l1st ancl ¥ 
distribute a list of all our key accounts to the Pegional Sales ~1an8gers. ,Q 

........ 
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Do This 

2 After you have typed a 
few lines of text, press the 
(Return) key and type a 
little more. 

Notice how pressing (Return) 
begins a new paragraph. 

3 Now let's suppose you 
made a typing mistake 
somewhere in the first 
line of text you typed, and 
that you just noticed it. 
Move the pointer to the 
very right of the mistaken 
letter and click once to 
select an insertion point, 
as shown. If you've typed 
something different from 
what's shown to the right, 
just click once after any 
letter in the first line. 
(Insertion point not where 
you want it? Try again -
hold the text pOinter still 
when you click.) 

4 Press the (Backspace) key 
to delete the mistake. 
(Did pressing (Backspace) 
delete more than just one 
letter? You probably held 
down the (Backspace) key 
too long. To retrieve the 
extra letters you deleted, 
hold down the (Shift) 

key, and press the 
(Backspace) key.) 

Note: Holding down any key will 
cause it to repeat automatically 
- this feature is called "auto­
repeat." 

... A381 : : : Section A 

Fi Ie/Print Edit Search Type Style Format 1r Page layout 

Ll 
One of my goals for next monti', is to procluse 8. status report for aacll of tile r:::; 
two projects I'm working on. I \;ill also reVlew our llpda.tecl customer list and r:;::­
distribute a list of all our key accounts to tile Regional Sales ~18118IJers. ,!;;!. 

Next month will also be tile time to review the nevi ad campaign that' s beln~1 
put together.1 

Select an insertion point to 
the right of the mistaken letter 

• •••• 

File/Print Edit Search T 

Ll 
One Of ml.' goals for ne:(t montll is to proclu e a status report for each of the ~ 
two projects I'm workinlJ on. I \;ill also review our upclated customer list and 
clistnljute a list of 811 our ke~1 accounts to the Reglonal Sales Managers. [] 

Next month vHll also be the time to review the new ad campaign that's being 
put t oget her. 

( Backspace) to delete 
the mistaken letter 

Fi Ie/Print Edit Search Type Style Form t 1f Page layout 

One or n1:/ 'Joels for ne:<t montll is to prodle a status report for each of the ~ 
two projects I'm 'ilorking on. I \'iill also review our updated customer list and 
dlstnbute a list of all our ke\' 8.ccounts to the Regional Sales Managers. [] 

~Ie>:t month will also be the time to review the nevl ad campaign that's being 
put t og~t her. 



Do This 

5 Now that the mistaken 
letter is deleted, type in 
the correct one. 

6 To resume typing where 
you left off, move the text 
pointer to the right of the 
last letter in the 
document and click to 
select an insertion point, 
as shown. 

7 Now if you want to type 
some more, type. 
Experiment - try 
different things. Press 
and move across the 
menu bar and look at 
what's in all your menus. 
If you want specific 
information on 
something, look in the 
LisaWrite Reference 
Guide, Section C, or 
check the index. 

Type the correct letter 

File/Print Edit Search Type Style Form t If Page Layout 

lj 
One of m~' 9081s for next montr1 is to proclu e a status report for ee.crl of n·,8 r,::, 
ti','O proJects I'm workin'~ on. I I'lill 81so reVlei'1 our update,] customer llst 8.nd ~ 
distrilJute 8. list of a11 our l<el,1 accounts to tr1e Re'Jlonel Sales ~lan8gers. ~ 
Next month 'Ilill also be the time to revie\"1 the n8'II ed c:3mpai'Jn tl1at' s beln~1 
put together. 

File/Print Edit Search Type Style Format 1f Page Layout 

lj 
One of my I goals for next month is to procll.lce a status report for e8cl1 of tr',e 1"'7" 
two projects I'm ylorking on. I will also review our updated customer llst an,] ~ 
distribute a list of all our ke\' accounts to the Re'Jional Sales Managers. ~ 
Next month \"Iill also be the time to revie\'~ the nevi ad C8mpaign tr~t' s being 
put together. 

To resume typing, select an 
insertion point where you left off 
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Finishing Up 

What You're About To Do 

It is a good idea to save all your documents and clear off your Lisa's desktop at least 
once a day. The steps below illustrate one of the many ways you can manage things on 
the Lisa desktop. 

Note: When you are connecting, disconnecting, moving, or servicing equipment, you 
must turn off the power. But normally, you should turn off your Lisa only at the end of 
each week, and always leave your ProFile turned on. 

Do This 

1 Choose Set Aside 
"Monthly Goals" from the 
File/Print menu and 
notice how Monthly Goals 
is set aside as an icon on 
the desktop. 

Note: When you're working with 
several documents at the same 
time, it's often convenient to 
keep some of them set aside on 
the desktop, where it's easy to 
get at them. 

... A40 I : : : Section A 
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Do This 

2 If you want to file the 
Monthly Goals document 
in a new place, move it to 
a clear area in the 
LisaWrite Examples 
folder, as shown. (Press 
with the pOinter on the 
icon, move it, and release 
when the icon is where 
you want it.) 

3 If you want to throwaway 
the Monthly Goals 
document, move it to the 
Wastebasket icon. When 
the document icon is on 
the Wastebasket and the 
Wastebasket icon 
highlights, release the 
mouse button and wait 
for the document to be 
deposited. 

Note: You can always get back 
the last thing you've thrown 
away by opening the 
Wastebasket icon and moving 
the deposited document back 
out. 

o 
::.ettmg S'tarte(j 

~ 

11111 LlsaWllte Examples 111I11 

~ ~ 
Chapter 2 Chapter 3 Chapter 4 

II ~ 
Furmture Memo Sales Strategy 

Chapter 2 Chapter 3 Chapter 4 

g ~---~----F'Jrmtur!--_--Memo Sales Strategy 
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Do This 

4 Now set aside both the 
LisaWrite Examples 
folder and ProFile by 
choosing Set Aside 
Everything from the File/ 
Print menu. 

Notice that both the Folder and 
ProFile icons are now set aside 
on the desktop. 

5 You can put away the 
LisaWrite Examples 
folder back in its filing 
home in the ProFile even 
when the ProFile window 
is closed. To do so, select 
the LisaWrite Examples 
folder and choose Save & 
Put Away "LisaWrite 
Examples" from the File/ 
Print menu. 

Note: If you want to deselect a 
selected icon, click once when 
the painter is not over the icon. 
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Do This 

6 When you are ready to 
work on something else, 
just open the ProFile 
again. When you want to 
turn off Lisa's power -
for example, over the 
weekend - press the lit 
on-off button, as shown. 
When you turn on the Lisa 
again, everything will 
reappear as you left it 
when you turned the Lisa 
off, including documents 
you may have left open on 
the desktop. Normally, 
you should leave the 
ProFile turned on. 
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Using LisaWrite 

You now have the basic skills necessary for using 
LisaWrite to produce your own LisaWrite documents. 
Because the concepts for using each Lisa tool are the 
same, you also have some of the basic skills for using 
other Lisa tools: LisaCalc, LisaDraw, LisaGraph, LisaList, 
and LisaProject. 

There is much more you can do with LisaWrite. You can 
learn about other LisaWrite features by: 

• Going through other exercises in the LisaWrite Tutorial, 
Section B. 

• Using the LisaWrite Reference Guide, Section C, as you 
do your work. 

• Just experimenting as you use LisaWrite. Remember 
- when experimenting, you usually have to select 
something before taking action with it. It's safe to 
experiment because most of the things you do can be 
undone by choosing Undo Last Change from the Edit 
menu. And if you're experimenting with a document 
you've torn off of a stationery pad, you can try almost 
anything and always start fresh by either choosing 
Revert to Previous Version from the File/Print menu, or 
by throwing the document away into the Wastebasket, 
and tearing off a fresh copy from the same stationery 
pad. 



Other Lisa Write Features 

• Justification of text to the center, left, right, or both left 
and right margins. 

• Choosing from a number of different line spacings and 
spacings between paragraphs. 

• Choosing from a variety of typestyles - you can have 
different typestyles in the same document. 

• Automatic page numbering, with headers and footers. 

• Automatic searching of your document to find 
whatever words or phrases you specify - with 
automatic changes made to them if you want. 

• Cutting and pasting between LisaWrite documents, and 
from LisaCalc to LisaWrite. 
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Guide to Lisa Manuals 

Set up your Lisa following the setup procedures in the 
Lisa accessories box or in Appendix 1, Setup 
Procedures, in the Lisa Owner's Guide. 

Go through Section A, LisaGuide, in the Lisa Owner's 
Guide, for an introduction to the Lisa. 

If your dealer or service representative did not set your 
system Preferences so that the Lisa knows what external 
devices are attached, follow the instructions in Section 
D, Desktop Manager Reference Guide, under Set, in the 
Lisa Owner's Guide. 

Go to Section A, Getting Started, in the manual for each 
office tool that you want to learn, for the essentials of 
using that tool. 

~ Go to Section B, Lisa Fundamentals, in the Lisa Owner's 
Guide, for the background information you need before 
beginning long-term work on the Lisa. 

You are now ready to start doing your own work on the 
Lisa: 
• If you want self-paced instructions for using a tool, go 

to Section B, Tutorial, in that tool manual. 
• If you want instructions for performing specific tasks 

with a tool, go to Section C, Reference Guide, in that 
tool manual. 

For specific instructions on filing and desktop 
management, go to Section D, Desktop Manager 
Reference Guide, in the Lisa Owner's Guide. 

For more information on the Lisa hardware, tips on 
caring for the Lisa, and suggestions for troubleshooting 
when the system isn't working properly, go to the other 
sections of the Lisa Owner's Guide. 
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What's in the 
Lisa Write Tutorial? 

This tutorial teaches you about LisaWrite as it guides you 
step by step through several real-life examples. To get 
the maximum value from it, you should tryout the 
examples on your Lisa as you go through it. 

All major LisaWrite features are covered in the tutorial, 
but not always in fine detail. A complete description of 
each LisaWrite feature can be found in Chapter 2 of 
Section C, the LisaWrite Reference Guide, in this 
manual. 

Before you start this tutorial, be sure you have completed 
LisaGuide, in which Lisa introduces Lisa. You can find the 
LisaGuide diskette in the front pocket of the Lisa 
Owner's Guide. Also, you should have completed Section 
A, Getting Started with LisaWrite, in this manual. If you 
haven't completed one or both already, now is a good 
time to do so. 

To complete the activities in this tutorial, you need 

• The plain LisaWrite stationery pad that is on the 
ProFile . 

• The sample documents for this tutorial that are in the 
LisaWrite Examples folder on the ProFile. 

The arrow symbol ( ~ ) appears before each activity in 
the tutorial, and it means" Do something." For example, 

~ Turn the page to begin the tutorial. 

· · °1 B .. 
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Creating a New Document 

This chapter leads you step by step through the creation 
of a document. By following the activities in this chapter, 
you learn most of the basic features of LisaWrite. You 
learn how to 

• Get a new document. 
• Enter text and make corrections as you type. 
• Edit text by deleting text, adding new text, and moving 

text. 

• Save a document. 
• Print a document. 
• Put the document away. 

Chapter 1 ::: 83 
Creating a New Document ••• 



Getting a New 
Lisa Write 
Document 
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To create a new LisaWrite document, 

~ Open the ProFile 
window by Clicking twice 
on the ProFile icon. 

~ Tear off a sheet of paper 
for the new document by 
clicking twice on the 
LisaWrite stationery pad 
icon. 

~ Name the new document 
by typing your initials 
followed by Ch 1. This 
allows other people to 
use the same ProFile 
and not get their 
documents confused. 

~ Op~n thp. new 
document's window by 
selecting it and choosing 
Open from the File/Print 
menu. 

" "" """ E::!J " 
"":" I=TCtFlle 

.' 
," =",)" 

> ~ ~~ 
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Tenr Off §t:nhfmeq~ 
Make Stationery Pad 

Monitor the Printer ... 

In this chapter you assume the role of a Manager of 
Order Processing. You are in the process of reorganizing 
the department, and want to notify the other 
departmental managers of the changes taking place in 
Order Processing. 



Starting Out When you open a new document, your screen will look 
something like Figure 1. 

x 

Figure 1. Open LisaWrite Document 

If you've used Getting Started with LisaWrite, you're 
already familiar with the menus that appear at the top of 
the screen. If you haven't used them before, you'll be 
introduced to them as you follow the exercises in this 
tutorial. You won't need to use any of them just yet. All 
you need to write with LisaWrite is already available - a 
blank document, and your keyboard. 

Vv'riting with LisaWrite is similar to using a typewriter, 
only easier. On a typewriter, you have to think about 
content, accuracy and format all at once. With LisaWrite 
you need only concern yourself with content to start with, 
because it's so easy to make corrections and add or 
change special formats later. 

Figure 2 shows you a short handwritten memo. In this 
chapter you learn how to enter, change and format text 
to turn this memo into the one shown in Figure 3. 
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Figure 2. Handwritten Memo 

NOVA STEREO INTEROFFICE MEMO 

To: All Departl'l3nt Managers 

FroM: Charles cunninghaM, Order Processing Manager 

Date: July 25, 1982 

Subject: Reorganization of Order Processing Departl'l3nt 

Effective ilTEdiately, order processing will be divided into three departl'l3nts, 
each with a supervisor. 

Telephone Sales -- Ralph McDonnell, Supervisor 

Order Entry -- Diane TucKer, supervisor 

pacKing -- Linaa HugheS, supervisor 

Please give these supervisors your full cooperation. 

Figure 3. Resulting Memo 



Entering Text The empty document on your screen is like a blank piece 
of paper. You write on it by typing on the keyboard. When 
you type, the characters always appear at the insertion 
point on the screen. In a new document like this one, the 
insertion point is always at the top. Standard margins are 
already set by LisaWrite, so all you have to do is type. 
Any special margins and formats can be changed later. 

To start entering the memo, 

~ Press the (Caps Lock) key 
to enter capital letters. 

~ Type 

NOVA STEREO INTEROFFICE MEMORANDUM 

~ Press (Return) to end the line and start a new 
paragraph. 

Notice that LisaWrite automatically inserts extra space 
for you before plaCing the pointer on a new line. When 
you press (Return), you end one paragraph and begin 
another. One of the format settings in LisaWrite is 
paragraph spacing. This setting tells LisaWrite how much 
space to leave when you press (Return). Right now 
paragraph spacing is set to double space. You learn how 
to change it in Chapter 2, Formatting a Document. 

~ Press the (Caps Lock) key again to enter both upper 
and lower case letters. Unlike on a typewriter, 
pressing the (Shift) key does not release the (...."C,.....a-ps--,L:-"o-c ....... k) 

key. 

~ Type 

To: All departmental managers (Return) 

From: Charles Cunningham (Return) 

Date: July 25, 1982 (Return) 

Subject: Reorganization of Order Processing 
Department (Return) 

If you make a mistake, press (Backspace) to erase it, and 
then retype the character. Your document should look 
like Figure 4. 
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Fi 1~/Print Edit Search TYP'e Style Format 1r Page Layout 

lj 
NOVA STEREO INTEROFFICE nEnORANOUrl 

To: All depertrnent al managers 

From: Charl es Cunni nIJI-,8ff1 

De.te: July 25, 1982 

Subject: Reorganization of Drder Processing Oep8l"tment 

Figure 4_ Memo after Entering Initial Text 

The (Backspace) key lets you make corrections quickly as 
you type. But you also want to make changes in the 
middle of existing text quickly. 

The most basic changes to existing text are: 

• Inserting new text within existing text 
• Deleting text 
• ReplaCing text 

Inserting New Text 

To insert new text, place the insertion point where you 
want the new characters to be, and type. Try this in the 
memo. Add a title to Charles Cunningham's name on the 
"From" line: 

~ Move the pOinter just 
after the name 
Cunningham and press 
the mouse button to 
place the insertion point 
there. 

~ Type 

Clinningh1 

, Manager of Order Processing 

Don't press (Return). 



Deleting Text 

You can delete text from a document in several ways. 

Using Cut to Delete Text 

To delete existing text use Cut from the Edit menu. 
Change "MEMORANDUM" to "MEMO": 

~ Place the insertion point ~1E~10. 
just before the" R," 
press and hold the 
mouse button, and pull 
through "RANDUM." 

~ Miss? Try again. 

~ Choose Cut from the 
Edit menu. (Move the 
pointer to Edit on the 
menu bar, press the 
mouse button and hold. 
Pull down to Cut and 
release.) 

Paste 

Select All of Document etA 

"RANDUM" disappears from your text and appears at 
the bottom of the screen on the Clipboard. 

If the Clipboard folder is not visible on your screen, you 
can open it for viewing. If you don't see the Clipboard 
icon, the document window is probably covering it. 
Resize the window until you can see the Clipboard. 

~ Move the pointer to the 
size control box in the 
lower right-hand corner 
of the document 
window. 

~ Press the mouse button and hold it, pulling the mouse 
diagonally up and to the left so that the document 
becomes both shorter and narrower. 

~ Release the mouse button when you can see the 
Clipboard icon. 
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~ Double click on the 
Clipboard icon. I 

The Clipboard window is now active. To continue 
working on the memo, 

~ Move the pointer back into your document window 
and click. 

~ Move the Clipboard down until your screen looks 
like Figure 5. 

Figure 5 shows the screen with the Clipboard open. 

To: All departmental managers 

From: Charl es Cunni ngham, Manager of Order Processi ng 

Date: July 25, 1982 

Subject: Reorganization of Order Processing Department 

Figure 5. Screen after You Open the Clipboard 

Whenever you cut text from your document, it is placed 
temporarily on the Clipboard. Text on the Clipboard 
stays there until you cut or copy another section of text. 
Later in this chapter you'll learn to paste text that has 
been cut and placed on the Clipboard into another 
location in your document. 



Using Backspace to Delete Text 

You can also delete existing text by placing an insertion 
point to the right of the text and using the (Backspace) key. 
When you use the (Backspace) key to delete, the 
characters are not placed on the Clipboard. On the "To" 
line, change "departmental" to "department": 

~ Place the insertion 
point at the right of 
"departmentaL" 

~ Press (Backspace) twice. 

To: All departmentall managers 

(Backspace) can be used to delete selected text, too. Put 
the "al" back at the end of "department." 

~ Type 

al 

~ Now select the two 
characters "al." Place 
the pOinter between the 
"t" and the "a" in 
departmental. Press the 
mouse button and hold 
it down while you pull 
through the "ai," and 
then release the button. 

~ Press (Backspace). 

To: All department; manew;rs 

When used in this way, (Backspace) deletes all selected 
text. The contents of the Clipboard have still not 
changed. 

You can delete spaces and return characters just like any 
other character: select and cut them, or backspace over 
them. So if you press an extra (Return) by mistake, just 
press (Backspace). 

Replacing Text 

To replace text in a document you select the characters 
you want to replace, then type the characters you want 
inserted. 

Capitalize the words "department" and "managers" on 
the "To" line: 

~ Select the "d" in 
department. 

To: All lepartrnent managers 
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~ Type 

D 

Select the "m" in managers. 

~ Type 

M 

In this example, you replaced one letter with another. But 
you aren't limited to using the same number of 
characters when replacing text. You can select one 
character and replace it by an entire sentence, if you 
want. 

Replace "Manager of Order Processing" with "Order 
Processing Manager": 

~ Place the insertion point Cunni ngl-18ff1,1 ,"lanager of 
just before the "M" in I 
Manager. 

~ Press the mouse button 
and pull through to the 
end of the line. 

~ Type 

la,na,ger of ClHler Proce'::::HII~ 

Order Processing Manager 

As soon as you begin typing the replacement text, the 
selected text disappears from the screen. You can type 
as much text as you want, and use the (Backspace) key if 
you make a mistake. 

To add more text to the end of a document, you place the 
insertion point at the end of the existing text and type. 
Although you see additional white space on the screen as 
though it is a piece of blank paper, that space is not 
actually part of your document yet. If you try to place the 
insertion point below your text, LisaWrite automatically 
moves it to the end of your text. 

~ Place the insertion point Dat e : Jul ~/ 25; 1982 
at the bottom of the text 
on your screen. Subject: Reorganizat 



If you can't place the insertion point below the "Subject" 
line of the memo, you forgot to press (Return) when you 
ended the line. In this case, place the insertion point at 
the end of the "Subject" line and press (Return). 

Now that the insertion point is on the bottom line, 

~ Type the following paragraph, being sure to press 
(Return) at the end of the paragraph, but not at the end 
of any other lines: 

Effective immediately, order processing will be 
divided into three departments, each with a 
supervisor. Please give these supervisors your 
full cooperation. (Return) 

We mentioned earlier that LisaWrite has some standard 
margins already set. When the text you type reaches the 
right margin, LisaWrite automatically wraps it around to 
continue on the next line. You only need to press the 
(Return) key when you come to the end of a paragraph. 
This capability, known as word wrap, will increase your 
typing speed tremendously. You need never concern 
yourself with watching for the right margin again! 

To help you get used to word wrap in these exercises, 
only pressthe(Return)keywhen you see the symbol(Return). 

Figure 6 shows what your screen looks like now. 

File/Print Edit Search Type Style Format 11" Page Layout 

U 
NOVA STEREO I NTERO F FI CE 11EMO 

To: All Department t1anagers 

From: Charles Cunningham, Order ProcesSlng Manager 

Date: Jul',.. 25, 1982 

Subject: Reorgamzatlon of Order Processing Departrnent 

Effective imrnediatel'i, o!Jler processing will be divided lnto three 
departments, each with a~upervlsor. Please give these sLlpervlsors 'y'DUr full 
cooperat i on. 

Figure 6. Screen after Entering More Text 
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~ Type 

Telephone Sales -- Ralph McDonnell (Return) 

Order Entry -- Diane Tucker (Return) 

Packing -- Linda Hughes (Return) 

You've now entered the basic content of the memo. 
Figure 7 shows two final changes to be made. 

• Adding titles to the new department supervisors . 
• Moving a paragraph. 

NOVA STEREO INTEROFFICE t1EI10 

To: All Department Managers 

From: Charles CLlnninghem, Order Processing Manager 

Date: Jul'/ 25" 1982 

Subject: Reorganization of Drder F'rocessing Department 

Eff'ective immediatel'y', order processing will be divided into three 
departments, each wHh a supervisor. [Please glve mese supervlsors >'our TUB) 

( cooperatlCl l1. ./ 

Telephone Sales -- Ralph ~lcDonnelll JJ~ • .:~ 

~::":'~:' l::d:':::h:::"1~'-- X 

Figure 7. Final Content of Memo 

Saving Documents 

Before you continue with the final changes, save the text 
you've already entered. It's a good idea to save the 
document you're working on every 15 to 20 minutes. That 
way you have a copy of the work you've done so far 
stored on your disk. You may want to change your mind 
later and revert to a previous draft, or you may need to 
return to an earlier draft in the event of an unforeseen 
power failure. 



To save your document, 

~ Choose Save & Continue 
from the File/Print 
menu. 

Revert to Previous 

That's all it takes to ensure a safe copy of your work. 

Notice that the pointer takes on the shape of an 
hourglass while LisaWrite saves your document. When 
you see this pointer, it means that the Lisa is temporarily 
busy. Wait until the pointer resumes its normal 
appearance before continuing. 

Copying Text 

When you need to insert the same text in different places 
in your document, you can avoid retyping it by using 
Copy from the Edit menu. 

Add", Supervisor" after each of the names: 

~ Place the insertion point at the end of Ralph 
McDonnell's name. 

~ Type 

, Supervisor 

~ Now select the 
characters you just 
typed. Place the 
insertion point just 
before the comma (,) 
and pull through 
"Supervisor." 

~ Choose Copy from the 
Edit menu. 
",Supervisor" appears 
on the Clipboard, 
replacing the previous 
contents. 

Ralph McDonnell; superviso1 

Ral ph t'1cDonnell 

Select All of Document 'A 
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Copy works very similarly to Cut except that a copy of 
selected text is placed on the Clipboard, leaving the 
original text in place. 

~ Now place the insertion 
point at the end of Diane 
Tucker's name. 

~ Choose Paste from the 
Edit menu. 

Telephone Sales -- Ralph McDonnell, 

Order Entry -- Diane Tucke1 

Packing -- Linda Hughes 

Select RII of Document etR 

~ Now place the insertion point on the next line, at the 
end of Linda Hughes' name. 

~ Choose Paste from the Edit menu again . 

•• ___ = __ "' ___ A 

,r,u""'!1 ' C'AI 

You can move text around in a document quickly and 
easily using Cut and Paste from the Edit menu. Earlier in 
this chapter you used Cut to remove unwanted text. Now 
use it to move part of the second paragraph to the end of 
the sample memo. 

To emphasize that you want your managers to cooperate 
with the new supervisors, move the first sentence in the 
second paragraph to the bottom of the memo. 

~ First, place the insertion processi ng Ir,li 11 be di 
point just before the ~r\/i sor . PI ease gi'v'e 
second sentence in the 
paragraph and press 
(Return). This divides the 
paragraph into two 
separate paragraphs. 

~ Now, select the new second paragraph by moving the 
pointer into the second paragraph and triple clicking. 
Triple clicking the mouse button quickly selects the 
entire paragraph. 

lease '~ll,le the~e ~uperl./i SOE' ~Iour f 1.l11 cooperation. 

Telephone Sales -- Ralph McDonnell , Supervisor 



~ Choose Cut from the 
Edit menu. The 
paragraph disappears 
from the body of the 
memo and reappears on 
the Clipboard. 

Select All of Document eiA 

A special feature with your Lisa, Undo Last Change, lets 
you change your mind after doing something. Try it out. 
Undo the cut you just made. 

~ Select Undo Last 
Change from the Edit 
menu. 

Cut 
Copy 
Paste 

Select All of Document eiA 

The paragraph reappears in the memo and disappears 
from the Clipboard. You can undo many changes that 
you make in LisaWrite. You can even undo Undo! 

Remove the paragraph from your text again. 

~ Select Undo Last Change from the Edit menu again. 
The same paragraph is moved from the memo onto 
the Clipboard. 

~ Now place the insertion 
point at the bottom of 
the memo. 

Order Entry -- D1 

Packing -- Linda 

~ Choose Paste from the Edit menu. A copy of the 
paragraph on the Clipboard is placed at the bottom of 
the memo. 

~ If the text of the memo scrolls up, just move the 
pOinter to the upper scroll arrow and click the mouse 
button once. 
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A copy of the paragraph remains on the Clipboard, even 
though you've pasted a copy into the memo. This text 
remains on the Clipboard until you cut or copy another 
section of text. You can paste text from the Clipboard 
into as many portions of the document as you want, or 
into another document. Chapter 6 in this Tutorial shows 
you how to cut and paste from one document to another. 

Paste can also be used to replace text. When text is 
selected in a document and you choose Paste, the text 
on the Clipboard replaces the selected text. 

Changes to the content of the memo are now complete. 
Next you learn to print your document and put it away. 

To print a document, you naturally have to have a printer 
connected to your Lisa. If you don't have a printer, or it is 
not set up, you may skip this section for now, and 
proceed to Putting Your Document Away, later in this 
chapter. 

For how to set up your printer, refer to the manual that 
came with your printer. 

You also need to set up Preferences correctly for your 
printer. If you have not already done this, do this now. For 
how to configure your printer to your Lisa, refer to the 
Set Printer Configuration procedure in Section D, 
Desktop Manager Reference Guide, in the Lisa Owner's 
Guide. 

Once the printer and Preferences have been set up, you 
need to make sure that the printing options for your 
document match the options for your printer. To do this: 

~ Choose Print from the 
File/Print menu. Set Aside Everything 

Set Aside "Ipu-chl" 

Save & Put Away 
Save & (ont i nue 
Revert to Previous Version 

Format for Printer ... 



A Print dialog box appears on your screen: 

Print,,, • Finished quality 0 Quick Draft (Text Only) 

DOne r:op)' While You V,'8Jt • While You Work 

• All Pages 0 Only , __ ,. _ , .............................. .. 

~Jumber of Copies: 11001IlITIITJ[7]ITJ[I]~ 

To see some of the printing capabilities available to you, 
print the document twice, first using Quick Draft, and 
then using Finished Quality. 

~ Check the box next to 
Quick Draft. 

d Quality 0 Quick Draft (Text Only) 

e You Wait • While You Work 

Inly pages: r.:·.·.·.:·.·.~.:·.:· ... ·.:·.~.:· ... ·.:·.·.·.:·.::::·.·.: ..... ~ ... ~.:.J Through: C ......... ::· ..... : 

s: .[TI[I]@][[][!]0[I][I]~ 

~ Click OK in the dialog box. 

Your Lisa then displays a message saying that it is 
preparing to print your document and allow you to 
continue working, since the Print dialog box specified 
that you wanted to print your document while you work. 
After that message, the Lisa displays an alert box asking 
you if you want to cancel the printing or proceed with it. 
To respond to the message, 

~ Click Proceed to 
continue working while 
your document is being 
printed. 

((roceed ) 

If your Lisa cannot print your document while you work, it 
will display a message to let you know that, and you will 
have to wait until the document is finished printing and 
the message disappears. 

The quick draft of your memo prints quickly. When it is 
finished, print another copy, this time a finished quality 
copy, and compare the two. 

~ Choose Print from the File/Print menu. 

~ Check Finished Quality in the print dialog box. 

~ Click OK in the dialog box. 

~ Check Proceed in the 
message box that 
appears. 

( Proceed) 
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This time your document takes longer to print. When it 
finishes, remove it from the printer and compare it with 
the first printed copy. On a dot matrix printer, a built-in 
font is used when you choose Quick Draft, instead of the 
fonts shown on the screen. On a daisy wheel printer, 
whatever print wheel is on the printer will be used, even if 
you've specified a different one in your document. No 
special type styles or fonts are printed in a quick draft, 
but they are in a finished quality draft. Figure 3 at the 
beginning of this chapter shows the memo printed with 
finished quality. 

You learn to use the other settings available in the Print 
dialog box, and with the menu item, Format for Printer, in 
Section C, LisaWrite Reference Guide, Chapter 2, under 
Print. 

When you're finished with a document, you can either 
save it or discard it. You will use the memo you have 
created in the next chapter, so save a copy. 

To save the document you just created, 

~ Choose Save & Put 
Away from the File/Print 
menu. 

The document window closes automatically, and its 
document icon goes back beside the stationery pad in 
the ProFile window. 

Now you can move the document icon to an empty place 
in the disk window. 

~ Move the pOinter into the LisaWrite document icon. 
Press and hold the mouse button while moving the 
icon to any empty place in the disk window. 

~ Release the mouse button. 



The Clipboard window is still open. Leave it open, if you 
like, or close it. If you prefer to close the Clipboard, 

~ Move the pointer into the Clipboard and click the 
mouse button to activate it. Choose Set Aside 
Clipboard from the File/Print menu. 

This completes Chapter 1. Go on to the next chapter, if 
you like, or come back to it at a later time. 
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Get a new document 

Enter text in a new 
document 

Insert new text 

Delete text 

• Open the disk containing 
the stationery pad. 

• Tear off a piece of paper 
from the pad. 

• Name and open the 
document. 

• Type the characters you 
want. They appear at the 
insertion point. 

• Press (Backspace) to erase 
the last character you 
typed. 

• Press (Return) at the end 
of each paragraph, not 
each line. 

• Place the insertion point 
where you want to add 
text. .~ 

• Type the characters you 
want to insert. 

• Select the text to be 
deleted. 

• Choose Cut from the Edit 
menu. 

or 

• Place the insertion pOint 
at the end of the text to 
be deleted. 

• Press (Backspace) once 
for each character you 
want to delete. 

or 

• Select the text to be 
deleted. 

• Press (Backspace). 



Replace text 

Copy text 

Move text 

Undo last change 

Save a document 

• Select the text to be 
replaced. 

• Type the new text. 

• Select the text to be 
copied. 

• Choose Copy from the 
Edit menu. 

• Place the insertion pOint 
where you want the copy 
to go. 

• Choose Paste from the 
Edit menu. 

• Select the text to be 
moved. 

• Choose Cut from the Ed it 
menu. 

• Place the insertion point 
where you want to place 
the text. 

• Choose Paste from the 
Edit menu. 

• Choose Undo Last 
Change from the Edit 
menu. 

• Choose Save & Continue 
from the File/Print menu. 

or 

• Choose Save & Put Away 
from the File/Print menu. 
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• If you haven't set up your 
printer yet, see the 
manual that came with 
your printer. 

• If you haven't set printer 
Preferences yet, see 
Section D, Desktop 
Manager's Reference 
Guide of the Lisa Owner's 
Guide under Set Printer 
Configuration. 

• If you need to change any 
of the options in the 
Format for Printer dialog 
box for your document, 
choose Format for 
Printer from the File/ 
Print menu and change 
the options. 

• Choose Print from the 
File/Print menu. 

• Respond to any dialog 
boxes that appear. 
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Formatting a Document 

So far you've learned to enter and edit text in a LisaWrite 
document, print it, and put it away. In this chapter you 
learn to add some finishing touches to make your 
documents look more professional. 

The Type Style, Page Layout, and Format ~ menus all let 
you add final touches to your documents before printing 
them. In this section, you learn to use the Format ~ and 
Type Style menus. The Page Layout menu is discussed in 
Chapter 4, Formatting Long Documents - Page Layout. 

In this chapter, you learn to 

• Retrieve an existing document. 
• Change the left and right margins of existing text. 
• Align text flush with the left margin, right margin, or 

both margins, and center text. 
• Underline text and make text bold. 
• Change paragraph and line spacing. 
• Copy format settings from one paragraph to another. 
• Change the type style and font used for characters in 

text. 
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If you stepped through the exercises in Chapter 1, you 
now have a copy of the memo. 

To retrieve your document, 

~ Open the ProFile 
window. 

~ Open the document 
that you created in 
Chapter 1. 

That's all there is to it! 

I 
If you didn't follow the exercises in Chapter 1, you'll 
find a copy of the memo on the stationery pad named 
Chapter 2. 

~ Open the LisaWrite 
Examples folder. 

~ Tear off a sheet of paper 
from the stationery pad 
named Chapter 2. 

~ Name the document by 
typing your initials 
followed by Ch2. 

~ Open the new document. 

Your screen should look like Figure 8. 

cn~ter 2 



Using the 
Format ~ Menu 

NOV'A STEREO nmROFFICE ~IEMO 

To: All Department ~lanager:? 

From: Charle, Cunl1lngrl8J1\ Order Processlng Manager 

Date: Jul~' 25, 1982 

SubJect: Reorganizatlon of Order Processing Department 

Effectlve lfnrnedlatel'y', order processing \'1111 be (llVlded into three 
departments, each \'11th a super'Jisor. 

Telephone Sal es -- Ralph t'lcDonnell, SUper\'l sor 

Order Entry -- [Ilane Tucker, Super'v'lsor 

Packing -- Llnda Hughes, Superl/lSor 

Please give these supervisors 'y'our full cooperation. 

Figure 8. Memo 

You can make formatting changes to your text at any 
time while using LisaWrite. If you know how you want 
your document to look before you enter text, change the 
settings before you start, or as you enter it. If you're not 
sure, concentrate on content first, and change the format 
later, as you do in this example. The beauty of LisaWrite 
is that you can try a variety of formats and see how your 
document will look on the screen before you print it. 

The Format ~ menu makes it easy to set and change the 
format of text in LisaWrite documents. Using the menu 
items on it, you control the spacing and placement of 
your text on the screen. And since LisaWrite displays 
your text as it will be printed, you can make any 
adjustments you want before producing a final copy. 

Figure 9 shows the Format ~ menu. 
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vleft Flush eil 
(enter eiK 
Right Flush eiR 
Justify eiJ 

Show Margin/Tab Ruler 

Hide Margin/Tab Ruler 

Single Space 1r 
1-1/2 Space 1r 

vDouble Space 1f 
Triple Space 1r 

vSingle Space lines 

1-1/2 Space Lines 

Double Space lines 

Triple Space lines 

Same as on [I ipboard eis 

Figufe 9. FOr mitl il ivi~rlu 

Changing Margins 

The text of the memo you have been working on is fairly 
brief. If you were to print this memo with the current left 
and right margins, it would look somewhat short and fat 
for a letter-size piece of paper. To give it a sleeker 
appearance, increase the left margin. 

To change the left margin of the memo, use the Show 
Margin/Tab Ruler option from the Format ~ menu. 
Before opening the menu, select the text to be 
reformatted. In this example, you change the left margin 
for the entire memo, so select the entire memo. 

~ Choose Select All of 
Document from the Edit 
menu. 

Undo last Change 

Cut 

Copy 

Paste 

Select All of Oocument etA ~ 
,,,,~,~,,. "" ',,,""",,,,,.,0 '" '~',"W"H"'" '." "" '''''M""'''/ 



The text on your screen should look something like 
Figure 10. 

Figure 10. All Text Selected 

Now bring the ruler to the screen: 

~ Choose Show Margin/ 
Tab Ruler from the .,fLeft Flush 

Format ~ menu. Center 
Right Flush 

JustiFy 

The ruler appears on your screen at the bottom of the 
first selected paragraph, and the Ruler menu appears on 
the menu bar, as shown in Figure 11. 
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Figure 11. The Margin/Tab Ruler 

The ruler lets you set margins and tabs quickly and 
acc:..:rately. The top of the iulei displays units of measure 
(inches in this example; later you learn to change this to 
centimeters) and a small dark triangle. You learn to move 
this marker to set tab stops in Chapter 4, Formatting 
Long Documents - Page Layout. 

The light triangles in the middle and bottom of the ruler, 
,£, &" and .£ show the current first-line, left and right 
margins. The first-line margin lets you tell LisaWrite how 
you want paragraphs indented. Our memo uses block 
paragraphs, so the first-line and left margins are set in 
the same position. 

Move both of these triangles to the 1-112 inch marker, 
and watch what happens to the selected text of your 
document. 

~ Move the pointer to 
the ,£. 

2EL5ii 



~ Press and hold the 
mouse button, moving 
the triangle to the 1-1/2 
inch marker, and release 
the button. Notice that 
the first I ine of each 
paragraph indents 
automatically as you do 
this. 

~ Now move the pointer to 
the ,&, press and hold, 
pulling it to the 1-1/2 
inch marker in the same 
way. The entire text of 
the memo moves to line 
up with the new left 
margin. 

When you make the margins of text smaller, each line 
holds fewer characters than it did before. LisaWrite 
automatically adjusts the words on each line to fit within 
the margins. Any extra words are moved to the next line. 
Each paragraph is treated as one unit, so the basic 
format of your document remains. 

While the ruler is still on your screen, format another 
section of the memo. Indent the lines containing the 
names of the new departments and their supervisors. 
You don't need to move the ruler to do this. You can 
change the margins of text with the ruler displaying 
above them. 

~ Select the three lines 
containing department 
and supervisor names. 

~ Now move the first line 
ruler marker to the 2 
inch marker. The three 
lines automatically move 
in to match the new left 
margin. 

, I' , I '!' I "I ' ! '-.,1 ' ; , I ' 1 ' • , zr : ' '41 

r 
Effective immedlate1\", order pro( 
depertment s, each wi t ~I a super-vi ~ 

~le')IDne ::,,1~: -- P~ll)h rll 

=I!-:Ie~ EI,"r -- [u-,~ ;x e 

~':'l";1 -- d' ,:13 HJ;1he: ~, 

P1 ease gille these super-v'l SOTS 'y'OI 

Chapter 2 
Formatting a Document · · .1 833 ... ... 



B341 : : : Section B I- -- LisaWrite Tutorial 

That's all the margin changes you need to make right 
now, so hide the ruler: 

~ Choose Hide Margin/ 
Tab Ruler from the 
Format ~ menu. 

Justifying Text 

..,ILeft Flush 
Center 
Right Flush 
Justify 

Show Margin/Tab Ruler .. 

When you type on most typewriters, you have an even left 
margin, and a ragged right margin. When you enter text 
with LisaWrite you get the same effect initially. However 
it's very easy to request that your text line up differently 
on the Lisa. When you open the Format ~ menu, you'll 
find four different alignments available: 

• Left Flush: This is the style you're used to, with an even 
left margin and a ragged right margin. Sometimes 
you'll hear this kind of text called "left justified." 

• Center: This centers text between the current left and 
right margins. 

• Right Flush: This lines up the text with the right margin, 
and leaves the left margin ragged. 

• Justify: This gives you an even left and right margin, 
such as you see in books, magazines, and newspapers. 

Lert flush text has en even left margin, 
end a ragged right margin, 11ke this 
paragraph. If the fust line margin is 
Indented or outdentea frilli the left 
margIn, the first 11ne will follow that 
setting. All other lines beoln at the 
left maroin marker. 

Left Flush 
Aligned on Left Margin 

A Centered Title 
Centered text is placed equldlstent 

between left end nqht margins. It Is 
useful for tItles, headings, end header 

end footer InfoT1!letlon. This is an 
example of a flush left paragraph with 

a centered title I1ne. 

Centered 
Centered between Margins 

Right flush text has an even right Justified text has even left end right 
margin, and an une'v'en left margin. margins throughout the paragraph. Only 

You'11 find it· useful when you want II the last line of text is not extended 
rew 11nes to print even with the nght between margins. To justIfy text, 

margin. In thlS exernple, the heeder LlsSllrite spaces the words out on eac~ 
containing "Page 2" 15 flush rloht, line between the left and nght margin 
ebove a paraQfeph of text which is settinos. This is an example of a 

flush left. justified paragraph. 

Right Flush Justified 
Aligned on Right Margin Aligned on Left and Right 

When you complete this exercise, the whole memo is 
justified, and the top line is centered. 



So that you can clearly see the effects of text lined up in 
different ways, start by selecting the memo heading. 

~ Triple click to select the 
top line of the memo. 

To: All Depertrnent r1elle.ger:: 

Right now the heading is lined up with the left margin, or 
left flush. See how it looks right flush. 

~ Choose Right Flush from 
the Format 11 menu. 

The heading shifts to the right, as in Figure 12. 

To: All Department Managers 

From: Charles Cunningham, Order Processing ~lanager 

Date: Jul~1 25, 198: 

SIJbJect: Reorganization of Order ProcessIng Department 

x 

Effective immediately, order processwJ wIll be di'o'1ded Into three 
departments, each W1 th a supervisor. 

Telephone Sales -- Ralph ncDonnell 

Order Entri -- D1 ane Tucker 

Packi ng -- L1 nda Hughes 

Pl ease g1v8 these sliperv'lsors your full cooperat 1 on 

Figure 12. Flush Right Text 

The flush right heading doesn't look quite appropriate for 
this memo, so try centering it. 

~ Choose Center from the 
Format ~ menu. 

Figure 13 shows the result. 

. ............................... " .. " .... " ... " ... , ..... . 
~~~-
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11'llllpU-ch2111111 
10 ~ ::TEFED I1ITEF'OFFICE IIEIIO 

To: All Department Managers 

From: Charles Cunningham, Order Processing Manager 

Date: July 25, 1982 X 
Subj ect : Reorgani z at i on of Order Processi ng Department 

Effective immediatelv, order processing will be divided into three 
department s, each wit h a supervi sor. 

Telephone Sales -- Ralph McDonnell 

Order Entrv -- Diane Tucker 

Packi ng -- Li nda Hughes 

Please give these supervisors 'your full cooperation. 

Figure 13. Centered Text 

Now justify the rest of the memo: 

I 

~ First, select the rest of the memo by placing the 
pOinter just before "To:", clicking the mouse button 
and holding it down while you pull diagonally through 
the memo to the end of "cooperation." Then release 
the mouse button. 

If the text of the memo shifts on the screen while you are 
selecting it, you can scroll it back easily by clicking the 
pointer on the scroll arrows at the bottom and right 
edges of the window. Scrolling is reviewed in detail in 
Chapter 3, Working with Long Documents. 

~ Now choose Justify from 
the Format 11 menu. V'Left Flush 

Center 
Right Flush 
Justify ,~ _J 

Show Margin/Tab Ruler 
Hide Margin/Tab Ruler 



You don't notice an immediate change in this memo as it 
stands, because it doesn't contain many mUlti-line 
paragraphs. However, add the following sentence and 
watch what happens: 

~ Place the insertion point 
at the end of the first 
paragraph. 

Effective Immedlatel'Y, order processing will be 
departments, each wIth a supervlsor.1 

Telephone Sales -- Ralph 11cDonnell 

~ Type 

I believe this will improve the efficiency of the 
department in handling our rapidly increasing 
sales volume. 

Figure 14 shows the justified memo. 

NOVA STEREO INTEROFFICE MEMO 

To: All Department Managers 

From: Charles Cunningham, Order Processing Manager 

Order Entry -- Diane Tucker 

Packi ng -- Li nda Hughes 

Please give these supervisors your full cooperation. 

Figure 14. Justified Memo 

~I 

Many of the lines still look just as they did when the 
memo was flush left. Short lines by themselves or at the 
end of paragraphs would look odd if they were spaced 
out across the line, so LisaWrite leaves them flush left 
when you choose Justify. Longer paragraphs, such as the 
first one in the body of the memo, have a more finished 
look when given even left and right margins. 

Paragraph and Line Spacing 

You can alter the amount of blank space left between 
each line of text and paragraph in your document by 
using the Paragraph and Line Spacing items on the 
Format ~ menu. 

Chapter 2 
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Paragraph spacing determines how much space is left 
blank between the end of a paragraph and the next line 
of text. Remember, every time you press (Return), you end 
one paragraph and begin another. 

Even before you look at the Format ~ menu items, you 
can tell what paragraph spacing is currently in use by the 
length of the insertion point when it is in the bottom line 
of a paragraph. In the sample memo, paragraph spacing 
is set to 2. Look at the insertion pOint in the memo. It 
extends below the characters on the screen. The greater 
the paragraph spacing, the longer the insertion point. 

Line spacing determines how much space is left between 
the lines of text within a paragraph. 

~ Place the insertion point in the multiple-line 
paragraph. 

Notice that the insertion paint is shorter now, showing 
you that single line spacing is active within the 
paragraph. 

~ Open the Format ~ 
menu, and look at it. 

~i,Jim"'II~ 
I ",I:" 1:"1 .... h 
...... 1'" 1 IU,HI 

Center 
Right Flush 

-I JustiFy 

Show Marg i niT ab Ru I er 
Hide Margin/Tab Ruler 

Single Space 1r 
1-1/2 Space 1r 

-IDouble Space 1r 
Triple Space 1r 

-ISingle Space Lines 

1-1/2 Space Lines 

Double Space Lines 
Triple Space Lines 

Same as on (I ipboard tts 



As you can see on the menu, both paragraph and line 
spacing may be set to Single Space, 1-1/2 Space, 
Double Space, or Triple Space. The settings active for 
the current paragraph are checked. The current 
paragraph is the first one selected, or the one containing 
the insertion point. When more than one paragraph is 
selected, the checked settings show the spacing for the 
first selected paragraph. 

To see the difference between paragraph and line 
spacing, 

~ Choose Select All of Document from the Edit menu. 

~ Choose Single Space ~ 
from the Format ~ menu. til 

tiK 
tiR 
tiJ 

Show Margin/Tab Ruler 

Hide Margin/Tab Ruler 

ouble Space 1f 
Triple Space 1r 

The memo closes up quite a bit with single space 
paragraphs. Figure 15 shows what you see on the screen. 

Figure 15. Single Space Paragraphs 
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~ Now choose Double 
Space Lines from the 
Format ~ menu. 

Same as on [I ipboard WS 

Only the spacing for multi-line paragraphs changes. The 
result is shown in Figure 16. 

NOVA STEREO INTEROFFICE MEMO 
To: All Department Managers 
From: Charles Cunningham, Order Processing Manager 
Date: July 25, 1982 
Subject: Reorganization of Order Processing Department 
Effective immediately, order processing wlll be divided into three 

departments, each with a supervisor. I believe this will wprove the 

efficiency of the department in handling our rapldly increasing sales volume. 
Telephone Sales -- Relph McDonnell 
Order Entry -- Diane Tucker 
Pscki ng -- Li nds Hughes 

Please give these supervisors your full cooperation. 

Figure 16. Double Space Lines 

x 

If part of your document disappears below the bottom of 
the window while you're experimenting, don't be 
alarmed. With extra spacing, the memo may fill up more 
paper than the window can display at one time, but the 
text is still present. In Chapter 3 you review how to scroll 
long documents through the window to see different 
portions of them. 



Now return the memo to its initial spacing. 

~ If the memo is not now selected, choose Select All of 
Document. 

~ Choose Double Space ~. 

~ Choose Single Space Lines. 

The sample memo was entered using Double Space ~ 
and Single Space Lines for all the text. In some 
documents, you may have consistent settings like this 
throughout. In other documents, you'll want to vary line 
and paragraph spacing. In our memo, for example, you 
might prefer to have the three paragraphs listing the new 
departments single spaced. 

~ Select the three lines 
containing the 
department and 
supervisor names. 

~ Choose Single Space ~ 
from the Format ~ menu. 

Show Margin/Tab Ruler 
Hide Margin/Tab Ruler 

1-1/2 Space 1r 
ble Space U 

Triple Space 1r 

~ Click the mouse button outside of the selection to 
deselect and see the memo more clearly. 

Figure 17 shows the resulting spacing. 
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NOVA STEREO INTEROFFICE MEMO 

To: All Department Managers 

From: Charles Cunningham, Order Processlng Manager 

Dat e: Jul)l 25,. 1982 

SubJect: Reorganizatlon of Order Processlng Department 

Effectlve immediatel)l, order processlng IAI111 be dl,nded wto tllree 
departments, each Wl th a supervlsor. I bell eve thlS wlll lmprove the 
efficienc)I of the department In handllng our rapldl'/ lncreaslng sales ',"olume. 

Telephone Sales -- Ralprl t'lcDonnell, Supervl sor 
Order Entr)l-- Diane Tucker, Sllper\!lSOr 
Packing -- Linda Hughes, Super'/l so~ , 

Ple;~se glve these supenllsors 'iol.lr full cooperation, 

Figure 17. Different Settings in Same Document 

The three lines now sit on consecutive lines in your 
document. But in addition, the final paragraph of the 
memo sits snuggly up against them. What happened? 
Each of the iines is a paragraph in itseil. By selecting all 
of them, you selected three paragraphs - including the 
(Return) at the end of the last department line, which 
determines the spacing before the next paragraph. You 
only needed to select the first two lines to get the desired 
effect. 

To correct the spacing, 

~ Place the insertion point 
somewhere within the 
line "Packing -- Linda 
Hughes, Supervisor." 

Tucker, Super·.,.Ii sor 
hes l Supen/i so~ 
,sors your full cooperation. 



~ Choose Double Space ~ 
from the Format ~ menu. 

Show Margin/Tab Ruler 
Hide Margin/Tab Ruler 

............................................................................................... 

The last paragraph moves down a line. As you can see, 
you don't have to select the entire paragraph to change 
the spacing. Placing the insertion point within the 
paragraph is enough. 

How Formatting Changes Affect Editing Text 

When you add or change text in a paragraph, the 
changes don't alter the current paragraph format. This 
means that once you've established the formats you 
want, any insertions or deletions fit right in automatically. 

Add some text to the middle of the first paragraph. 

~ Place the insertion point 
after "order 
processing." 

~ Type 

of Order Processing Departm 

order processind will 
a supen."i sor . I bel i e\.l8 

ent in hancHing our rapidl'y" 

(which now includes telephone sales, order 
entry and packing) 
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Watch what happens while you type. The line shifts back 
and forth as you enter characters, continually rejustifying 
the paragraph. As text needs to, it shifts down onto the 
next line, maintaining the same left and right margins, 
both flush. 

Now, let's say you want to add another paragraph at the 
bottom of the memo, and you want to use the margins 
active for the three lines containing department and 
supervisor names. You can copy these margins without 
using the ruler. 

~ Place the insertion point 
below the last line of the 
memo. 

Please give 

Look at the position the pointer takes. The insertion 
point sits at the current left margin, which is the same as 
the margin for the last paragraph of the document. You 
can change the margins to match the ones you want by 
using the menu item Same as on Ciipboard. The next 
section shows you how. 

Copying Format Styles 

To copy the format of one paragraph to another, 

~ Select the paragraph _.;.. $'Im.,' .... I_ 
Order Entry -- Diane TIJcker, S!Jpervis!Jr 

with the format you Packing--lindaHu!~hes. SuperVlSor 

want, in this case, 
"Telephone Sales -
Ralph McDonnell, 
Supervisor." 

~ Choose Copy from the 
Edit menu. 

'" , """,""""""""""""""""""""""""""""""""""" "''''''''''''''''''111 

Select All of Document aA 



Using the Type 
Style Menu 

~ Place the pointer below 
the last line of the memo 
again. 

~ Choose Same as on 
Clipboard from the 
Format ~ menu. 

The paragraph format 
settings active for the text 
on the Clipboard are 
applied to the current 
paragraph. You can see the 
change by the shift of the 
insertion point. 

Please give 

LeFt Flush 
Center 
Right Flush 

...; Justify 

". I • ~'V I , } \ I , .. " •• " .... I '" 

departments, each with a super 

Telephone Sales -- Ralph 
Order Entry -- Diane Tuc 
Packing -- Linda Hughes, 

Please give these supervisors 

I I 

The Same as on Clipboard feature is most useful when 
you have one particular format that you wish to use in 
several places. You simply copy that paragraph and 
paste its style wherever you wish. 

When you open the Type Style menu, you see quite an 
extensive list of styles to choose from. You can pick the 
actual size and face of the fonts to be used in your text, 
and add special effects such as underlining, italics, bold, 
and sub- and superscripts. 

Figure 18 shows the Type Style menu. 
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v'Plairr Text .P 
Underline tiu 
Bold .B 
Ital ic ., 
Superscript 
Subscript 

15 Pitch Gothic 
v'12 Pitch Modern 

12 Pitch EI ite 

10 Pitch Modern 
10 Pitch Courier 
PS Modern 
PS ExeCLlt i ve 

1/4 inch Modern 
1/4 inch Classic 

1/3 inch Modern 
1/3 inch Classic 

Figure 18. The Type Style Menu 

In this exercise you underline the last paragraph of the 
memo, make the word "immediately" bold, and choose a 
new font for the top line to create a letterhead. 

To underline the last paragraph, 

~ Select the last 
paragraph of the memo. 

~ Now choose Underline 
from the Type Style 
menu. The paragraph 
remains selected after 
you underline it. Click to 
deselect it and you see 
the underlining more 
clearly. 

Telephone Sales -- Ralph 11cDonnell, Supen"l~or 
Order Entr", -- Dlane Tucker, Supen'lsor 
Packlng -- LlndaHughes, Supen/1S'or 

Italic 

Superscf i pt 
Subscript 

., 

Figure 19 shows the underlined paragraph. 



~~OVA STEREO HHEPOFFICE MEMO 

To: All Department Managers 

From: Charles Cunmngham, Order Processing Manager 

Date: JulV 25, 19BZ 

Subject: ReorgamzatlOn of Order Processlng Department 

EffectiVe lmmediatelv, order processlng iwhlcrl nO'N lncludes telephone sales, 
order entry'" and packlng) Will be dlvlded lnto three departments, each with a 
supervlsor, I belle','e thlS wlll lmprove the efflCl~C'J of the department ln 
handling our rapldlv lncreaslng sales volume, J.. 

Telephone Sales -- Ralph 11cDonnell, Supervlsor 
Order Entrv -- Dlane Tuc,er, Super'.'lsor 
Packlng -- LlndaHughes, Supervl sor 

Pl ease glve these supeY'v'l SOTS ,",our full cooperat 1 on, 

Figure 19. Underlining 

To make a word bold, select it and choose Bold from the 
Type Style menu. 

~ Select the word 
"immediately" by 
double clicking on it. 

~ Choose Bold from the 
Type Style menu. 

:tive .. aW"'OI, orde 
entrYI and packi ng) w 

Ital ic 
Superscript 
Subscript 

To change the font of the top line, 

~ Select the top line of the 
memo. 
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~ Choose 1/4 Inch Modern 
from the Type Style 
menu, and watch the 
character size change. 

Underl ine 
Bold 
Italic 
Superscr i pt 
Subscript 

1/4 inch Modern ' 
1/4 inch (Iassic 
1/3 inch Modern 
1/3 inch (lassie 

Figure 20 shows your memo with the new font and 
bolding. 

NOVA STEREO INTEROFFICE MEMO 
To: All Department Managers 

From: Charl es Cunni nngham, Order Processi ng Manager 

1,,', J ",)1:, 1nQ,,? 
......... .r.y 1...1, • .I'.u .. 

Subject: Reorganization of Order Processing Department 

Effective illlllediately, order processing (which now includes telephone sales, 
order entry and packing) will be divided into three departments, each with a 
supervisor. I believe this will improve the efficiency of the department in 
handling our rapidly increasing sales volume. 

Telephone Sales -- Ralph McDonnell, Supervisor 
Order Entry -- Diane Tucker, Supervisor 
Packing -- Linda Hughes, Supervisor 

Please give these supervisors your full cooperation. 

Figure 20. Bolding and New Fonts in Memo 

x 

You can also combine italics, bolding, and underlining 
with any of the fonts, giving you a very wide range of type 
styles. 

That's it! Your memo is complete. Print it now, if you 
would like a paper copy, and put it away. 



~ Choose Print from the 
File/Print menu. 

~ Click OK in the dialog 
box. 

~ Choose Save & Put 
Away from the File/Print 
menu. 

You could leave your documents where they are now in 
the ProFile window, but your ProFile window would soon 
become cluttered with document icons. You can create a 
folder to contain all the related documents. 

~ Move the pointer into 
the empty folder pad 
icon in the ProFile 
window and click the 
mouse button twice. 

~ Type 

Tutorial-

followed by your initials. 

IIlMI'@A 

To file the document in your new folder, 

~ Move the pointer into 
the document icon. 
Press and hold the 
mouse button while 
moving the document 
icon over the folder. 

LJ 
Fi-lPtY Folders 

~lPU 
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~ Release the mouse button when the folder icon 
flashes. 

~ Move the folder icon to an empty place in the ProFile 
window. 

~ Move the document that you worked on in Chapter 1 
into your new folder to keep all your examples 
together. 

This completes Chapter 2. Go on to the next chapter, if 
you I ike, or come back to it later. 



Chapter 
Summary 

Retrieve an existing 
document 

Change margins 

Set text left flush 

Set text right flush 

Center text 

Justify text 

Set line spacing 

• Double click on the 
document icon. 

• Select paragraph(s) in 
text. 

• Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. 

• Pull &, &, or .£ to 
margin position. 

• Choose Hide Margin/Tab 
Ruler from the Format ~ 
menu. 

• Select paragraph(s) in 
text. 

• Choose Left Flush from 
the Format ~ menu. 

• Select paragraph(s) in 
text. 

• Choose Right Flush from 
the Format ~ menu. 

• Select paragraph(s) in 
text. 

• Choose Center from the 
Format ~ menu. 

• Select paragraph(s) in 
text. 

• Choose Justify from the 
Format ~ menu. 

• Select paragraph(s) in 
text. 

• Choose the desired 
line spacing from the 
Format ~ menu. 

Chapter 2 851 
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Set paragraph spacing 

Copy format style 

Change type styles 

Create a folder 

Put a document 
in a folder 

• Select paragraph(s) in 
text. 

• Choose the desired 
paragraph spacing from 
the Format ~ menu. 

• Select the paragraph with 
the style to be copied. 

• Choose Copy from the 
Edit menu. 

• Select the paragraph to 
receive the new style. 

• Choose Same as on 
Clipboard from the 
Format ~ menu. 

• Select the text you want. 

• Choose the desired type 
style from the Type Style 
menu. 

• Double click on the folder 
pad icon. 

• Type the name of the 
folder. 

• Move the document icon 
over the folder icon. 

• Release the mouse 
button when the folder 
icon flashes. 



Chapter 3 
Working with Long Documents 



Working with Long Documents 

This chapter shows you how to use LisaWrite with long 
documents. You'll find that it's as easy to move around 
and make changes in a long document as it is in a brief 
memo. 

You learn how to 

• Use the scroll bar, scroll arrows, and elevators to bring 
more text into view in the window. 

• Split the window into two or more views of your 
document. 

• Find and go directly to specific text in your document. 
• Find and replace text at the same time. 

Some formatting features make working with long 
documents easier, too. They are discussed in Chapter 4, 
Formatting Long Documents - Page Layout. 
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In this chapter you work with a letter provided as the 
stationery pad Chapter 3. 

To get a copy of the letter, 

~ Open the ProFile window. 

~ Open the LisaWrite Examples folder. 

~ Tear off a piece of stationery from the stationery pad 
named Chapter 3. 

~ Name the document by typing your initials followed by 
Ch3. 

~ Open the new document. 

The document displayed in your active window should 
look like Figure 21. 

I 

Ms. Roseli e Eberhurs t 
1627 Ha,Stings Avenue 
Cupertino. CA 9:,014 

W8.\:erly Information Systems Ii\ 
3600 South First Street ~ 
Cupertino, CA 94014 ~ 

April 12., 1983 

I 
i ::] 
! 

:::~ 
Dear r1s. Everhurst. Hi 

Thank \IOU for 'your letter and resume dated ~181"Ch 24 1983. As personnel ::::1 
maneqer of vHS Corp ... I em qulte interested in your expenence In survey"! 
research in the Held of Information S')Istems, and I am circulatinl~ \lour resume :'::::1 
to eppropna.te departments. :1 

As \IOU f.now, ViiS Corp. is 8. small but repidl'\" 9rOyilng flIm In the SIlIcon i •...•...• • •...•.•.••... : .•.... 1 Valley. We expect an ongoing need for highly' quellfied IndIVIduals 1n survey 
research. ~ 

yilll here from us Q If we flnd that your te.lents can be of lise to V!lS Corp .. 
T -

cJf:j 

Figure 21. Sample Letter for Chapter 3 

Only part of the letter shows in the window on your 
screen. A printed copy of it, marked with the changes 
you'll be making, is shown in Figure 22. Although only 
one printed page, the letter is long enough to show you 
what you need to know to work with long documents of 
any length. All of the tasks you do in this chapter work 
just the same with one, ten, twenty, or thirty page 
documents. 



Ms. Rosalie Eberhurst 
1627 Hastings Avenue 
cupertino, CA 95014 

Ir 
Dear MS. Ejerhurst, 

Waverly InforPlation SysteMs 
3600 South First Street 
cupertino, CA 94014 

1983 

Thank or ur letter and resUl'le dated March 24, 1983. As personnel Manager 
Of IS Cor , I aPl quite interested in your experience in survey research in the 
fie nforPlation systet"\s, and I aM circulating your reSUMe to appropriate 
departMent s . 

As you know, WIS Corp. is a SMall but rapidly growing firM in the Silicon 
Valley. We expect an ongoing need for highly qualified individuals in survey 
research. 

TOM JaMes, 
Personnel Manager 
WIS Corp. 

Figure 22. Complete Letter Marked with Changes 

The Window into Your Document 

rOM us 
1. 

Think of each document as a long, wide scroll of paper. 
The active window shows you one portion of your 
document at a time. This scroll of paper can be moved 
up and down and left and right so that you see different 
parts of it through the window. 

Sometimes LisaWrite automatically scrolls your 
document for you. For example, when you enter text and 
it fills up the window, LisaWrite scrolls the text up line by 
line so that you continue to see what you are typing. As 
this happens, the top part of your document scrolls up 
beyond the top of the window, temporarily out of view. 

Your documents may often contain more lines than the 
window can display all at once, as our sample letter 
does. LisaWrite provides two different ways to move 
around your document quickly and easily . 

• You can scroll the text of the document so that 
different parts of it display in the window. This lets you 
treat your LisaWrite document as you might a printed 
one, scanning through it to find what you want. 
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Scroll arrow 
View button 
Elevator 

Scroll bar 

View button 
Scroll arrow 
Split control 
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• You can use the Search menu and tell LisaWrite to 
locate the exact text you want to review or change. No 
matter how long your document, LisaWrite will search 
through it for you, and bring that portion of the text 
into the window. 

Scrolling a Document through the Window 

Scrolling a document through the active window is fast 
and easy. You use the scroll bars at the bottom and right 
edge of the window. Figure 23 points out the scroll bars 
and their contents. 

Split control I 
I 

I vJaverlv Information Svstems L ~ 
5bUU :;out n t lrst ::;treet r::.: 

"Uf.'~" ,"!IV, "n ~"VJ.' 1-Q 

Ms. Rosalie Eberhurst 
1627 Hasti ngs Avenue 
Cupert i no, CA 95014 

April 12, 1983 

I I 
Dear ~1s. Everhurst, iiiil 
Thank \/Cru for your letter and resume dated ~1arch 24, 1983. As personnel 
mans,ger of WIS Corp" I 8Jll quite interested in your experience in survey 
research in the field of information svstems, and I 8Jll circulating your resum 
to 8ppropri at e department s. 

i!!!!!1 

As you know, WIS Corp. is 8. small but rapidly groViing firm In the Silicon 
Valley. We expect an ongoing need for highly' qualified individuals in survey 
research. 

I, f we fi nd that vour t 81 ent s cen be of use to WIS Corp., you Viill here from US\~ 
T " '"" v 

~ 

Scroll barl 

Figure 23. Scroll 8ars 

In this chapter you practice using the the scroll arrows, 
elevators, and view buttons to move around in your 
documents. 

Vertical Scrolling 

Use the bottom scroll arrow to scroll the bottom of the 
letter into view, one line at a time. 

~ Move the pointer to the 
bottom scroll arrow. 

I 



~ Press and hold the 
mouse button until the 
bottom of the letter 
shows in the window. 

The arrow highlights, just like selected text, and the letter 
scrolls up on the screen, one line at a time. As it scrolls, 
the elevator moves down the scroll bar. 

Try scrolling part of the letter back down, using the top 
scroll arrow until the middle section of the letter is in 
view: 

~ Move the pointer to the 
top scroll arrow; 

~ Press and hold the mouse button until the signature 
line no longer displays in the window. 

Now try another way of scrolling. Use the view buttons to 
move sections of text in window-size increments into 
view at one time. 

~ Move the pointer to the 
top view button. 

~ Click the mouse button. 

The view button highlights briefly, and the top of the 
letter comes into view. 

~ Now move the pointer to 
the bottom view button. 

~ Click the mouse button. 

The bottom of the letter appears in the window. 

~ Select the bottom view button again. 

Since you are already at the bottom of the document, 
nothing happens. Although there is potentially much 
more room in this document below the existing text, 
LisaWrite knows where to end the scrolling. You won't 
accidentally wind up looking at a blank window far below 
the content of your document. 
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As you use the scroll arrows and view buttons, the 
elevator itself moves up and down the scroll bar. The 
position of the elevator tells you where you are in relation 
to the length of the document. You can use it to scroll, 
too. 

~ Move the pointer to the 
elevator. 

~ Press and hold the 
mouse button, pulling 
the elevator to the top of 
the scroll bar. 

When you release the mouse button, the top of the letter 
displays immediately. 

Use the elevator to move immediately to the top or 
bottom of a document, or to move to an approximate 
position in your document. The elevator's position on the 
scroll bar represents the text in view in the window in 
proportion to the size of the entire document. 

Sometimes when you pull the elevator to the bottom, 
you'll see it bounce back to the middle of the scroll bar, 
particularly in short documents. When this happens, you 
are still moved to the bottom of the document. 

Horizontal Scrolling 

So far you've used the contents of the scroll bar at the 
right edge of your document to move the letter vertically 
through the window. You can also move the text 
horizontally through the window by using the scroll 
arrows in the scroll bar at the bottom edge of the 
window. 

You'll want to scroll your documents horizontally when 
you set left and right margins which don't automatically 
display within the window size. To illustrate this, turn on 
the margin/tab ruler and then try scrolling to the right 
and left. It doesn't matter where the insertion point is in 
your document. 

~ Choose Show Margin/Tab Ruler from the Format ~ 
menu. 



Notice that you see from the 1/2 inch mark on the ruler to 
the 7-1/2 inch mark. The ruler actually extends from the 
o inch mark to 8-1/2 inches however, simulating the 
width of an 8-1/2 inch wide piece of paper. This width is 
determined from the printer specification settings. You 
learn to change it in Section C, LisaWrite Reference 
Guide, Chapter 2, under Print. 

~ Press and hold the ms 

mouse button with the 
pointer on the right 
scroll arrow, until you 
see the 8-1/2 inch mark 
on the ruler. 

, I ' I ' I '81 ' I ' 

The left portion of the letter has now scrolled off the 
screen. 

~ Now press and hold the 
mouse button with the 
pointer on the left scroll 
arrow, until you can see 
the left edge of the text 
again. 

~ Choose Hide Margin/Tab Ruler from the Format ~ 
menu. 

Experiment with the scroll bar facilities as you work with 
this and other long documents. As you get used to 
working with them, you'll find you can move quickly and 
easily through your documents. 

Splitting Views in B Document 

When you want to see different parts of a long document 
at the same time, you can split the window into two or 
more views. You can have split views horizontally, 
vertically, or both at the same time. Try it: 

~ Move the pointer to the 
vertical split view 
control, at the top of the 
vertical scroll bar. 

~ Press and hold the mouse button, moving the mouse 
down towards you. 
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~ Release the button when 
the flickering outline is 
half-way down the 
screen. 

rsonnel 

The active window splits into two views of your 
document, each with its own scroll bar and view controls. 
Right now both views display the same text. Your screen 
should look something like Figure 24. 

D 

~1s. Ross.li e Eberhurst 
1627 Hastings Avenue 
Cupert i no, CA 95014 

Dear t1s. Everr,urst, 

Waverly Information Systems 
3600 South First Street 
Cupertino, CA 94014 

April 12, 1983 

x 

Thank you for your letter and resume dated t1arch 24, 1983. As personnel <} 
manager of vJIS Corp., I am quite interested in YOl,r experience in survey ~ 
research in the field of information systems, and I all1 circulatlng your resume iiI 
to appropriate departments. 

As you know, WIS Corp. is e. small but rapidly growing fHm in the Silicon :!:!t 
~~;~~~h.we expect an ongoing need for highly qualified individue.1s in survey I 

~ 
If we find that your ;~lents ce.n be of use to 'HIS Corp., you will here from us ~ 

I O~ 

Figure 24. Split View of Document 

Notice that each view of the document now has its own 
split control at the top of the vertical scroll bar. 

Now try scrolling in the two windows. 

~ Use the scroll arrows, view buttons, or elevators, to 
move the text of the letter so that you see the bottom 
of the letter in the lower view and the top of the letter 
in the upper view. 

~ Now scroll the text so that you see the bottom of the 
letter in the top view, and the top of the letter in the 
bottom view. 

The window can be split horizontally, too. 

~ Move the pointer to the 
split control at the left­
hand edge of the bottom 
scroll bar. 



~ Press and hold the 
mouse button, pulling 
the mouse to the right 
until the flickering 
outline is about half-way 
across the screen; then 
release it. 

.Jt r~pidl~ 
'or rgh1\ 

of ~se t( 

l!![ml!!~m:!'!illimi!i 
Your screen should look something like Figure 25. 

Ms. Rosalie Eberhurst 
1627 Hastings Avenue 
Cupertino, CA 95014 

Dear Ms. 

Thank you for your letter and 
manager of WIS Corp., I 1;111 quite int 
research in the field of information 
to appropriate departments. 

As you know, ViIS Corp. is a small but 
Valley. We expect an ongoing need for 
research. 

If we find that your talents can be of 

Apri 1 12, 1983 

March 24, 1983. As personnel 
ed in your experience in survey 
ems, and I am Circulating your resume 

will here from us 

Figure 25. Four Views in Document Window 

You can split a document into as many views as you 
want, both vertically and horizontally. When creating a 
new split view, always start with the top and far-left split 
control. The split controls that appear in the new views of 
the document are used to adjust the size of each view. 

Now close the views. 

~ Move the pointer to the 
split control in the lower 
left edge of the right­
hand split view. 

e of se to 
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~ Press and hold the 
mouse button, moving 
the edge of the right­
hand view back to the 
edge of the left-hand 
view, and release the 
button. 

~ Now move the pointer to 
the split control in the 
upper right edge of the 
lower split view. 

~ Press and hold the 
mouse button, moving 
the edge of the lower 
view back to the top of 
the upper view, and 
release the button. 

P::::: 
\ ::," 

". 

Your window returns to one view. 

Locating Text 

You can go directly to any word or phrase in your 
document by using the Search menu. To see how this 
works, use the Search menu to go to "Sincerely." 

~ First, use the elevator to Insertion point 

move back to the top of j 
the letter, and select an =-ir---------­
insertion pOint at the top 
of the text. 

x 
Ms. Rosalie Eberhurst 
1627 Hastings Avenue 
Cupertino,. CA 95014 

LisaWrite always searches for the text you want from the 
current selection or the insertion point to the end of the 
document. When you want to find the first occurrence of 
a word or phrase, always select an insertion point at the 
top of your text. 



~ Choose Find What? 
from the Search Menu. 

Change This Occurrence 
Change & Find Next eiN 
Find & Change RII 

The dialog box appears at the top of your screen. The 
insertion point is automatically placed in the brackets 
next to "Find," as in Figure 26. 

File/Print Edit Search Type Style Format' Page layout 
Find !II 
Change to I} 

Ms. RosaHe Eberhurst 
1627 Hast i ngs Avenue 
Cupert i no, CA 95014 

Deer Ms. Everhurst, 

I 
wU~~H'''U, WC w.-
Apri 1 12, 1983 

Thank you for your letter and resume dated Merch 24, 1983. As personnel 
manager of here WIS Corp., I em quite interested in your experience in survey 
reseerch in the field of information systems, and I em circulating your resume 
to appropriate depertments. 

As you know, WIS Corp. is a small but rapidly growing firm in tile Silicon 
Valley. We expect an ongoing need for hIghly qualified individuals in survey 
reseerch. 

If we find that your talents can be of use to WIS Corp., you will here from us 

Figure 26. Search Dialog Box 

~ Type 

Sincerely 

Find 
Cha.t"I';le to 

The characters appear within the brackets in the dialog 
box next to the word "Find." 

Since you just want to find the word "Sincerely," and not 
change it to another word, you don't need to fill in the 
Change To line. 
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~ Choose Find Next 
Occurrence from the 
Search menu. 

Change This Occurr 
Change [, Find Next elN 
Find [, Change All 

The portion of the letter containing "Sincerely" appears 
in the window. The text you wanted to find is selected. 

Now find the first occurrence of the word "information." 

~ Move the pointer inside 
the dialog box at the top 
of the screen and select 
"Sincerely." 

~ Type 

information 

FInd 
Crlange to 

Find 
Change to 

{ij'R.iijl} 
{} 

{ informatiorl} 
{) 

"information" replaces "Sincerely" next to "Find." This 
time, close the dialoQ box before searching. 

~ Choose Hide Dialog Box 
from the Search menu. Find What? 

Find Next Occurrence elF 
Change This Occurrence 
Change & Find Next elN 
Find [, Change All 

Cases Must Agree 
ases Need Not Agree 

Insert Wi Id Card C ... ) 
I .... ·· .. ·································,· .................. ·· ................. , ........................... ,. 

~ Use the elevator to move back to the top of the letter 
and place an insertion point on the first line. 



~ Choose Find Next 
Occurrence from the 
Search menu. 

Change This Occu 
Change & Find Next 
Find & Change All 

"Information" is selected in the company address at the 
top of the letter. . 

Notice that LisaWrite found the word even though you 
typed the word with a lower case "i" and the first 
occurrence of it in the letter starts with a capital "I." This 
is because the Search menu is currently set to Cases 
Need Not Agree. 

Further Defining Text to Locate 

When you tell LisaWrite to "find" text, you can set 
additional criteria to help locate a specific place in the 
document. 

~ Open the Search menu and locate the menu items 
Cases Must Agree and Cases Need Not Agree. 

Cases Need Not Agree is 
checked indicating that it is 
now active. This setting 
tells LisaWrite to match the 
characters you specify, but 
to pay no attention to 
whether they display in 
upper or lower case. 

t? 
Find Next Occurrence 
Change This Occurrence 
Change Er Find Next " 
Find & Change All 

Cases Must Agree 
ases Need Not Agree 

When you want LisaWrite to match the case of the 
characters you specify exactly, choose Cases Must Agree 
from the Search menu. 

Try it. 
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~ Open the Search menu 
and choose Cases Must 
Agree. 

~ Open the Search menu 
again and notice that 
Cases Must Agree is 
now checked. Cases 
Need Not Agree is not. 

find What? 
find Next Occurrence 
(hange This Occurrence 
(hange & Find Next • 

find & (hange All 

find What? 

find Next Occurrence .F 
(hange This Occurrence 

Change & Find Next .N 
Find & (hange All 

ses Must Agree 

Cases Need Not Agree 
I .......... · .......................... ·· ...... · ............................................ . 

~ Place the insertion point at the top of the letter again. 

~ Choose Find Next Occurrence from the Search menu. 

LisaWrite remembers the 
last word you searched for, 
and goes directly to the first 
lowercase occurrence of 
"information," skipping the 
capitalized occurrence in 
the company address. 

:orp., I 8JTJJid te i nt 
d 0 f GilliG 1M S)l S t 
tments. 

~ Choose Cases Need Not Agree again. 

Use Cases Need Not Agree when you want to find all 
occurrences of a word or phrase, regardless of case, and 
when you don't remember exactly which characters are 
capitalized. 

Use Cases Must Agree to help you find the first exact 
occurrence of text. 



Finding and 
Changing Text 

Locating Additional Occurrences of Text 

Normally when you use Search to move to a position in 
text, enter a word or phrase that you believe to be unique 
in the document. That way you are assured of moving to 
the desired text in the fastest way. If the text brought to 
the screen isn't what you're looking for, the phrase you 
entered in the dialog box may not be unique. You can 
quickly find the next occurrence of the phrase. 

Try it now in the document: find out if "information" is 
repeated in the text of the letter again. 

~ Choose Find Next Occurrence from the Search menu 
again. 

This time the text on your screen doesn't change. 
Instead, the dialog box appears, with "Not Found" 
showing in the lower right-hand corner, as shown in 
Figure 27. This tells you that "information" doesn't occur 
again in the letter. 

r File/Print Edit Search Type Style Format 1[ Page Layout 
Find {Information 1 lQ. 

~rn=ch~an~ge~t~0rn=i)mmrnrnrnrnrnrnWIT~~mm~~~mmNo~t~FO~lJr~'Ci~~~'? 
<~ 1:!::)::i}!i!t;;;;;;;;i;!U;!t:::~'!i/;;Hil ~ IDl 

Figure 27. Not Found Message 

~ Choose Hide Dialog Box from the Search menu. 

You can use the Search menu to help make corrections 
quickly. When you use Search to locate text, LisaWrite 
automatically selects the found text. This makes it easy 
for you to see, and also makes it easy to insert or replace 
characters. 

When text is selected, you can replace it by typing in a 
new character, word, phrase, or as much text as you 
want. In fact, you can use any of LisaWrite's editing 
abilities after finding a particular place in the text. 

Ms. Eberhurst's name is spelled incorrectly as 
"Everhurst" in the salutation of the letter. Use Search to 
help you make the correction. 
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~ Choose Find What? 
from the Search menu. 

Change This Occurrence 

Change & Find Next " 
Find & Change All 

The dialog box reappears, with "information" still in it, 
but now the word is selected. This makes it easy for you 
to change the text you want to find. 

~ Type 

ver 

Find 
Cflange to 

{ver} {} . 

As soon as you start typing, "information" disappears 
and is replaced with the characters you type. 

~ Now place the insertion point at the top of the letter. 

~ Choose Find Next Occurrence from the Search menu. 

LisaWrite selects "ver" on Deex ~1s. Elmhurst 1 

~ Type 

her 

Again, as soon as you start typing, the selected text 
disappears, and the new characters are inserted. 

Selective Changes to Text 

You can also specify the change you want to make at the 
same time you tell LisaWrite to find text. Then you can 
use the Change & Find Next and Change This 
Occurrence menu items to move quickly through a 
document, selectively changing as you go. At any located 
piece of text, you may elect to change the selected text, 
to leave the selected text as it is and find the next 
occurrence, or to change this occurrence and find the 
next one. 

In the third paragraph of the letter, the word "here" 
occurs twice when it should be "hear." Use the Change & 
Find Next and Change This Occurrence items on the 
Search menu to make the correction. 

The dialog box still displays the last phrase you located. 



Replace "ver" with "here" next to "Find" in the dialog 
box. 

~ Double click to select "ver." 

~ Type Find {here} 

here Cf-Iange to {} 

~ Press the (Enter) key to Find {here} 
place the insertion point Change to {I} 
in the brackets on the 
"Change to" line. 

~ Type Find {here} 
hear Change to { rlear} 

~ Choose Find Next Occurrence. 

LisaWrite selects the first orp.,I ~lOU ~Iill III from us 
occurrence of "here." ?ase feel free to call. 

~ Choose Change & Find 
Next. Find What? 

Find Next Occurrence 

"Here" is replaced with "hear," and the next occurrence 
of "here" is selected. Change & Find Next replaces the 
selected word and then locates the next one for you. Use 
this when you think you may want to leave some 
occurrences of the word without changing it. 

~ Now choose Change 
This Occurrence from 
the Search menu. 

"Hear" replaces "here." LisaWrite doesn't look for 
another instance of the word when you choose Change 
This Occurrence. 
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Global Changes 

You can also change all occurrences of a word at one 
time. To see how this works, change "WIS Corp." to 
"Waverly Information Systems Corporation" throughout 
the letter. 

~ Scroll to the top of the letter. 

Now you'll use another method to indicate the text you 
are searching for. 

~ Select the first 
occurrence of "WIS 
Corp." in the letter. 

your 1 et t acn( 
~8.r IIMd'r 
he field of inf( 

~ Choose Copy from the Edit menu. 

~ Select "here" in the 
dialog box. 

Find 
Change to 

~ Choose Paste from the Edit menu. 

~ Press the (Enter) key and 
watch LisaWrite select 
"hear" on the "Change 
to" line. 

~ Type 

Find 
Change to 

Waverly Information Systems Corporation 

~ Select an insertion point near the top of the letter. 

~ Choose Find & Change 
All from the Search 
menu. 

Cases Must Agree 
ses Need Not Agree 



LisaWrite finds and changes your specified text 
throughout the entire letter. The last change remains 
selected in your document, as in Figure 28. 

Figure 28. Letter after Using Find & Change All 

~ Use the elevator or top view button to move quickly to 
the top of the document. Now you can see the 
changes that have been made to the company name. 

~ Choose Hide Dialog Box from the Search menu. 

Ensuring Accurate Changes 

Be sure to clearly define your changes before you choose 
Find & Change All from the Search menu. To illustrate 
the importance of this, the next steps make some 
intentional mistakes. So that you can recover from the 
mistakes, save this version of the document now. 

~ Choose Save & Continue 
from the File/Print 
menu. 

Set Aside Everything 
Set Aside "lpu-ch3" 

Save & Put Away 

Revert to Previous versionl 

~ ~ 
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As personnel manager for WIS Corporation, suppose you 
decide that you want to capitalize the word 
"information" in your correspondence about your 
company's services, to distinguish it from the general 
use of the word. You use the word frequently, so you want 
LisaWrite to make all the changes at once for you. Since 
you only want to change the first letter, you don't bother 
to type in the whole word: 

~ Place the insertion point at the top of the letter. 

~ Choose Find What? from the Search menu. 

~ Type 

in 

~ Press (Enter) to place the insertion point next to 
"Change to." 

~ Type 

In 

~ Choose Find & Change All. 

Find 
Change to 

Figure 29 shows tI-le changes iu your ietter. 

Ms. Rose.l ij. Eberhurst 
1627 H~t!lJAgs Avenue 
Cuper~o, CA 95014 

Dear Ms. Eberhurst, 

April 12, 1983 

{in} 
{In} 

Thank you for your letter and resume dated March 24, 1983. As Rersonnel 
manager of Waver.ll' Information Syst~s Corporation, j am quite Oterested ~ 
your experiS[lce QJi survey research V1 the field of aJiforme.tion systems, and I 
am circul atQJig your resume to appropri at e department s. 

As y2.J.I know, ~verly Information Systems Corporation is a small but rapidly 
gro~g firm 'W the Silicon Valley. We expect an ongc@g need for highly 
qualified@dividuals 11) survey research. 

If we that your talents can be of use :t Waverly Information ems 

Figure 29. Unexpected Changes to Letter after Find & Change All 

As you can see, LisaWrite followed your instructions, but 
went far beyond the desired changes. Every occurrence 
of "in" has become "In," even in the middle of words. 



To ensure that LisaWrite makes the changes you want, 
follow these guidelines when using Find & Change All: 

• Enter enough characters to distinguish the found text 
from similar words. In this case, you would have been 
better off entering the entire word. 

• Use Change & Find Next a few times in your document 
to verify that the change you want is being made 
before choosing Find & Change All. 

• Remember to decide whether you want to use Cases 
Must Agree or Cases Need Not Agree before having 
LisaWrite make the change throughout. 

Returning to a Previous Draft 

When you make changes to the text of a document and 
then decide you don't want them, you can tell LisaWrite 
to scrap your changes and return the document to its 
previous state. 

Since the sample letter now contains many errors, go 
back to the last version. Fortunately, you saved a copy of 
it just before starting this last example. 

~ Choose Revert to 
Previous Version from 
the File/Print menu. 

Revert to Previous Version ' 

Fonnat for Printer ... 
Print... 
Monitor the Printer ... 

An alert box appears, with a message asking you if you 
really want to throwaway your cha~ges. Figure 30 shows 
this dialog box. 
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00 you really want the active document to 
revert to the version saved 1 hour ago? 

IF y~J want to leave the document as it 
is now, click (ancel. 

Once you click OK, you will not be able 
to change your mind, even with Undo. 

Figure 30. Revert to Previous Version Alert Box 

~ Click the OK button. 

(ancel 

OK 

The last draft of your document displays on the screen. 

When you tell LisaWrite to revert to the previous draft, 
the text of your document is returned to its state when 
you last saved it. Save & Continue and Save & Put Away 
menu items both update the current draft stored on your 
Lisa. 

You've completed the work with this letter, so put it away 
..... ,.....,., 
IIVYV. 

~ Choose Save & Put Away from the File/Print menu. 

~ Place the document in your tutorial folder. 

This completes Chapter 3. Go on to the next chapter, if 
you like, or come back to it later. 



Chapter 
Summary 

Locate specific text 

Locate the next 
occurrence of specific 
text 

Locate text to change 

Find and change 
all occurrences 
of specified text 

• Choose Find What? from 
the Search menu. 

• Type the text you want to 
locate in the dialog box 
next to "Find:". 

• Place the insertion point 
at the top of the 
document. 

• Choose Find Next 
Occurrence from the 
Search menu. 

• Choose Find Next 
Occurrence from the 
Search menu. 

• Choose Find What? from 
the Search menu. 

• Type the text you want to 
locate in the dialog box 
next to "Find:". 

• Choose Find Next 
Occurrence from the 
Search menu. 

• Make any changes you 
want to the found text. 

• Choose Find What? from 
the Search menu. 

• Type the text you want to 
change in the dialog box 
next to "Find:". 

• Press (Enter) to place the 
insertion point next to 
"Change to:". 

• Type the text you want to 
be inserted. 

• Choose Find & Change 
All from the Search 
menu. 
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Find and change text 
selectively 

Scroll in a document 

Return to the last saved 
draft of the document 

• Choose Find What? from 
the Search menu. 

• Type the text you want to 
change in the dialog box 
next to "Find:". 

• Press (Enter) to place the 
insertion point next to 
"Change to:". 

• Type the text you want to 
be inserted. 

• Choose Find Next 
Occurrence from the 
Search menu. 

then 

• Choose Change & Find 
Next from the Search 
menu to replace the 
selected text and go to 
the next occurrence. 

or 

• Choose Find Next 
Occurrence from the 
Search menu to leave the 
selected text as it is and 
find the next occurrence. 

or 

• Choose Change This 
Occurrence from the 
Search menu to replace 
the selected text and 
remain at that point in 
the document. 

• Point to and click on any 
of the items in the scroll 
bar: scroll arrows, view 
buttons, or the elevator. 

• Choose Revert to 
Previous Version from 
the File/Print menu. 
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Formatting Long Documents 
- Page Layout 

You can write documents with LisaWrite without thinking 
about how the text is arranged on each page because 
standard page layout settings are provided. However, 
you may want to mod ify the layout to take advantage of 
special features or to format your documents a different 
way. 

In this chapter you learn to 

• Use Preview to view documents on the screen as they 
will be arranged on pages, including top and bottom 
margin spacing and text. 

• Change top and bottom margins. 
• Add text that will print within the top or bottom margin, 

or both, of each page of a document. 

• Add page numbering. 
• Keep sections of text together on a page. 
• Force text to print on a new page. 
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Page Layout Menu The Page Layout menu, illustrated in Figure 31, shows 
you some of the items you can change when formatting 
your documents. The Format ~ and Type Style menus 
provide other formatting changes, and are discussed in 
Chapter 2, Formatting a Document. 
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Page layout settings determine which text prints on each 
page, the margins left blank at the top and bottom edges 
of each page, and any header and footer information that 
prints within those margins. 

Show Page Ruler 

Hide Page Ruler 

I nsert Page Number 

Insert Page Mark 

Keep On Same Page 
Ilow to (ross Pages 

Figure 31. Page Layout Menu 

A sample document, a marketing report that is 
"complete" yet needs page formatting, is on the Chapter 
4 stationery pad in the LisaWrite Examples folder. 

~ Open the ProFile window if it is closed. 

~ Open the LisaWrite Examples folder. 

~ Tear off a piece of the Chapter 4 stationery. 

~ Name the new document by typing your initials 
followed by Ch4. 

~ Open the new document. 

The first portion of the document appears in the active 
window. Figure 32 shows you what you see on your 
screen. 



Previewing a 
Document as It 
Will Print 

El 

l¢l 

TARKETING RESEARCH REPORT 

FREPARED BY VIDEO SYSTEMS MARKETING 

SUBJECT: VIDEO DISK Rf::CORDERS 

STUDIES OF: CONSUMERS 
MIDDLE MANAGERS 
STEREO SALES REPRESENTATIVES 

BACKGROUND 
Three merketing research studies were recently completed dealing witll upper income 
($25, 000 plus) heads of households, middle level business managers, and stereo 
store sales represent at ives. Detailed reports prepered by the fims which 
conducted each specific study have been circulated to the individuals most directly 
affected by the resul ts of the study. 

These studies, when analyzed together, suggest that there is: 

Figure 32. Marketing Report 

Use the view controls to look through the report and get 
an idea of its length and content. It is long enough to 
require two printed pages. 

LisaWrite can show you a picture of your document on 
the screen as it will be arranged on each page when you 
print it. To use this capability, choose the Preview item 
from the Page Layout menu. By previewing the marketing 
report, you can see how it will print using the standard 
page layout settings currently active in LisaWrite. 

~ Open the Page Layout 
menu and choose 
Preview Pages. 

Look through the report again, using the view buttons 
and scroll arrows. The text now appears on two separate 
"pages." A wide blank space is left between each page, 
showing the top and bottom margins. Figure 33 shows 
the margins between pages 1 and 2. 
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that these customers are often looking for a rationale for purchase. This is <Q 
evi denced by a great er interest in movi e recordi ngs (oft en, for consumers, ones that e::J 
will help justify the purchase in one's family). 

BARRIERS TO PURCHASE 
Reasons for not wanting to purchase included (but are not necessarily limited to) 
feelings that the price is too and that prices will decline substantially. 

Figure 33. Previewing the Margins between Pages 1 and 2 

The length of the simulated pieces of paper that you see 
on the screen is determined by the paper size set in the 
printer specifications. When you don't change it, the 
standard page length is 11 inches. 

Now turn Preview off. 

~ Choose Don't Preview 
Pages from the Page 
Layout menu. 

The margins between the pages disappear. 

You could print the document now, before doing anything 
to alter the way the text would fallon the printed pages. 
In that case, the document would have: 

• No page numbers. 
• No headers or footers. 
• Top and bottom margins of 1 inch. 

The sections that follow show you how to make some 
quick changes to improve page format before printing 
the marketing report. 



Setting Top and Bottom Margins 

Using Preview, you saw the amount of space left for top 
and bottom margins. To see the current settings that 
determine that space, bring the page ruler to the screen. 

~ Choose Show Page 
Ruler from the Page 
Layout menu. 

A vertical page ruler appears to the right of your text, and 
the Page Ruler menu appears at the end of the menu bar. 
Preview is automatically turned on when the page ruler 
appears. Your screen now looks like Figure 34. 

rage Ruler menu 

File/Print Edit Search Type Style Format I Page Layout Page Ruler 

LI I 

- -¥ 
f- <8 ~ 

rARKETING RESEARCH REPORT 
:J.<f] 

PREPARED BY VIDEO SYSTEMS MARKETING f-

-
SUBJECT: VIDEO DISK RECORDERS X :.1 

-
STUDIES OF: CONSUMERS 

MIDDLE MANAGERS I-

STEREO SALES REPRESENTATIVES -
BACKGROUND :..l 
Three marketing research studies were recently completed dealing with upper il~ ~ 
($25,000 plus) heads of households, middle level business managers, and sIl- O 

10 C)5J 

Figure 34. Page Ruler and Its Menu 

Scroll through the document again. As you see, there is a 
separate vertical ruler for each page frame. 

Like the horizontal paragraph ruler described in Chapter 
2, Formatting a Document, the page ruler can show 
inches or centimeters as its measure. You can use 
whichever settings you prefer to work with in your 
documents. Right now it shows inches. 

Chapter 4 
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~ Choose Metric Scale 
from the Page Ruler 
menu. The ruler changes 
to centimeters. 

Figure 35 shows the ruler with metric measurements. 

:l 

MARKETING RESEARCH REPORT 

PREPARED BY VIDEO SYSTEMS MARKETING 

SUBJECT: VIDEO DISK RECORDERS 

STUDIES OF: CONSUMERS 
MIDDLE MANAGERS 
STEREO SALES REPRESENTATIVES 

research studies were recently completed dealing with upper it~ ~ 
of middle level business and sl: {) 

~ Choose Inch Scale from 
the Page Ruler menu. 
The ruler changes back 
to inches. 

~51 

~ Position the document in the window so that you see 
the end of the first page and the beginning of the 
second. 

This lets you see the bottom of one ruler and the top of 
another. Your screen should look something like 
Figure 36. 



reported that they are seeing more customers who have a strong consumer int 
that these customers are often looking for a rationale for purchase. 
evidenced by a greater interest in movie recordings (often, for consumers, 
will help justify the purchase in one's family). 

BARRIERS TO PURCHASE 

v 
J.. 

Reasons for not ~Ianting to purchase included (but are not necessarily limite 
feelings that the price is too high and that prices will decline substanti 

Figure 36. Viewing Page Rulers at Bottom of Page 1 

Look at the page rulers and find the four triangular 
markers .&" &., &, and,£.. They are positioned 
at the standard page layout settings . 

.&, is positioned at the 1 inch level of the second page, 
indicating where the top line of text on a page will print. 
Although you see it on the ruler for page 2, the top 
margin setting is the same for each page of your 
document. In fact, all page ruler settings are the same 
throughout a document. 

&. is positioned at the 10 inch marker on the first page, 
indicating where the bottom line of text on a page will 
print. 

& and ,£. indicate where any headers and footers will 
appear within the top and bottom margins. You add a 
header and footer to the marketing report later in this 
chapter. 

One inch top and bottom margins on 11 inch paper are 
often used for office documents. That's why they are the 
initial settings on LisaWrite stationery. You can change 
them quickly and easily when you want larger or smaller 
margins, though. To see how, increase the top margin to 
1-1/2 inches. 
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~ Press and hold the 
mouse button on the .&, 
pulling it to the 1-1/2 
inch position. 

:..l 

The text on page 2 moves down to the 1-1/2 inch marker. 
Since this changes the top margin for all pages in the 
document, including page 1, some of the text from page 
1 moves to the top of page 2. 

Your screen now looks something like Figure 37. 

8'nd their reactio'ns to current ;dvertiSing clearl':/ indicated a strong'lntere~ .0 
personal/home usage. Furthermore, the dealer sales representati''J'e w - eJ 
investigated indicated that there has been a change 1n buyers. That 18. -
reported that the~1 are seeing more customers who he:'j8 a strong consumer interes~ 

~~ 

- <8 

:...l 

1

-

Figure 37. New Top Margin for Marketing Report 

As you make changes to the page layout settings, keep in 
mind that every document has only one setting for the 
top of text, the bottom of text, the header, and the footer. 
Every time you change one marker on one ruler, all rulers 
and all text change to match. You can make the changes 
on any page. 



Headers and Footers 

Headers and footers are text that print within the 
margins at the top and bottom of each page of a 
document. To insert a header or a footer, or both, in your 
document, you type text in the top or bottom margin next 
to the &. and £::. symbols. The text of a header or footer 
can be edited and formatted using any of LisaWrite's 
capabilities. 

To get the knack of entering headers and footers, add 
the heading "Marketing Report" to the top of each page, 
and a footer containing the page number to the bottom 
of each page. 

~ Place the insertion point in the top margin of the 
second page, on the line to the left of the &., as 
shown in Figure 38. 

I I 

Insertion point 

Figure 38. Insertion Point next to Header Marker 

~ Choose Right Flush from 
the Format ~ menu. 

~ Now type 

Marketing Report 

r1lJ I 
Header marker iiiii'i 

The words appear at the right side of the top margin, 
next to the &.. If the right margin was underneath the 
page ruler, LisaWrite may scroll the text of the report to 
the left so that you can see the full header text. Your 
screen looks something like Figure 39. 
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t1ark.et i ng Report:- <.~ 

B.t these customers are often looking for 8. rationale for purcl-l8.se. TI-lis is :-

Figure 39_ Inserting Header at Top of Page 2 

~ Click and hold the 
mouse button on the ,& 
in the page ruler and pull 
it from the 1/2 inch mark 
to the 3/4 inch mark. 

t1erket i ng Report ~ xe 

Your header moves down in the top margin to align with 
the ,&. 

Now set a footer that contains an incrementing page 
number: 

~ If you can't see the left margin of the text, use the left 
scroll arrow to bring it into view. 

~ Place the pOinter in the bottom margin on the line to 
the left of the £. on the first page and click the mouse 
button. The insertion point appears at the far left 
margin. 

~ Type 

Page 

~ Press the space bar once after the word "Page." 

~ Choose Insert Page 
Number from the Page 
Layout menu. 



LisaWrite knows that this is the first page of your 
document, and automatically inserts a "1" at the 
insertion point. Figure 40 shows the marketing report as 
it looks now. 

and their reactions to current advertising cle&ly indicated a strong interest 
personal/home usage. Furthermore, the dealer sales representative who-
investigated indicated that there h8.s been a ehs.nge 1n buyers. That is, t­
reported that they &8 seeing more customers \~ho have a strong consumer interest ~ 

:lli~ 

~ q] 

M&keting Rep~ <8 

tl-Iat tl18se customers ere often looking for 8. ratlonale for purcl-Iase. Tl1is::- 1] 
evidenced by a I~reater interest in movie recordings (often. for consumers .. ones t - ? 

Figure 40. Marketing Report with Page Number Inserted 

Now center the footer: 

~ Choose Center from the 
Format ~ menu. 

O~ 

Now scroll through the document. "Marketing Report" 
appears at the top of each page, while page numbers 
appear centered at the bottom of each page. You can set 
or change headers and footers on any page of your 
document. LisaWrite automatically duplicates them on 
all the other pages. 

In this example, you used Center and Right Flush 
formatting from the Format ~ menu. You can use any 
LisaWrite editing or formatting features with header and 
footer text, including changing the left and right margins 
and setting tab stops. 

Now turn Preview off. 
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~ Choose Don't Preview 
from the Page Layout 
menu. 

Turning Preview off also hides the page ruler. 

Scroll through the document again. You no longer see 
the headers and footers, but they are still there. You can 
check them at any time by choosing Preview Pages or 
Show Page Ruler from the Page Layout menu. 

Page Breaks 

Page breaks tell LisaWrite when to stop printing lines on 
one page and move on to the next page. Some page 
breaks are automatically set by the top and bottom 
margin settings. 

You can set other page breaks in a document with items 
on the Page Layout menu . 
....... "1 _____ r'\ _____ ~ ____ r-\ _____ L.. _____ ..1.1 __ ~ ____ I ______ .1... ____ _ 

III""'"" vIlUU::;~ r-r~vl~w r-i:1y~::; HUIII lIl~ r-i:1y~ Li:1yUUl III~IIU. 

Once again, scroll through the document and notice how 
the text is divided between pages. The page divisions you 
first looked at are gone because you altered the top 
margin, redistributing the text. For the next two steps, 
we've decided that the paragraph split between pages 1 
and 2 might look better if it all printed on the second 
page, and the chart at the end should be on its own page. 
Figure 41 shows the current page break between pages 1 
and 2. 



El 
and their reactions to current advertising clearly indlcated a strong interest HI 
personal/home usage. Furthermore, tile dealer ss1es representatl"V8 who Ive 
investigated indicated that there has been 8. ch8nge in buyers. That lS, they 
reported that they are seeing more customers Iv110 have a srn'~ cOlisurner interest and 

Page 1 I 

Marketl ng Report 

that these customers are often looking for 8. ratlonale for purcl'l8.se. HilS is Ii] 
evidenced by a greater lnterest in movie recor,jings (often, for consumers, ones tllat ~ 

c)t5] 

Figure 41, Current Page Break in Marketing Report 

In additon to setting top and bottom margins, there are 
two ways you can control how text is divided between 
pages . 

• You can define text passages that are never to be 
interrupted by a page change. LisaWrite then attempts 
to fit the whole passage on a page. When there isn't 
room, the whole passage is placed on the next page . 

• You can establish points in the document where you 
want new pages to start. Use this method to insert 
page breaks before text that should always start at the 
top of a new page. 

Keeping Text on the Same Page 

When you want to keep a passage together on one page, 
use the Keep on Same Page item from the Page Layout 
menu. Try this with the paragraph that is now split at the 
bottom of page 1. 

~ Scroll the document on your screen so that you can 
see the end of page 1 and the beginning of page 2. 

~ Now use the upper scroll arrow to scroll the text down 
the screen until you can see the top of the paragraph 
and the line with the heading "Consumer PotentiaL" 

~ Triple click to select "Consumer Potential" and 
pull the pointer down to select the paragraph that 
follows it. 
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Your screen looks like Figure 42. You don't see the 
bottom of the selected paragraph, because it is on the 
next page. Scroll the text up if you want to make sure it is 
selected. 

Page 1 

Figure 42. Selecting Text to Keep on Same Page 

Open the Page Layout menu. Notice that Allow to Cross 
Pages is checked. You want to keep this text together, so 

~ Choose Keep On Same 
Page from the Page 
Layout menu. 

Immediately, the entire passage is moved to the top of 
page 2 and the rest of the document is adjusted on the 
remaining pages. 

~ Scroll the document up to see the top of page 2 with 
the text moved to it. 

Your screen looks like Figure 43. 



Page 1 

t1erketlng Report 

Figure 43. Passage Kept Together 

To get rid of a Keep on Same Page instruction, select the 
text that is kept together and choose Allow to Cross Pages. 

Inserting Page Marks 

The table at the end of the marketing report is an 
attachment to the report, and should always print on a 
new page. To ensure this, use Insert Page Mark. 

~ Scroll the document so you can see the beginning of 
the table. Your screen should look something like 
Figure 44. 

dl~1< recorders concept incilJates a cleer and immediate potentlal, 

Total U,S, Households: 
wi t h incomes> $25, 000 

r;ONSUMER MARKET ESTI MATES 

76 Million 
13,8 t1ll11on (18~'; of all I'louseholdsl 

Consumer Interest in Purchasing 
Defini telv interested 8% 
Probablv interested 6% 
Signi f1cant interest 14~, 

Calculation of Current Potential 
Defini telv interested 

(8%) (13,'8Million) = 1.1 Milllon 
pi'obablv interested 

(6%) (13.8Million) = ,8 Million 
Total interested 1, 9 ~ll11iol1 

Figure 44. Beginning of Table 

x 
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~ Place the insertion point 
next to the title 
"CONSUMER MARKET 
ESTIMATES." 

~ Choose Insert Page 
Mark from the Page 
Layout menu. 

~ONSUMER MARKET ESTIMATES 

76 Million 
13. 8 t1illion(18~~ of all households) 

Insert Page Number . .. 
Keep On Same Page 

..,fAllow to (ross Pages 

A symbol representing the page mark is placed in your 
text, and the beginning of the table is forced to the top of 
page 3. Scroll through your document to see the page 
mark on page 2 and the table on page 3. Figure 45 shows 
how the top of page 3 now appears. 

CONSUMER MARKET ESTIMATES 

Total U.S. Households: 76 Million 
with incanes ) $25, 000 13.8 Million (18% of all households) 

Consumer Interest in Purchasing 
Defini tely interested 8'4 
Probably interested 6% 

Significant interest 14% 

Calculation of Current Potential 
Definitely interested 

(8%) (13.8 Million) = 
Probably interested 

13.8 Million = 

Figure 45. Forced Page 8reak 

1.1 Million 

Merketing Report 

You can use all the other LisaWrite features and 
capabilities while you are previewing text and using the 
page layout settings. You will find that some LisaWrite 
features take longer while your document is being 
previewed, however, so you may want to turn preview off 
before making major editing or formatting changes. 



Printing the 
Document 

As a final step in this chapter, print out the document. 

~ Choose Print from the File/Print menu. 

~ Click OK in the dialog box. 

Now put the document away. 

~ Choose Save & Put Away from the File/Print menu. 

This completes Chapter 4. Go on to the next chapter, if 
you like, or come back to it later. 
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Preview a document 

Display the page ruler 

Change the ruler scale 
from inches to metric 

Change top and bottom 
margins 

I nsert headers and 
footers 

Insert page numbers 

• Choose Preview Pages 
from the Page Layout 
menu. 

• Choose Show Page Ruler 
from the Page Layout 
menu. 

• Choose Show Page Ruler 
from the Page Layout 
menu. 

• Choose Metric Scale 
from the Page Ruler 
menu. 

• Choose Show Page Ruler 
from the Page Layout 
menu. 

• Pull the .&. and .£ 
markers to the new 
rn~rnin nnc::itinnc:: ... _. ;:' ... .- -_ ... _ .. _. 

• Turn the page ruler on. 

• Place the insertion point 
on the line next to the & 
or .£. markers. Most of 
the time the insertion 
point will be at the left 
margin. 

• Type the header Ifooter 
text. 

• Turn the page ruler on. 

• Place the insertion pOint 
on the header or footer 
line. 

• Choose Insert Page 
Number from the Page 
Layout menu. 



Keep text together on a 
page 

Insert page marks 

• Select the text. 

• Choose Keep On Same 
Page from the Page 
Layout menu. 

• Place the insertion pOint 
where you want the page 
mark. 

• Choose Insert Page Mark 
from the Page Layout 
menu. 

Chapter 4 
Formatting Long Documents - Page Layout 
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Creating Tables with Tabs 

This chapter teaches you to set and use tabs so you can 
produce tables and text with various indents. You learn 
to 

• Set tab stops for left and right flush text, centered text, 
and decimal-aligned text. 

• Type text that uses tab stops. 
• Set a character pattern that fills the space up to a tab. 
• Change tab stops. 
• Clear tab stops. 
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Using tabs with LisaWrite is similiar to using them on a 
typewriter, but with much greater flexibility. You set tab 
stops at locations between the left and right margins on a 
page and press a (Tab) key to cause the next text to skip 
to that location. 

With LisaWrite, the tab stops you set can have different 
formats. You can set: 

• Normal (Left Flush) Tabs: 
The text begins at the tab 
stop and proceeds to the 
right. 

• Right Flush Tabs: The 
text appears to the left of 
the tab stop. 

• Centered Tabs: The text 
centers on the tab stop. 

• Decimal Tabs: The 
decimal point aligns on 
the tab stop. 

Normal tabs 

Centered tab 

, I' '1'1' '1'1'1'1 ":::,:::,, 

~ ~A~ 7£~i 
And, of course, you can reset tab stops to experiment 
with the positioning of items and columns. 

In this activity, you enter part of a short income 
statement for a typical quarterly report and learn to use 
LisaWrite's different tabs to set it up. Figure 46 shows 
the statement in handwritten form. 



Entering Text with 
Tab Characters 

~ {~; ~~ ~ jJ~~ 
/L..u ~'fL ~d 
'11t~ 3 / 

I~?, ~ 

~ . _.. ~~J/ 'i~tJ,a2J 

t!.,..~ . - - . ;Lt.,';} 7.;z-/J 

d.............y fu ~(,.I ~"'r, 102 

Figure 46. Quarterly Income Statement 

To begin, create a new document from a blank piece of 
paper. 

~ Tear off a piece of blank stationery from the LisaWrite 
pad. 

~ Name the new document "your initials-ChS." 

~ Open the new document. 

On a typewriter, you set tab stops before typing your text. 
You can do the same with LisaWrite, or you can type the 
text and then set the tab stops. In this exercise you try it 
both ways. 

Start by entering the first line of the income statement. 

~ Type 

(Tab) Income Statement: Smith's Paints (Return) 

When you press the (Tab) key, an "invisible" character is 
recorded along with your text. The tab character is only 
seen when you select it, and then it looks much like a 
blank space. 

The text you just typed belongs at the right margin of the 
income statement. To place it there, 

~ Select the line of text, or 
place the insertion point 
somewhere within that 
line. 

Income Statement: Smith' s P~int~ 
I 
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~ Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. 

...ILeft Flush 
Center 
Right Flush 
Justify 

The Ruler menu appears at the end of the menu bar and 
the horizontal ruler appears in your document. Right now 
the ruler shows the first-line, left, and right margins. 

~ Open the Ruler menu. 

Look at the items on the menu; they are the items you 
use to create different kinds of tab stops. In addition, you 
can change the measurements on the ruler from the Inch 
Scale to the Metric Scale on this menu. Figure 47 shows 
your text, the ruler, and the Ruler menu. 

U I Inch scOie-
Income St.atement: Smi HI's paint4 Metric Scale 

, ; '11 ' I ' I ' , '21 ' I ' I ' I '31 ' I ' I ' 1 '41 ' I ' I ' I '51 ' I ' I ' I ' 
Clear Tab Stop 

~ 
Set Normal Tab 
Set Centered Tab 
Set Right Flush Tab 
Set Decimal Tab 

No Tab Fi" Pattern 
.. Tab Fill Pattern 
-- Tab F ill Pattern 

Tab Fi" Pattern -

Figure 47. Ruler and Ruler Menu 

To set a tab stop, 

~ Move the pointer to the 
7 inch mark on the ruler. 

I 'sl ' I ' I ' I I~C I I I 

~ Click the mouse button. 



The black triangular tab 
marker moves to join the 
pointer at the 7 inch mark. 
The position of this tab 
marker is where the tab will 
be set. 

~ Open the Ruler menu 
and choose Set Right 
Flush Tab. 

1'.1' 1'1'1' '1'1 
b .1 

I 

Inch Scale 
Metric Scale 

Clear Tab Stop 
Set Normal Tab 
Set Centered Tab 

Set Decimal Tab 

Several things happen: a symbol for a right flush tab 
appears on the ruler at the 7 inch position, and the tab 
character in the selected line, responding to the tab stop, 
moves the text right flush to the tab stop. 

~ Choose Hide Margin/Tab Ruler from the Format ~ 
menu. 

Figure 48 shows how your screen should look. 

Income Statement: Smi th' s Ps.int, 

'1'1' 1'1'1'1' 1'1'1'1' 1'1'1'.1' 1'1'1'1' 1'1'1 '.1' 1'1'1 '. '1'1' 
1 2 3 4 5 b I 

.l. 

Figure 48. First Paragraph at Flush Right Tab Stop 

Clearing Tab Stops 

For now, skip the column headings and the two-line 
heading; since the column headings are centered over 
the columns and the two-line heading is centered over 
the column headings, they are best added after the 
columns of text and numbers are in place. 

~ Place the insertion point 
at the end of the line and 
press (Return). 

Income Statement: Smith's Paint .. 
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This ensures that the new paragraph will use the same 
tab stop that you just set. When you press (Return) and 
begin a new paragraph, the new paragraph assumes the 
paragraph format styles of the starting paragraph. 

~ Now type the first line containing multiple tabs: 

(Tab) Income C~) $22,460.25 (Tab) $29,500.60CReturn) 

Since your new paragraph has the same tab stops as the 
last paragraph, your first tab character responds to the 
same tab stop, plaCing "Income" right flush at the tab 
stop. The second tab stop extends past the right margin, 
and wraps the first number to the beginning of the next 
line, and the third tab stop is placed at the right flush tab 
stop on the next line. Your screen looks like Figure 49. 

$22,460.25 

Income Statement: Smith's Paints 

Income 
$29,500.60 

Figure 49. Three-Column Paragraph without Proper Tab Stops 

Since you want this paragraph to use different tab 
settings, delete the old tab stop. 

~ Select the paragraph or 
place the insertion point 
within the paragraph. 

~ Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. 

I 
,,/left Flush 

Center 
Right Flush 
Justify 



~ Click over the right flush 
tab stop at 7 inches to 
place the tab marker 
there. 

~ Choose Clear Tab Stop 
from the Ruler menu. 

Income 
$29, :,00. 6r, 

"1' I' ;.' I' '1'1 
h .. . j, 

Inch Scale 
Metric Scale 

I.aU.IJI 

Set Normal Tab "\ 
Set Centered Tab 
Set Right Flush Tab 
Set Decimal Tab 

~ 

The tab stop disappears from the ruler. Now that the 
paragraph has no tab stop, it is repositioned at the left 
margin. 

Setting a Normal Tab 

To set a new tab stop for the selected paragraph, 

~ Place the pointer at 3 
inches on the ruler and 
click the mouse button 
to bring the tab marker 
there. 

~ Choose Set Normal Tab 
from the Ruler menu. 

'21' I ' i ' I 'J' I ' I ' I '41 ' 

X 

Inch Scale 
Metric Scale 

Clear Tab Stop 

Set Centered Tab 
Set Right Flush Tab 
Set Decimal Tab 

A symbol representing a normal (left flush) tab appears 
on the ruler. The first tab character in the paragraph of 
text responds to the new tab stop, and the paragraph 
moves to the 3 inch marker. Figure 50 shows the 
resulting change. 
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Income Statement: Smitr,'s Paints 

I nCDrne $22,460.25 $29, 500. 6~ 

, "1"'1"'1"'1' I '~' I ' I ' I ' I ' I ' I ' I 'e,1 ' I ' I ' I ' I ' "1' I '~II ' "1 
1 2 )! 4 _ 6 , 

!.... 

Figure 50. Three-Column Paragraph with One Tab in Effect 

Since you set a normal or left flush tab, the text proceeds 
from that point to the right. 

Setting a Decimal Tab 

It is customary to line up the decimal points when typing 
numbers in a column. So when you set the tabs for the 
two dollar values in this line, use decimal tab stops. 

~ Move the black triangle 
to a position at 5-1/2 
inches on the ruler. 

~ Choose Set Decimal Tab 
from the Ruler menu. 

~ Move the black triangle 
to a position at 7 inches. 

, I '~)I ' I '1' I '61 ' I ' I ' I ' 

r 

Inch Scale 
Metric Scale 

.. ,,, ....... ,, ....................... ,,",, ......... , .......... ,, ....... . 

- 1-

No Tab Fill Pattern 
.. Tab Fill Pattern 
-- Tab Fill Pattern 

Tab Fi II Pattern 

'6\ ' I ' I ' I 'i ' I ' I 

I 



~ Choose Set Decimal Tab 
from the Ruler menu. Inch Scale 

Metric Scale 

Clear Tab Stop 

Set Normal Tab 

Set Centered Tab 

Set Right Flush Tab 
- I -

LisaWrite adds two symbols for decimal tab stops to the 
ruler and displays the paragraph in the appropriate three 
columns. Figure 51 shows your screen. 

Income Statement: Smith's P8.ints 

Income $22,460.25 $29,500.60 

, I '11 ' I ' I ' I '21 ' I ' 1'1 '31 ' I ' 1'1 '41' I ' I ' I '51' I ' I ' I '61 ' I ' I ' I '~' I ' I 

~ A. ~ ~ & 

Figure 51. Paragraph in Three Columns 

Setting a Fill Pattern for a Tab Stop 

The handwritten copy of the earnings statement shows a 
line of dots, called a "leader," between the word 
"Income" and the dollar amount of income (Figure 46). 
To get those dots, you could have typed periods when 
you typed the line, except that you didn't know how many 
to type. 

Instead of typing periods, you can instruct LisaWrite to 
add a "fill pattern" to a tab. This fills the space from the 
last text to the tabbed text with the character that you 
specify. 

To add a fill pattern to the second tab stop, 

~ Move the black 
triangular tab marker to 
the first decimal tab stop 
at 5-112 inches on the 
ruler. 

, 1' .. 1·' t' I '.1.' I.' I' 

5 ~ 61 
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~ Choose ... Tab Fill 
Pattern from the Ruler 
menu. Metric Scale 

Clear Tab Stop 
Set Normal Tab 

Set Centered Tab 

Set Right Flush Tab 
Set Decimal Tab 

No Tab Fi II Pattern 

Tab Fill Pattern 

A row of periods displays between "Income" and the first 
dollar value. Now close the ruler and the Ruler menu, 

~ Choose Hide Margin/ 
Tab Ruler from the 
Format ~ menu. 

v'Left Flush 
Center 
Right Flush 
JustiFy 

Show Margin/Tab Ruler 

Your screen now looks like Figure 52. 

Income Statement: Smi t f-,' s Pe.i nt s 

Income ............. $22, 460.2:) $29, :',00 . 6~ 

Figure 52. Filled Tab Stop 

Adding More Rows to the Columns 

As you add the next lines to the table, LisaWrite applies 
the tab stops of the current paragraph to the new 
paragraphs. 

~ Place the insertion point at the right margin of the 
current line and press (Return). 



~ Type: 

(Tab) Expenses (Tab) 

The fill pattern is automatically inserted after you press 
the second (Tab). It is part of the ruler settings for these 
paragraphs. 

~ Continue typing 

26,372.13 (Tab) 23,820.09 (Return) 

(Tab) Earnings before taxes (Tab) 

6,088.12 (Tab) 5,680.51 (Return) 

~ Press (Return) two more times to add blank lines at the 
bottom of the document. Since this is a short 
document, the extra lines will let you scroll text under 
the ruler in the next exercise. 

Figure 53 shows your screen when all the rows are typed. 

Income Sta.tement: Smith's Paints 

Income ............. $22 .. 460 .25 $29/ 500.60 

EJ; penses ............ 26 .. 372 .13 23 .. 820.09 

Earnings Mfore taxes.. 6 .. 088 .12 5 .. 680.51 

Figure 53. Several Rows of Three Columns 

Setting Centered Tabs 

All that remains to be added to the income statement 
now are the headings. You enter these as centered tabs. 

~ Place the insertion point 
at the end of the first line 
of text and press 
(Return). 

Sm it h ' s P ;3.i n t :. 

$291 500.60 

23/ 820.09 

5 .. 680.51 
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~ Choose Show Margin/Tab Ruler from the Format ~ 
menu. 

As you can see, the settings on this ruler are the ones you 
used for the first line of the document. Clear the current 
right flush tab stop. 

~ Move the black triangle to the right flush tab. 

~ Choose Clear Tab Stop from the Ruler menu. 

The line you want to enter now will have one centered tab 
stop. To set it, 

~ Pull the black triangle to 
a position midway 
between the the two 
columns of numbers. Six 
inches looks about right. 

~ Choose Set Centered 
Tab from the Ruler 
menu. 

'cl ' : . i ' : 'I' I ' I ' I '_"i .) , II 

Inch Scale 
Metric Scale 

Clear Tab Stop 
Set NOfrYlu i T uu 

~ Choose Hide Margin/Tab Ruler from the Format ~ 
menu. 

~ Type 

(Tab) Three Months Ended (Return) 
(Tab) March 31 (Return) 

LisaWrite centers the text marked by tab characters at 
the centered tab stop you set. Your screen looks like 
Figure 54. 



Income Ste.tement: Smith's Paints 

Three t'1ont rls Ended 

Income ............. $22,460.25 $29,500.60 

Ex penses ............ 26, 372. 13 23,820.09 

5,680.51 Esrnings before taxes.. 6,086.12 

Figure 54. Lines Centered at Tab Stop 

To center the column headings, you do pretty much the 
same thing. 

~ The insertion point should be at the left margin of the 
line below "March 31." If it is not, select an insertion 
point there. 

~ Choose Show Margin/Tab Ruler from the Format ~ 
menu. 

Clear the existing tab: 

~ Move the black triangle 
to the tab stop on the 
ruler, open the Ruler 
menu, and choose Clear 
Tab Stop. 

Inch Scale 

Metric Scale 

Set Centered Tab 
Set Right Flush Tab 
Set Decimal Tab 

~ Use the lower scroll arrow to scroll the text up until 
you can see the line of income figures. 

Set a new tab: 

~ Place the black triangle 
at a position centered 
over the 1982 column; 
5-3/8 inches looks 
about right. 

..... $22, 460.25 $29, 500.60 

'1'1'1'1 I'I'I'I'I'I'I'!' I 
:' 6 7 

x 
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~ Choose Set Centered 
Tab from the Ruler 
menu. 

Inch Scale 
Metric Scale 

Clear Tab Stop 
Set Normal Tab 

Set Decimal Tab 

~ Set another centered tab for the 1981 column at 
6-7/8 inches. 

If you wish, open the Format ~ menu and choose Hide 
Margin/Tab Ruler to put the ruler out of sight. 

~ Type: 

(Tab) 1982 (Tab) 1981 (Return) 

The partial quarterly income statement is shown in 
Figure 55. 

Three Months Ended 

1982 1981 

I ncorne . . . . . . . . . . . . . $22/ 460.25 $29/500.60 

El: penses ............ 26/ 372.13 23/ 820.09 

Earnings before te.xes ., 6,. 088.12 

Figure 55. Partial Quarterly Income Report 

This completes Chapter 5, so save your document. 

~ Choose Save & Put Away from the File/Print menu. 

Go on to the next chapter, if you like, or come back to it 
at a later time. 



Chapter 
Summary 

Set normal tabs 

Set right flush tabs 

Set decimal tabs 

Set centered tabs 

• Choose Show Margin/ 
Tab Ruler from the 
Format 11 menu. 

• Move the black triangular 
tab marker to the desired 
tab position. 

• Choose Set Normal Tab 
from the Ruler menu. 

• Choose Show Margin/ 
Tab Ruler from the 
Format 11 menu. 

• Move the black tab 
marker to the desired tab 
position. 

• Choose Set Right Flush 
Tab from the Ruler menu. 

• Choose Show Margin/ 
Tab Ruler from the 
Format 11 menu. 

• Move the black tab 
marker to the desired tab 
position. 

• Choose Set Decimal Tab 
from the Ruler menu. 

• Choose Show Margin/ 
Tab Ruler from the 
Format 11 menu. 

• Move the black tab 
marker to the desired tab 
position. 

• Choose Set Centered 
Tab from the Ruler menu. 
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• Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. 

• Move the black tab 
marker to the tab 
position. 

• Choose Clear Tab Stop 
from the Ruler menu. 

• Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. 

• Move the black tab 
marker to the tab 
position. 

• Choose the fill pattern 
you want from the Ruler 
menu. 

• r.h()()~~ ~h()\A1 1\" !:Il"n in / - _. -- --- _ .. _ ..... -.~ .... 
Tab Ruler from the 
Format ~ menu. 

• Place the pointer on the 
tab you want to move. 

• Press and hold, moving 
the tab marker to the new 
position on the ruler. 
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Working with 
Multiple Documents 

So far in the LisaWrite Tutorial you have worked with 
individual documents, learning to create, edit, change, 
and format text the way you want it. 

LisaWrite also makes it easy to work with several 
documents at the same time. In this chapter you learn to 

• Make your own stationery so that you have easy access 
to documents you use frequently. 

• View the contents of several documents at once on the 
desktop. 

• Move and copy text from one document to another. 
• Paste part of a LisaCalc document into a LisaWrite 

document. 
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Throughout this tutorial you've been tearing off pieces of 
stationery provided in the LisaWrite Examples Folder. 
The sample documents are set up as stationery pads so 
that you can tear off your own copy, make many changes, 
and still have an untouched copy on your disk for the 
next person who uses the LisaWrite Tutorial. 

You can create your own stationery pads to be used in 
similar ways. You may want special "letterhead 
stationery," for example, customized with your own 
headings, margins, and spacing to use for 
correspondence. Or you may want to make stationery for 
special forms you use in your business. Virtually any 
LisaWrite document can be turned into a stationery pad. 

To see how easy this is, create a letterhead stationery 
pad. 

~ First, tear off a piece of the LisaWrite Paper stationery 
to create a new document. 

~ Name the new document "your initials-letterhead." 

~ Open the document. 

~ Choose Single Space ~ from the Format ~ menu. 

~ Choose Center from the Format ~ menu. 

~ Type your name and address, or your company's 
name and address, pressing (Return) at the end of 
each line. 

~ With the insertion point on the line below the name 
and address, choose Left Flush or Justify, as you 
prefer, from the Format ~ menu. 

~ Set the paragraph and line spacing as you want to use 
them for your correspondence. 

~ Make any other format changes, including setting 
margins and tabs as you want them. If you want the 
heading to print in a different type style from the bulk 
of your correspondence, select the name and address 
and choose the type style you want. 

~ Save and put the document away. 

~ Move the document icon to an uncluttered part of 
your desktop. 



Viewing Multiple 
Documents 

~ With the document icon 
still selected, open the 
File/Print menu and 
choose Make Stationery 
Pad. 

Set Aside Everything 
Set Aside "Profile" 

I··· .... · .............. ·· ...... ·· .............. · ........ · ...... · .... · ........................ · ................ EI! 

\qV~.:: f, h.~t 

Open "Letter" 
Ouplicate .0 
Te·ur UH' §tnt~om.:rq 

That's all there is to it. Your new stationery automatically 
takes on the name of the document. Change it if you like, 
or leave it with the name it has now. 

You already know that the Clipboard can be open at the 
same time you have a document open. And the disk 
window is often open when you work on a document, 
although it may be "under" your active document 
window. You can also open more than one document 
window at a time. If you arrange the positions and sizes 
of the documents, you can view two or more 
Simultaneously. Viewing more than one document is 
useful when you want to see information in one 
document while working on another or when you want to 
copy parts of one document to another. 

To learn to work with multiple documents in LisaWrite, 
you use a lease document that is on the stationery pad 
named Chapter 6. To start this activity, get a copy of the 
lease: 

~ Tear off a piece of paper 
from the Chapter 6 
stat ionery pad. 

~ Name the document and open it. 

Your screen should look something like Figure 56. 
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OFFICE SUPPLY COMMERCIAL TERM LEASE AGREEMENT 

OFFICE SUPPLY CORPORATION, SAN LEANDRO, CALIFORNIA 

CUSTOMER INFORMATION 

TERM OF AGREEMENT: _24 MONTH _36 ~10NTH _48 MONTH 

Office Supply Corporation hereby les.ses to trle Customer, and Customer hereby 
lesses from Office Supply Corporation, the Equipment and Furniture described 
below (hereafter called "Hie Equipment") in accordance witrl the terms and 
conditions and prices set forth below s.nd on the reme.ining pages hereof. 

EQUIPMENT 
ORDERED QUANTITY 

Figure 56. Lease Document 

MONTHLY LEASE MONTHLY 
AMOUNTI\.JNIT COST 

This lease has been set up as a "boilerplate" document. 
BOilerplate is text that is used over and over again with 
some changes. In this case, the bulk of the lease is the 
same for every customer. Some variable information 
needs to be inserted. 

Imagine that you work at Office Supply Company. You are 
in the business of selling and leaSing office supplies and 
furniture. You use this lease as the basic contract 
whenever you lease office furniture. To customize this 
lease for each customer you need to add: 

• Customer name and address. 
• Customer number. 
• Terms of Agreement. 
• Each item being leased, including the description, 

quantity, monthly cost per unit, and total monthly cost. 

In this example, you want to customize the lease for Mr. 
John Smith at Alphabet Electronics. He wants to lease 
the following furniture: 

1. One couch, item number 1654A. 

2. Three desks, item number 49876B. 

3. Three chairs, item 1954J. 

Some of the information to be inserted in the lease is 
stored in other documents on your ProFile, on a 
stationery pad named Customers and some is on a 
LisaCalc stationery pad named Furniture. You'll find both 
stationery pads in the LisaWrite Examples folder. 



Next you will open a copy of the Customers document 
and view its contents with the lease still on the screen. 
First, resize the lease document so you can see the 
stationery pads. 

~ Place the pOinter in the J 
size control box in the 

lower right corner of the . r"\ ~I 
lease document. ..., _~ 

~ Press the mouse button 
and pull the bottom of 
the window up until you 
can see the lower half of 
the desktop. 

@I 
L2J 

Chapter 3 

Figure 57 shows how your screen should look. 

OFFICE SUPPLY COMMERCIAL TERM LEASE 

OFFICE SUPPLY CORPORATION, SAN LEANDRO, CALIFORNIA 

CUSTOMER INFORMATION 

TERM OF AGREEMENT: _24 ~10NTH _36 MONTH _48 MONTH 

~ rJ 
Customers lPU-Ch6 CMpter 4 Chapter 2 Chapter 3 

mJ ~ 
furmture lp'j-tutonal Chapter 4 

Figure 57. Lease Document Shortened to Upper Half of Screen 
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~ Now tear off a piece of paper from the Customers 
pad, name it, and open it as a new document. 

The new document overlaps the lease document and 
becomes active. To arrange the documents so that you 
can see both of them, 

~ Move the pointer to the III rig MOb'TU • 

title bar of the LC"""''LI=ST=OM'''''''E'"""'"R/c-=O=N=TR.,-l~:I,.--~ T---NO-. -A-10-1---
Customers document. 1st & Fremont, r'1t. View 

~ Press and hold, pulling the document down until the 
title bar sits approximately half way down the screen, 
and you can see the lease document. 

Figure 58 shows how your screen should look. 

Ipu-ch6 
eFICE SUPPLY COMMERCIAL TERM LEASE AGREEMENT 

OFFICE SUPPLY CORPORATION, SAN LEANDRO, CALIFORNIA 

CUSTOMER INFORMATION 

tUSTOMER'S NAME: John Smith ,CUSTOMERICONTRAtT NO., AWl 
BILLING ADDRESS: Alp~labet Electronlcs, 1st & Fremont, ~1t. Vlew 
INSTALLATION ADDRESS: Same 

CUSTOMER' S ~IAME: Ms. Freedman CUSTOMERICO~ITRACT NO. A50 
BILLING ADDRESS: 114569 Francisco, Bellevue 
INSTALLATION ADDRESS: 4967 Tascsdero, British Heightts 

CUSTOMER'S NAME: Betsy Malloy CL6TOMERICONTRACT NO. Bb150 
BILLn-IG ADDRESS: 130 So. Main St., Fremont 
INSTALLATION ADDRESS: Same 

Figure 58. Viewing Two Documents on Screen 

The window containing the document Customers is now 
active on the screen. Notice that this document now 
displays scroll bars and a highlighted title bar, while the 
lease document does not. These tell you which document 
is active. You can use all of LisaWrite's capabilities in this 
document, just as though it were the only one on the 
screen. 

To make changes or scroll in the lease document, 
act ivate it. 

~ Just place the pointer in the lease document and click 
the mouse button. 



Copying between 
Documents 

You see the Customers document deactivate, and the 
lease activate. The title bar highlights, and scroll bars 
appear in the upper document. 

With two or more documents in view at the same time, 
you can easily copy and paste between them. 

~ Select the information 
about Mr. John Smith in 
the Customers 
document. 

1llllllpu-custotllers IIIIII 
_L::TOI'EF': IIWE ~:III :r,ltl C 
,ILLIII~ H[[,f=E=:O "';I'!'I';I',et Ele,-tFIU'-: 

II,:THLLf, TiOI, r[(,FE:: : ,,[lIe 

~ Choose Copy from the Edit menu. 

~ Activate the lease document by placing the pointer in 
it and clicking the mouse button. 

~ Place the insertion CUSTOMER n~FORMATION 
point on the line below 
"CUSTOMER 
INFORMATION" in the TER~1 OF AGREEME~H: _24 ~10NTH 
lease document. 

~ Choose Paste from the Edit menu. 

Figure 59 shows the resulting screen. 

El 

10 

OFFICE SUPPLY CORPORATION,. SAN LEANDRO, CALIFORNIA 

I 
CUSTOMER INFORMATION 

CUSTOMER'S NAME: John Smith CUSTOMERICONTRACT NO, A101 
BILLING ADDRESS: Alphabet Electronics, 1st & Fremont, Mt, View 
IINSTALLATION ADDRESS: Seme 

BILLING ADDRESS: Alphabet Electronics, 1st 8< Fremont, ~1t, View 
INSTALLATION ADDRESS: Seme 

CUSTOMER'S NAME: Ms, Freedman CUSTOMERICONTRACT NO, A50 
BILLnIG ADDRESS: 114569 Francisco, Bellevue 
INSTALLATION ADDRESS: 4967 TasCBder'J, British Heightts 

CUSTOMER'S NAME: Betsy MalloV CUSTOMER/CO~ITRACT NO, Bb150 
BILLING ADDRESS: 130 So, t1ain St" Fremont 
INSTALLATIO~I ADDRESS: Ssme 

Figure 59. Results of Copying from One Document to Another 

Itl!l!11 

I 
~ 

~ 
05] 

You are finished with the document Customers, so set it 
aside. 

~ Activate the Customers document. 
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~ Choose Set Aside from 
the File/Print menu. 

Save & Put Away 
Save & [ont i nue 
Revert to Previ ous Version 

Format for Printer ... 
Print ... 
Monitor the Printer ... 

The document Customers shrinks down into its icon on 
your desktop. 

You can bring whole tables of information from LisaCalc 
into LisaWrite documents. To show you how this works, a 
sample LisaCalc document is stored in the LisaWrite 
Examples folder on a stationery pad called Furniture. 

You do not need to know how to use LisaCalc to 
complete this activity; LisaCalc capabilities are not 
discussed here. However, to learn to use LisaCalc, turn 
to the LisaCalc manual. 

~ Tear off a piece of paper from the Furniture stationery 
pad, name it, and open it. 

This LisaCalc document contains information about the 
furniture Mr. Smith wants to lease. This information was 
entered into a LisaCalc document so that the Lisa could 
be used to perform the necessary calculations. 

You want to select the information shown and copy it. 

~ Place the pointer in the " M Formula: 
~~--~--~----~--~ sq uare contai n i ng the f-:-+----:....;A~-+-_=_-.;;..~_...I! 

word "Couch." 1 

~ <9.·~:~.F:.·::.~.·§:~A·§.·:.·.·f.:.·:.L.·:.·:.·.·:".·:.· .... :: .. :: ... : ...... :: ........... : .. :: ....... ~: ......... :: .. : .... .I.I 
4 Desks 498768 . 3i 
5 ¢..h~Ii.j .. · .. iif54·~· ... · ....... :................. .. ................. _ ....... · ... · .... · .. ~T 

~ f..'9I~I ..................... : ................ ··· ....... · ................................ · .. · .......................................................... : ...... : ............................... '. 
~ Press and hold the mouse button, pulling the pointer 

diagonally across the screen to select all the 
information. 



Figure 60 shows the selected text in the LisaCalc 
document. 

Figure 60. Selected Text in LisaCalc Document 

~ Now choose Copy from the Edit menu. 

A copy of the selected information is placed on the 
Clipboard. 

~ Close the LisaCalc 
document by choosing 
Save & Put Away from 
the File/Print menu. 

Revert to Previous Version 

~ Activate the lease document. 

~ Scroll the document so leases from Office Supply Corporati 

that you can see the 
"EQUIPMENT 
ORDERED" line and 
place the insertion point 
on the line below the 
headings. 

~)elo\'l (flereafter called "Hie Equi pm 
condit ions and prices set forth bel 

EQUIPMENT 
ORDERED 

1. TERM 

Cli ANTI TY 

~ Choose Paste from the Edit menu. 
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That's all there is to it! The figures from the LisaCalc 
document are inserted into the lease document. Each 
column of information is placed at a tab stop in your 
document that corresponds to the spacing from the 
LisaCalc table. The first tab stop is always set at 1 inch. 

~ Now use the LisaWrite ruler to move the tab stops so 
that they align with the columns in the lease. 

Figure 61 shows where you should set the new tab stops 
on the ruler. 

EQU I PI·1EI~T 
ORDERED QUANTITY 

~10NTHL Y LEASE 110NTHL Y 
AMOUNT/UN IT COST 

Couch 16~'4H 1 "'~I (11:1 ""~I I)l:1 

Oe:l ~ 49,:"'68 ~ :'~L:'l:1 166 :1(1 

[Inn:; 1954J -: 39 ,}l.' 11- .':":' 

Tot 31 II 35,:1 :(1 

Figure 61. New Tab Settings for the LisaCalc Data 

There's one final change to make now: there are too 
many spaces between the dollar sign ($) and the amount 
on the total line. To correct the spacing, 

~ Place the insertion point to the left of "358.50" and 
press (Backspace) five times. 

This completes the LisaWrite and LisaCalc example. You 
can also cut and paste text between LisaWrite and 
LisaTerminal documents. For how to do this, see the 
LisaTerminal manual. 

This completes Chapter 6 and the LisaWrite Tutorial. 
Save and put away the document, and you're ready to 
use LisaWrite for your own writing and editing needs. For 
further details about LisaWrite capabilities, see Section 
C, the LisaWrite Reference Guide, in this manual. 



Chapter 
Summary 

Make a stationery pad 

View multiple documents 
at once 

Copy text from one 
document to another 

• Select the document icon 
that you want to become 
stationery. 

• Choose Make Stationery 
Pad from the File/Print 
menu. 

• Open the first document. 

• Use the size control box 
to make the document 
window smaller. 

• Place the pointer in the 
title bar. 

• Move the document 
down the screen until you 
can see the other 
document, folder, or disk 
icon that you want. 

• Open the next document. 

• Use the size control box 
on the second document 
to shrink the window until 
you can see both 
documents. 

• Open and size both 
documents to see them 
both on the screen. 

• Use LisaWrite scroll and 
edit features to select the 
text to be copied and 
copy it onto the 
Clipboard. 

• Place the insertion point 
in the document to 
receive the copy. 

• Choose Paste from the 
Edit menu. 
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Copy text from a 
LisaCalc document into 
a LisaWrite document 

• Open the LisaCalc 
document containing the 
information you want. 

• Select the entries to be 
copied from the LisaCalc 
document. 

• Choose Copy from the 
Edit menu. 

• Place the insertion point 
where you want the text 
inserted in the LisaWrite 
document. 

• Choose Paste from the 
Edit menu. 

• Use the margin/tab ruler 
to set tabs for the text 
inserted from LisaCalc. 
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What's in the 
Lisa Write Reference Guide? 

This LisaWrite Reference Guide contains complete 
information about LisaWrite and is divided into two 
parts. Chapter 1 briefly explains basic LisaWrite 
concepts. Read Chapter 1 for an overview of LisaWrite 
and how to use it. Chapter 2 is divided into categories. 
Within each category are directions for accomplishing 
specific tasks and some examples. Use Chapter 2 as a 
reference guide when you want a reminder about a 
specific task or when you want more information about a 
particular subject. 

You can look for specific topics in the Index, in the table 
of contents of this Reference Guide, or at the beginning 
of each category of Chapter 2 of this Reference Guide. 

The information in the LisaWrite Reference Guide is 
based on the assumption that you have completed 
LisaGuide, for an introduction to your Lisa, and Section 
A, Getting Started with LisaWrite, for a brief introduction 
to the basic skills needed to use LisaWrite. For more self­
paced instructions on LisaWrite, you can use the 
LisaWrite Tutorial, Section B. 
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What's in 
Chapter 1? 

The LisaWrite 
Screen 

Title bar 

Menu item 

Window 

Scroll bars 

Overview 

Chapter 1 covers the basic concepts and terminology in 
LisaWrite. It introduces you to the LisaWrite screen, 
selecting, scrolling, entering text, changing and 
formatting text, and the LisaWrite work flow. 

When you create and edit documents with LisaWrite, the 
desktop of your Lisa looks something like Figure 1. 

stationery. It was started by t 
and then opening the new document. 

Then the text you are reading was typed 
few mistakes, these paragraphs were formatted t 

Figure 1. The LisaWrite Screen 
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Lisa Write 
Concepts 
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The following brief descriptions explain the functions of 
the items you see in Figure 1. You learn to use these 
items throughout the LisaWrite Reference Guide, as well 
as in other sections of this manual. 

Icon 

Menu bar 

Menu title 

Menu item 

Window 

Scroll bar 

Split control 

Graphic symbol 
representing something on 
the Lisa desktop. 

Shows the names of the 
available menus in 
LisaWrite. 

Names a list of menu items. 

An option, command, or 
instruction that affects the 
current selection when you 
choose it. 

Displays the contents of an 
open icon; in this case, the 
text of an open document. 

Contains scroll controls 
that allow you to move the 
document 'N!th!n the 
window to see different 
parts of it. 

Lets you split the window 
view so that you can see 
more than one part of your 
document at a time. 

Figure 1 shows you many of the items that you use when 
working with LisaWrite. However, during some LisaWrite 
activities, the basic screen looks a little different, and you 
see additional items. 

LisaWrite enables you to create anything from a short 
note to a letter, a memo, or a report of many pages. This 
section presents an overview of the basic concepts used 
in LisaWrite. 



Entering and Editing Text 

Entering and editing text determines the content of your 
document. When you enter text, you type it for the first 
time. When you edit text, you add to, rearrange, replace, 
and remove existing text. LisaWrite has some 
capabilities that make these changes quick and easy. For 
how to use LisaWrite's editing capabilities, see the Edit 
procedures in Chapter 2 of this section. 

Word Wrap 

You can type as fast as you want in LisaWrite without 
worrying about the length of the line. As you type, any 
word that exceeds the right margin automatically moves 
down to start a new line at the left margin. This feature is 
called "word wrap." Make use of it. Let LisaWrite wrap 
your text for you, because then 

• You only press the (Return) key when you want to start a 
new paragraph . 

• Text "wrapped" together in one paragraph is treated 
as a unit for many LisaWrite capabilities. For example, 
when you add or remove text from a wrapped 
paragraph, all gaps between the text and the margins 
are automatically readjusted. And if you change 
margins, the text aligns itself between the new ones by 
itself. 

Formatting Text 

Formatting text determines the appearance of your 
document by specifying the styles of text, paragraphs, 
and pages. You can set the formatting styles you want 
before entering text, or you can change them after you've 
entered text. 

Setting Format Styles Before Entering Text 

Before you start typing, you can choose the formatting 
styles you want from the Format ~, Type Style, and Page 
Layout menus. The settings you choose become active at 
the current insertion point, so when you type, your text 
automatically conforms to them. To change formats in 
the middle of a document, place the insertion pOint 
where the new text goes, choose the formats you want, 
and continue typing. 

Chapter 1 ::: I C5 
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112 inch header margin 

Changing Format Styles for Existing Text 

You don't need to think about formatting your text as you 
create your LisaWrite documents. You can type it first, 
and change the formats later. New text automatically 
uses the existing format settings. Change the format and 
style of existing text at any time by selecting the text and 
then choosing the new settings. 

Standard Format Settings 

The stationery pads that come with LisaWrite have some 
standard format settings. Figure 2 shows the standard 
settings active on the LisaWrite Paper stationery pad. 

, Thi sis header text. 
1 inch top margin 

It prints 1/2" frOM the top of the paper on eac page. 

Stanaara Format Settings on L1saWrlte Paper 

This sample dOcument snows you the standard format settings active on LIs Write 
~--~tatlonery. The first llne of text begins printing 1" down the page. This t p margin ~-..... ~ 

1 inc h can be Changed by moving the top margin marKer on the page ruler. 

left Each l1ne of text within a paragraph Is single spaced. spacing between par graphs Is 
margin ~~~b~~rS~:~~~·m:n~~re are different settings to control l1ne and paragraph s acing on 

1 inch 
right 

margin 

r~;te~~:5t ~~: ~~~t cl~~~il~~~1~e!~t~~~9i~,~t~r~o~e~e~t t~~' p~;~i~r~~6tn~e~~0; p~~~g~~;t 
S~~in-g-le-sp-a-c-e-b-e-tw-e-e-n-Iin-e-s-----+---I often. The right margin Is set at 7-112". The type style Is 12 Pitch Mode. There 
----------------+----L re no tabs set. Left and right margins and tabs are set on the Marglnsl ab Ruler. 

Double space between paragraphs "'paragraphs are al1gned left flush. You'l1learn to change them to center, rl ht flUSh, 
or Justified. Use the Format \I menu to select other alignments. 

11 inches 

8-112 inches 

... This Is footer text. It prints starting at 10-1/2" down the page. 

------------------------~----~, 1/2 inch footer margin L..-__ ....L-___________________ ....L. _____ --l 

Figure 2. Standard Format Settings on LisaWrite Paper 
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For how to set and change specific LisaWrite formats, 
see the Format procedures in Chapter 2 of this section. 

Text, Paragraphs, and Pages 

When you create, edit, and format a LisaWrite document, 
its content can be viewed as groupings of text, 
paragraphs, and pages. 

• "Text" is a grouping of one or more characters, 
including letters, numbers, symbols, and punctuation, 
and nonprinting characters such as spaces, tabs, and 
paragraph returns. Some LisaWrite functions work 
with any amount of text that you select in a document, 
whether it is part of a word in the middle of a line, a 
sentence in the middle of a paragraph, two 
paragraphs, or the entire document. Functions that 
can work with any amount of text include editing 
capabilities, such as cutting, copying, and replacing 
text; searching for text; and choosing the size and style 
in which the text is displayed and printed. 

• A "paragraph" is a grouping of text that ends with a 
paragraph return character, whether it is one word, a 
I ine of text, or many lines of text. A paragraph return 
character by itself is also a "paragraph." (A 
"paragraph return character" is the result of pressing 
the (Return) key.) Some of the formatting styles 
available in LisaWrite work on a paragraph-by­
paragraph basis. For instance, each paragraph of text 
has style attributes such as margins, tab stops, line 
spacing, and spacing between paragraphs. These 
attributes determine the appearance of the text; they 
may be the same for all paragraphs in a document, or 
they may differ, as you like. If you merge two separate 
paragraphs with different style attributes by removing 
the return character between them, the attributes of 
the lower paragraph remain. 

• A "page" is all the text that will print together on one 
piece of paper. LisaWrite has special formatting 
features for pages, too. Page length, page numbers, 
top and bottom margins, and headers and footers are 
style attributes associated with pages. 
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Ruler scale 

Tab alignments 

Tab patterns 

Horizontal ruler 
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The Horizontal Paragraph Ruler 

The horizontal paragraph ruler is used to set left and 
right margins and tabs. It appears when you choose 
Show Margin/Tab Ruler from the Format ~ menu. Figure 
3 shows what the horizontal paragraph ruler looks like. 
All ruler settings work on a paragraph-by-paragraph 
basis. 

Ruler menu 

r' 
L~--+--_--t-t-------"i' 

Figure 3. LisaWrite Screen with Horizontal Paragraph Ruler 



The following brief descriptions explain the functions of 
the items you see in Figure 3. 

Horizontal ruler Lets you set left and right 
marg ins and tab stops. 

Margin markers Show where the left, right, 
and first-line margins are 
set. You adjust the margins 
by moving these markers. 

Tab marker 

Tab stop 

Ruler menu 

Tab alignments 

Tab patterns 

Ruler scale 

Lets you indicate where on 
the ruler you want to set a 
tab. 

Shows where text will be 
positioned when you press 
the(~) key. 

Lets you choose the kind of 
tab stop you want to set 
and any fill pattern to be 
used. Also lets you clear 
tab stops and change the 
scale shown on the ruler. 

Specifies how tabbed text 
will line up at the tab stop. 

Inserts special characters 
between text and the next 
tab stop. 

Lets you choose the type of 
measurement that displays 
on the horizontal ruler. 
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Vertical page ruler 
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The Vertical Page Ruler 

You use the vertical page ruler to preview page breaks, 
set top and bottom margins, and insert header and 
footer text. You bring it to the screen by choosing Show 
Page Ruler from the Page Layout menu. If you want to 
see the top and bottom margins and their contents 
without the vertical page ruler, you choose Preview 
Pages from the Page Layout menu. 

When you use the vertical page ruler, the basic LisaWrite 
screen changes to look something like Figure 4. This 
figure shows only the top half of the page ruler. 

Document Header 
Page 1 

Header marker 

This document was created using Lise.Wri te and a blank piece 
stationery. It was sterted 1Jy. tearing off a piece of Lise.Write 
and then openi ng t he new document. 

Then the text you are reading was typed in. After 
few mistakes, these paragraphs were formatted to make 

Here is a sample of tabbed text: 

12345 

1

56758 
12.56 

45689.05 

x 

Top margin marker 

Figure 4. LisaWrite Screen with Vertical Page Ruler 



The following brief descriptions explain the functions of 
the items you see in Figure 4. 

Vertical page ruler Lets you set top and 
bottom margins and 
position header and footer 
text within the margins. 

Top margin marker Shows where the top 
margin is set. A similar 
marker marks the bottom 
margin. You adjust the 
margins by moving these 
markers. 

Header marker 

Header text 

Top margin 

Page Ruler menu 

Shows where any header 
text will print. A similar 
marker marks footer text in 
the bottom margin. You can 
adjust the positioning of 
header and footer text by 
moving the markers. 

Text that will print at the 
top of each page. 

Lines that are left blank at 
the top of each piece of 
paper when you print this 
document. 

Lets you change the 
incremental scale shown 
on the ruler. 
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Pointers 

As you move the mouse, the pOinter moves around the 
screen. Depending on what you're doing, the pointer can 
have any of the following shapes. 

x 

Selecting 

The text pointer is used to 
mark where you want to 
enter text. 

The arrow pOinter is used 
for view controls, menu 
items, and ruler markers. 

The check pointer is used 
to make choices within a 
dialog box or the 
Preferences window. 

The hourglass appears 
when you need to wait while 
the Lisa finishes what it is 
doing. 

You indicate text that you want to change or alter in 
some way by "selecting" it on the screen. This is an 
important concept: you must a/ways select text before 
you can edit or format it. 

Table 1 explains how to select a point of insertion, one or 
more characters, a word, a paragraph, or a text passage 
of any length. Selected text is highlighted on the screen; 
however, highlighting doesn't print. 

When you click the mouse button to select a point of 
insertion, a vertical bar blinks to show where the next 
typed character will appear. This vertical bar is called 
the "insertion point." The text pOinter temporarily 
disappears. (It reappears when you move the mouse.) 
Any previously selected text is deselected. 

If you try to select a point at the bottom of a document or 
in a blank area and can't, there is no text there to be 
selected. You can place the insertion point after the last 
text and press (Return) to move it down the screen, or you 
can press (Tab) or the spacebar to move to the right 
across a blank line. 



After selecting text, you can type new text to replace the 
selection or you can choose a menu item to edit or 
format it. For example, to replace a misspelled word, 
select the word and type it correctly. 

Pulling through text to select it can sometimes cause the 
document to scroll in the window. See the section on 
Scrolling in this chapter for how to scroll the text through 
the window. 

Table 1. Selecting in LisaWrite 

To Select 

Insertion point 

One or more characters 

One word 

A paragraph 

Several words or 
paragraphs 

Select everything 

Do the Following 

• Move the pointer to the 
desired location and click 
the mouse button. 

• Move the pointer to the 
left of the first character. 

• Press and hold the 
mouse button. 

• Pull through to the last 
character and release the 
mouse button. 

• Move the pointer to the 
word and click the mouse 
button twice. 

• Place the pointer in the 
desired paragraph and 
click the mouse button 
three times. 

• Same as for one word or 
paragraph, but after last 
click, hold the mouse 
button down, pull 
through the last word, 
and release. 

• Choose Select All of 
Document from the Edit 
menu. 
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Table 1. Selecting in LisaWrite, continued 

To Select 

Deselect; select nothing 
in the document 

Extend the existing 
selection 

Scrolling 

Do the Following 

• Click the mouse button in 
a blank area of the 
document. 

• Move the pOinter to the 
end of the text you want 
included in the selection. 

• Press and hold the (Shift) 
key and click the mouse 
button. 

Your document can be both longer and wider than the 
window that displays on your Lisa. Most of the time you'll 
want to keep the window wide enough so that you can 
see both ends of a line. The window of the active 
document has view controls that you may use to bring 
hidden portions of the document into view and to see 
more than one area of the document at a time. Figure 5 
shows these controls. Some of them are duplicated 
because the window has been split into two views. 



Scroll bar 

Scroll arrow 

Split control 

Scroll arrow 

Elevator 

SCROLLING 

There are two scroll bars on the window of your 8.ctive LisaWri te 
document: one at the right hand edge of the window, and the other 
along the bottom edge of the window. The scroll bars contain view 
controls. Use them to see other parts of of your document. The 
view controls include: 

The Scroll ArrIMS, at the ends of each 
scroll bar. These move the text of your 
document line by line and column by column 
through the window. 

The Elevator in the vertical scroll bar. 

Split control 
View button 

::t~~::~~~~~H:t :::' ::~:::;: of l ~c 
the window into multiPl~ views, so that f1t 

, ;u, '"~. ,., v 

~~--------------------J"~~ ________________________ T-____________________ I--I 

Split control I 
Scroll bar Elevator 

Figure 5. Window with View Controls 

The following brief descriptions explain the functions of 
the items you see in Figure 5. 

Scroll bars Contain controls that let 
you change the view of the 
document. 

Scroll arrows 

Elevators 

View buttons 

Split control 

Enable you to bring hidden 
portions of a document into 
view, either vertically, line­
by-line, or horizontally, 
column-by-column. 

Indicate where the current 
window's view is in relation 
to the rest of the document. 
Enable you to move quickly 
to the top or bottom of the 
document. 

Scroll the document one 
full view at a time. 

Splits the window into two 
or more views so that you 
can see different parts of 
the document at the same 
time. 
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Table 2 shows the different ways to scroll in LisaWrite. 

Table 2. Scrolling in LisaWrite 

To Scroll 

Line by line 

Column by column 

Continuous lines or 
horizontal increments 

V!ew-s!zed !nCrements 

Continuous view-sized 
increments 

Large jumps 

Do the Following 

• Move the pointer over 
one of the vertical scroll 
arrows and click the 
mouse button. 

• Move the pointer over 
one of the horizontal 
scroll arrows and click 
the mouse button. 

• With the pointer on the 
scroll arrow, press and 
hold the mouse button. 
Release it when the 
document is positioned 
where you want it. 

_ f\AI"\\Io tho nl"\intol' tl"\ tho - ... _. - ... - ..... -.... _ .. - ... -
view button and click the 
mouse button. 

• With the pointer on the 
view button, press and 
hold the mouse button. 
Release it when the 
document is positioned 
where you want it. 

• With the pointer on the 
elevator, press and hold 
the mouse button, 
moving the elevator up or 
down in the scroll bar. 
Release the mouse 
b~tton when the 
document is positioned 
where you want it. 



Table 2. Scrolling in LisaWrite, continued 

To Scroll 

To the top 

To the bottom 

Split a view vertically 

Split a view horizontally 

Close a split view 

Do the Following 

• With the pointer on the 
elevator, press and hold 
the mouse button, move 
the elevator to the top of 
the scroll bar, then 
release the mouse 
button. 

• With the pointer on the 
elevator, press and hold 
the mouse button, move 
the elevator to the 
bottom of the scroll bar, 
then release the mouse 
button. 

• With the pOinter on the 
split control in the 
vertical scroll bar, press 
the mouse button and 
hold it down, moving the 
mouse toward you at the 
same time. 

• With the pointer on the 
split control in the 
horizontal scroll bar, 
press the mouse button 
and hold it down, moving 
the mouse to your right at 
the same time. 

• With the pointer in the 
split control of the view 
you want to close, press 
and hold the mouse 
button, pulling the edge 
of the split view to the 
upper, lower, left, or right 
edge of the view. 
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About Menus 

Many of the operations that you can perform in LisaWrite 
you do by choosing an item from a menu. The LisaWrite 
menus are listed on the menu bar as shown in Figure 6. A 
description of all LisaWrite menu items can be found in 
this manual in Appendix 1, Menu Items. 

,. File/Print Edit Search Type Style Format 1f Page layout 

fllj 111111ii1i§;;;'iiiitiillllll 

Figure 6. LisaWrite Menu Bar 

To choose a menu item, 

~ Move the pointer to the 
menu bar and position it 
over the name of the 
menu you want. 

~ Press the mouse button 
and hold it down. Notice 
that the menu !s nO\·'! 
showing. 

~ Move the pointer to the 
menu item you want. 

~ Release the mouse button. 

page~DYOut 

Preview Phges 
...fO!!!1't Pre!!! ew P!!ge~ 

Show Page Ruler 

Hide Page Ruler 

Insert Page Number 

Insert Page Mark 

Keep On Same Page 

.../Allow to (ross Pages 

. . - . . 
Preview Pages 

.,.I0on't Previ ew Pages 

. .... .. 

Hide Page Ruler 



Some menu items have an Apple sym bol and a letter 
beside them. This means that you can hold down the @ 
key and the letter to choose a menu item rather than 
choosing the item with the mouse. Refer to Appendix 2, 
Apple Keys, in this manual, for a list of menu items that 
you can choose using the @ key. 

Some menu items are followed by an ellipsis ( ... ). When 
you choose one of these menu items, you must respond 
to a dialog box before the item takes effect. (Dialog 
boxes are explained below.) 

When a menu item is shown in gray instead of black, it 
cannot be chosen at that time. This is usually because it 
does not apply to the current selection. 

Some menu items are 
grouped together and 
represent the available 
choices for a particular 
menu setting. The current 
setting has a check mark 
next to it, while the others 
don't. If you choose another 
setting, the current one 
automatically turns off. 
These menu item choices 
are ones where being able 
to choose more than one at 
a time wouldn't make 
sense. For instance, you 
can't have the same text be 
both Single spaced and 
double spaced at the same 
time. 

Other menu items are 
marked by check marks 
when they are on, but they 
can work with other menu 
items also. For example, on 
the Type Style menu, you 
can use bold and underline 
at the same time. When you 
do, both items will be 
checked on the menu. In 
this case, choosing Plain 
Text turns both Bold and 
Underline off. 

--ILeft Flush 

Center 

Right Flush 

JustiFy 

Show Margin/Tab Ruler 

Hide Margin/Tab Ruler 

Single Space 1r 
--11-1/2 Space 1r 

Doubl e Space 1r 
Trip Ie Space 1r 

CP 
CU 
CB 

Italic .1 
Superscr i pt 
Subscript 
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A few menu items have 
additional menus 
associated with them. 
When you choose these 
items, another menu name 
appears on the menu bar. 
For example, when you 
choose Show Margins 
and Tabs Ruler from the 
Format ~ menu, a new 
menu title, Ruler, appears 
on the menu bar. This new 
menu contains items that 
affect margins and tabs. 

Dialog Boxes 

Inch Sca~ 
Metric Scale 

Clear Tab Stop 
Set Normal Tab 
Set Centered Tab 
Set Right Flush Tab 
Set Decimal Tab 

No Tab F i" Pattern 
.. Tab Fill Pattern 
-- Tab Fill Pattern 

Tab Fi II Pattern 

A dialog box is a box that appears on the screen in 
response to certain menu items. Two types of dialog 
boxes appear when using LisaWrite. One allows you to 
accept or change various options that apply to the 
command, and the other lets you fill in additional 
information. Figure 7 shows you the first type as it 
appears when you choose Print from the File/Print menu. 

r".i'§jUI Edit Search Type Style Format 1f Page Layout 

Print... • Finished Quality D Quick Draft (Text Only) 

• One Copy V!11ile V OIJ \\'a.it D \yhile Vou V,'ork 

• All Pagel DOnI\/ , __ .,_ .. , ......................... . 

t~umber of Copies: D00lIJ[I][IJ0[IJ0§J 

Figure 7. LisaWrite Dialog Box 

To respond to this type of dialog box, 

~ For each option that you wish to change, check the 
box next to the option you want by moving the pointer 
to the box and clicking the mouse button. 

~ When the dialog box reflects the options you want, 
click OK. 

~ If you change your mind and decide not to perform 
the operation called for by the menu item, click 
Cancel. 



The second type of dialog box is shown in Figure 8. This 
dialog box appears when you choose Find What? from 
the Search menu. 

r.- File/Print Edit Search Type Style Format,r Page Layout 
Finr] In 
CI·l~;nge t I) ( ) 

Figure 8. Another Type of Dialog Box 

To respond to this dialog box, 

~ Type the text you want to find in the brackets in the 
dialog box. 

~ Press (Enter) to place the insertion point next to 
Change To. 

~ When the brackets contain the information you want 
to use, choose another item from the Search menu. 

Notice that this second dialog box has scroll bars on the 
right and a size control in the lower right-hand corner. 
Use them to control the dialog box just as you would the 
window of your document. 

For how to find and change text, see the Search 
procedures in Chapter 2 of this section. 

Alert Boxes 

An alert box is a box in which a message from the system 
is displayed. The message can be Wait, Note, Caution, 
Stop, or ?, as described below. You can respond to these 
messages by clicking the OK or Cancel button. To do 
this, move the pointer to the OK or Cancel button and 
click the mouse button. 

Wait Message 

The Wait message tells you that the Lisa is carrying out 
an operation that may take some time. You don't need to 
respond to a message of this type. However, some Wait 
messages give you the option of being able to terminate 
the operation by holding down the (t) key while typing a 
period. Figure 9 is an example of a Wait message. 
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lisaDesk is placing a dupl icate of "lpu-ch5" on 
"Ipu-tutorial" . 

To ~rminate the operation, hold down the Apple key 
while you type a period. 

Figure 9. A Wait Message 

Note Message 

The Note message tells you that something might need 
your attention. Most likely, everything is all right, but the 
Lisa wants to tell you about something just in case. To 
dismiss the alert box with a Note message, you just click 
OK. Figure 10 is an example of a Note message. 

lisa will not be able to print on that printer 
until after you have turned Lisa off, plugged 
in .. hID n.·int-At" nnrl h.t"na.rI I i("n hnrlt nn nnni ... ... ... - ........ -. , _ .. - ._ ... _- _ .. - ~-- .. _ .. -"'_.... uK 

Figure 10. A Note Message 

Caution Message 

The Caution message tells you that you are about to do 
something risky that cannot be undone or that may take 
a long time. To dismiss the alert box with a Caution 
message, you click OK or Cancel. Figure 11 is an 
example of Caution message. 

00 you really want the active document to 
revert to the version saved 11 minutes ago? 

If yku want to leave the document as it 
is now, click [ancel. 

Once you click OK, you will not be able 
to change your mind, even with Undo. 

Figure 11. A Caution Message 

[ancel 

OK 



Stop Message 

The Stop message tells you that something you 
requested cannot be done and why. To dismiss the alert 
box with a Stop message, you click OK or Cancel. Figure 
12 is an example of a Stop message . 

• liS'''',it. [annot Undo <av. & (ontinu •. 

[ancel 

Figure 12. A Stop Message 

? Message 

The? message is displayed when you have to choose one 
of a number of alternative actions. Most? messages 
have two or three choices. To dismiss the alert box with a 
? message, you click OK or Cancel. Figure 13 is an 
example of a ? message . 

• 
The upper diskette is not a Lisa Office 
disk. Would you I ike it initial ized? 

WARNING: Initializing a disk erases its 
contents. 

Once you click Initialize, you will not be 
able to change your mind, even with 
Undo. 

Figure 13. A ? Message 

Cancel 

Initialize 
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The following material outlines how to start a new 
LisaWrite document and how to work with an existing 
LisaWrite document. For specific information and step­
by-step directions, refer to Chapter 2 of this Reference 
Guide and to Section D, Desktop Manager Reference 
Guide, in the Lisa Owner's Guide. 

Starting a New Document 

To start a new LisaWrite document, 

~ Open the ProFile 
window. 

~ Tear off a sheet of paper 
from the LisaWrite 
stationery pad. 

~ Type the new 
document's name. 

I 

I 
Lette~ L~ 

LlsaWnte Paper 

~ Open the new document's window. 

~ Type and edit the document to change its content. 

~ Format characters, paragraphs, and pages of the 
document to achieve the desired appearance. 

~ Save all changes about 
every 15 minutes and 
continue working. 

Set Aside Everything 
Set As i de "Letter" 

Save [, Put Away 



~ Print the document, if you like. 

~ Put away the completed 
document. 

To organize your documents into a folder and to keep the 
disk window uncluttered, you might want to 

~ Move the saved 
document into a folder 
of related documents, or 
tear a folder from the 
folder pad, name the 
folder, and move the 
document into it. 

TIj!!J~ 

Working with an Existing Document 

To work with a filed LisaWrite document, 

~ Open the ProFile window. 

~ If the document is in a folder, open the folder that 
contains the document you want to work with. 

~ Open the document. 

~ Edit and format the document, saving it every 15 
minutes. 

~ Print the document, if you like. 

~ Put away the document in its original location. 
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What's in 
Chapter2? 

Procedures 

Chapter 2 contains procedures for using all LisaWrite 
capabilities. To make the procedures easier to find, they 
have been divided into categories according to 
functions. The categories are: 

Edit 

Look here for operations that change the contents of 
your document. 

C32 Copy Text 
C34 Cut Text 
C36 Insert Text 
C38 Move Text 
C41 Replace Text 
C42 Revert to Previous Version 
C44 Undo Last Change 

Format 

Look here for operations that change the appearance of 
text in your document. 

C48 Copy Paragraph Style 
C51 Format Stationery Pad 
C53 Headers and Footers 
C57 Horizontal Margins 
C61 Keep Lines of Text on Same Page 
C64 Line Spacing 
C67 Page Breaks 
C69 Page Numbers 
C73 Paragraph Alignment 
C75 Paragraph Spacing 
C80 Tab Alignment 
CB5 Tab Clearing 
C89 Tab Patterns 
C91 Tab Stops 
C99 Top and Bottom Margins 
C 1 03 Type Styles 
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Print 

Look here for instructions on how to print a document. 

C 11 0 Format for Specific Printers 
C116 Preview a Document 
C118 Print a Document 

Search 

Look here for instructions on how to find and change 
specific text. 

C124 Find Text 
C127 Find and Change Text 

Other Tools 

Look here for instructions on how to use information 
from LisaCalc documents with LisaWrite. 

C 132 LisaCalc 



C32 Copy Text 
C34 Cut Text 
C36 Insert Text 
C38 Move Text 
C41 Replace Text 
C42 Revert to Previous Version 
C44 Undo Last Change 

Edit 
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To copy text 

~ Select the text you want to copy. 

~ Choose Copy from the 
Edit menu. 

~ Select the new location for the text, or select the text 
to be replaced by the copy. 

~ Choose Paste from the 
Edit menu. 

Select All of Document aA 

To copy text from one document to another 

~ Select the text you want to copy. 

~ Choose Copy from the Edit menu. 

~ Get or activate the other document. 

~ Select the new location for the text, or select the text 
to be replaced by the copy. 

~ Choose Paste from the Edit menu. 



You may copy text from one location to another within a 
document or from one document to another. When you 
choose Copy from the Edit menu, a duplicate of the 
selected text is automatically placed on the Clipboard. 
Then, when you choose Paste, a duplicate of the text on 
the Clipboard is placed in the document at the insertion 
point. If you selected text before you chose Paste, it is 
replaced by the contents of the Clipboard. 

Text remains on the Clipboard until you cut or copy other 
text, so you can make as many duplicate copies as you 
want. You can also perform other LisaWrite functions 
that do not affect the Clipboard between the copy and 
paste steps. The Clipboard acts as a temporary storage 
area in this way, whether or not its window is open. 

When you copy one or more entire paragraphs, all 
paragraph format styles are also copied. A selection 
includes a whole paragraph, and therefore the paragraph 
styles, when you triple click to select it, or when you click 
the mouse button and then drag the pOinter through a 
return character at the end of a paragraph. When you 
copy less than a paragraph, format styles are not copied. 
The text will adopt the format styles active at the location 
where you paste it. 

When you copy text within a long document, you can 
simplify the operation by splitting the window into two 
views. Scroll the text you want to copy into one view and 
scroll the area where you will paste the duplicate into the 
other view. Then follow the steps above. 

You can copy cells from a LisaCalc spreadsheet into a 
LisaWrite document. See the Other Tools in this chapter. 
To copy the format style of one paragraph to another, see 
the Copy Paragraph Style procedure, under Format, in 
this chapter. 

Edit 

Copy Text 
(continued) 
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To cut text 

~ Select the text you want to delete. 

~ Choose Cut from the 
Edit menu. 

Select All of Document etA 

To delete selected text with (Backspace) 

~ Select the text you want to delete. 

~ Press the (Backspace) key once. 

Cutting text removes it from your document and places it 
temporarily on the Clipboard. If you change your mind 
about removing it, you can restore the text by pasting the 
text on the Clipboard back into your document or by 
choosing Undo Last Change. You can also cut text and 
then paste it back into the same document or into 
another one. For more information on cutting and 
pasting, see the Move Text procedure, under Edit, in this 
chapter. 

Text you cut remains on the Clipboard until you cut or 
copy other text. The Clipboard acts as a temporary 
storage area in this way, whether or not its window is 
open. 



Pressing the (Backspace) key when text is selected also 
removes the selected text from your document. However, 
text that you remove with the (Backspace) key is not 
placed on the Clipboard. You can restore it immediately 
by choosing Undo Last Change from the Edit menu, but 
you may not paste it back into the same or into a different 
location. Use (Backspace) to remove text when you don't 
want to replace the contents of the Clipboard. 

When the selection is an insertion point, (Backspace) can 
also be used to delete characters to the left of the 
insertion point. 

When you delete the return character separating two 
paragraphs with cut or (Backspace), the upper paragraph 
becomes part of the lower paragraph. If the two 
paragraphs have different format styles when you delete 
the return character, the formats of the lower paragraph 
are retained. 

To delete an extra return character from a document, 
select it as a paragraph by triple clicking and choosing 
Cut from the Edit menu, or backspace over it. Too much 
space between lines or paragraphs of text in your 
document may not be caused by extra return characters, 
however. You may simply need to change the paragraph 
or line spacing. For how to change these settings, see the 
Paragraph Spacing and Line SpaCing procedures, under 
Format, in this chapter. 

Edit 

Cut Text 
(continued) 
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To insert text 

~ Select the location where you want to insert text. 

~ Type the text you want to add. 

You may insert any amount of text in a document at any 
time, from a single character to several pages of text. 
Simply select the spot where you want to insert text and 
begin typing. The insertion point always shows where the 
next typed character will go. As you type, the insertion 
point moves to the right. The new text uses the format 
styles active where you place the insertion point. 

As you type new text into your LisaWrite documents, 
remember not to press (Return) at the end of each line 
unless it is the end of a paragraph. When you type a word 
that extends past the right margin, LisaWrite 
automatically moves it to the left margin of the next line. 
This feature, called word wrap, can increase your typing 
speed and can help you make the best use of LisaWrite's 
formatting capabilities. See Word Wrap, Formatting 
Text, and Text, Paragraphs, and Pages in Chapter 1 of 
this section for more information. 

To insert the text present on the Clipboard into a 
document, select the location for the insertion and 
choose Paste from the Edit menu. 



Example 
1. Suppose you want to 

insert a paragraph 
between two others. You 
place the pointer at the 
beginning of the second 
paragraph, as shown, 
and press the mouse 
button once to place an 
insertion point there. 

To insert any amount of text, 
place the insertion point where you 
want it end start typing. It is that 
simple. 

IWhenever you insert text the 
new tex t conforms to the style 
characteristics active where you 
placed the insertion point. 

2. The point of insertion is marked by a blinking bar that 
shows where any inserted text will go. 

3. After you type the new To insert any amount of text, 
~ place the insertion point where you 

text and press the~ want it and start t~lping. It is that 
key to end it as a simple. 
paragraph, your 
document looks like this. For example, I selected a spot 

to the left of the first fy'yford in the 
second paragraph, typed this ney'! 
paragraph, and ended it by pressing 
RETURN. 

Whenever you insert tex t the 
nevY' text conforms to the style 
characteristics active where you 
placed the insertion point. 

4. Notice that the paragraph style of your new text is the 
same as for the previously existing text. 

Edit 

Insert Text 
(continued) 
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To move text 

~ Select the text you want to move. 

~ Choose Cut from the 
Edit menu. 

~ Select the point of insertion or the text to be replaced. 

~ Choose Paste from the 
Edit menu. 

To move text from one document to another 

~ Select the text you want to move. 

~ Choose Cut from the Edit menu. 

~ Get or activate the document you want to place the 
text in. 

~ Select the point of insertion or the text to be replaced. 

~ Choose Paste from the Edit menu. 



You may move text from one spot to another within a 
document or from one document to another. You can 
also move text from LisaCalc into a LisaWrite document. 
To find out how, see the LisaCalc procedure, under Other 
Tools, in this chapter. 

When you move text within a long document, you can 
simplify the operation by splitting the window into two 
views. First, scroll the text you want to move into one 
view, then select an insertion point in the other view, and 
scroll to the area where you want to paste the duplicate. 
Then follow the steps above. 

When you move text that includes paragraph return 
characters, the format styles of that paragraph are 
moved with the text. If you move text that doesn't include 
a return character, it will adopt the format styles active at 
the location where you paste it. Selected text includes 
paragraph return characters when you triple click to 
select a paragraph, and when you click and drag the 
painter through a return character. 

Example 

1. Suppose you have renumbered several paragraphs 
and you want to arrange them on the page 
sequentially. You select paragraph number 1. 

2. You may move text from LisaCalc tables into a LisaWrite document. 

Edit 

Move Text 
(continued) 
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Move Text 
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2. When you choose Cut 
from the Edit menu, the 
paragraph is removed 
from the document and 
placed on the Clipboard. 

Se I ect A II of Document itA 

3. You select the point of insertion where you want the 
text to go, before the number 2. 
I,nsertlon pOint 

12. You may move text from LiseCalc tables into e. LisaWri te docllllent. 

3. Moved text retains its own style. 

4. You choose Paste from 
the Edit menu. 

5. Paragraph number 1 is placed in the document before 
paragraph number 2. 

11. You may move text from one spot to another within a document 
from one document to another. 

2. You may move text from Lise.celc te.bles into e. Lisa~~rite document. 

3. Moved text retains its ovm style. 



To replace existing text 

~ Select the text you want to replace. 

~ Type the new text, or choose Paste from the Ed it 
menu. 

You may replace any existing text in a document with new 
text or with a duplicate of text on the Clipboard. For 
example, to replace a misspelled word either select the 
word and type it correctly or, if the correctly spelled word 
is on the Clipboard, select the misspelled word and 
choose Paste from the Edit menu. 

When text is selected, any characters you type from the 
keyboard replace it. This includes pressing (Return), (Tab), 
(Backspace), or the spacebar. 

Edit 

Replace Text 
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To undo all changes made to a document since it was last 
saved 

~ Choose Revert to 
Previous Version from 
the File/Print menu. 

Set Aside Everything 
Set Aside "Move" 

Save & Put Away 
Save & Continue 

_ •. - •• -. Ill • 

.................................................................................................................... 

Format For Printer ... 
n .... i_1-I r ........ . 

Monitor the Printer ... 

~ Click OK in the alert box that appears. 

I 



Revert to Previous Version can undo all changes in your 
document since the last time you chose Save & Continue, 
Save & Put Away, or Revert to Previous Version. 

When you choose Revert to Previous Version, LisaWrite 
always displays this alert box: 

Do you really want the active document to 
revert to the version saved 11 minutes ago? 

If yku want to leave the document as it 
is now, click [ancel. 

Once you cl ick OK, you wi II not be able 
to change your mind, even with Undo. 

( [ancel 

OK 

Since you must click OK before LisaWrite undoes your 
changes, you can't lose your work accidentally by 
choosing this menu item. 

Edit 

Revert to 
Previous Version 
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To undo the last change you made in your document 

~ Choose Undo Last 
Change from the Edit 
menu. 

Cut 
Copy 
Paste 

etx 
etc 
etv 

Select All of Document etA 

You can undo many of the actions you take in LisaWrite 
immediately after you do them by choosing Undo Last 
Change, or you can undo all changes since the last time 
you saved your document by reverting to the last version. 
For how to undo all changes made to a document, see 
the Revert to Previous Version procedure, under Edit, in 
this chapter. 

When you choose Undo Last Change and LisaWrite 
cannot undo your last step, an alert box appears, 
explaining what cannot be undone. 

[ [once I 



Here are just a few of the steps and commands in 
LisaWrite that you can undo: 

• Cutting text. 
• Pasting text. 
• Changing type styles and fonts. 
• Aligning paragraphs. 
• Typing text since you last selected an insertion point. 

Most of the steps that you cannot undo change the way 
the screen displays, but not the content of your 
document. For example, you cannot undo: 

• Scrolling. 
• Splitting the screen. 
• Choosing Show Margin/Tab Ruler or Show Page Ruler. 
• Choosing Hide Margin/Tab Ruler or Hide Page Ruler. 
• Choosing Find What? from the Search menu. 

Edit 

Undo Last 
Change 
(continued) 
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C48 Copy Paragraph Style 
C51 Format Stationery Pad 
C53 Headers and Footers 
C57 Horizontal Margins 
C61 Keep Lines of Text on Same Page 
C64 Line Spacing 
C67 Page Breaks 
C69 Page Numbers 
C73 Paragraph Alignment 
C75 Paragraph Spacing 
C80 Tab Alignment 
C85 Tab Clearing 
C89 Tab Patterns 
C91 Tab Stops 
C99 Top and Bottom Margins 
C 1 03 Type Styles 
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To copy the style of one paragraph onto another 

~ Select the paragraph with the style you want to 
duplicate. 

~ Choose Copy from the 
Edit menu. 

)eied Ri i of uocument 'R 

~ Select the paragraph(s) you want to be styled like the 
one now on the Clipboard. 

~ Choose Same as on 
Clipboard from the 
Format ~ menu. Center 

Right Flush 
Justify 



Each paragraph has a number of style characteristics 
associated with it: margin and tab settings, line and 
paragraph spacing, and paragraph alignment. You may 
copy the style characteristics of any paragraph onto 
other paragraphs in the same document or to 
paragraphs in another LisaWrite document. When you 
copy the style, all paragraph style attributes are copied. 

When you copy the style to paragraphs in another 
LisaWrite document, complete the first two steps above, 
then get or activate the other document and complete 
the last two steps. 

If you have more than one paragraph on the Clipboard 
because you cut or copied a large amount of text, the 
style of the top paragraph on the Clipboard will be copied 
when you choose Same as on Clipboard. 

Example 

Suppose you want to copy the style of one paragraph to 
several other paragraphs in the same document. 

1. You select the paragraph whose format styles you 
want to copy and choose Copy from the Edit menu. A 
copy of the text and its format styles are placed on the 
Clipboard. 

~~~"""!"'.!!i"""""'~~:.~~ like the duplicate on the 
d from the Format ! P menu. 

Format 

Copy 
Paragraph Style 
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2. You scroll to and select the first paragraph(s) to be 
styled like the one now on the Clipboard. If the 
paragraphs are contiguous, like the ones in this 
example, you can select them at the same time. 

1. Open 1:1. document and scroll into view both the paragraph 
whose style you want to copy and the ones to be styled 
like the duplicate . 

.2 = ~ : to ': r j.. f" -:- t::- r ~ ~:r ~ ~:'I' I I" ': : 0:- :... 1 ee' J I :- ,'" i ':1 : (I t: :-1" :1 

C \'1 :1 c : e '::1 t= I ; r :'1 P f-:- :: ~:." .. t: ", .' 

3 = 0: 10:- : - ;- I t:' f. :C .. " :- ,': :' v \ : -:1 t. ~ : ~ : -::. : ... ~ -: +- :- ,,: .... : :.. : :- 1-.:: : l I- t -: 

:::r"t:::-:-'j :O-I"j :1":::'::- ::-lle:-- :"1 :::r"I-:,:-.:-- ;:":i "'1"1-:- F:~--'3'" I: -'I~" 

g. You choese Same as en 
Clipboard from the 
Format ~ menu. Center 

Right Flush 
Justify 

4. The selected paragraphs take on the new style 
immediately. 

1. Open 8. document B.nd scroll into view both the paragraph 
whose style you want to COp'y and the ones to be styled 
like the duplicate. 

5. Continue this process for any other paragraphs. 



To format a stationery pad with the settings you want 

~ Tear off a piece of paper from an existing stationery 
pad. 

~ Open the new document. 

~ Choose Select All of Document from the Edit menu. 

~ Set all formats as you want them on the new 
stationery pad. 

~ Enter any text you want on the new stationery pad. 

~ Choose Save & Put Away from the File/Print menu. 

~ Choose Make Stationery 
Pad from the File/Print 
menu. 

Set Aside Everything 
Set Aside "Profi Ie" 

S~:ni~,:,' f, Fui:. 
Open "letter" 
Oupl icate .W 
Tenr Ofr Hn!:\OlH:,:rH 

Monitor the Printer ... 

Format 

Format 
Stationery Pad 
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You can turn any document into a stationery pad. You'll 
find this feature especially useful when you have 
standard forms and documents that you reuse often. 

Creating stationery with the formats you use frequently 
will save you time, because you won't have to set the 
formats for each document. 

The formats stored with LisaWrite stationery are listed 
below. You may want to check all of them and change the 
ones you don't like when personalizing your own 
stationery. 
"T'"L_ z, __ ..-. __ A. _ _ ... _ .... _-1 __ I ! __ \AI ..... :A. _ _ .1._ ... : ___ ........ _ .... _ .. 

III~ IVIIIIOl;:) ;:)lVI~U VII L.1;:)OVVlll~ ;:)lOlIVII~ly al~. 

• All horizontal paragraph ruler settings, including first­
line left margin, subsequent-line left margin, right 
margin, and all tab settings. Note that if you want the 
horizontal margins of header and footer text to match 
the main text of the document, you must change them 
separately. 

• All page ruler settings, including top and bottom 
margins, and positioning of header and footer text 
within the margins. 

• Paragraph and line spacing. 
• Paragraph alignment: left, right, centered, or justified. 
• Type style and font. 
• Size of window on the desktop. 
• Format for Printer settings. 

How to set these formats is discussed in individual 
procedures in this chapter. 



To insert a page header or footer 

~ Choose Show Page .:i. u ... mIIlU_ 

Ruler from the Page Preview Pages 

Layout menu. Preview is v'Don't Preview Pages 
turned on, showing top 
and bottom margins, 
headers and footers, and 
page breaks, and a 
vertical ruler appears at 
the right side of your 
document. 

_'~:lili ... 
Hide Page Ruler 

Insert Page Number 
Insert Page Mark 

Keep On Same Page 
v'Aliow to (ross Pages 

~ If you are inserting a header, place the insertion point 
on the line immediately below the header marker in 
the ruler. Most of the time, the insertion point appears 
at the far left margin. 

~ If you are inserting a footer, scroll to the bottom of the 
page and place the insertion point on the line 
immediately below the footer marker in the ruler. 

~ Type the text of your header or footer. 

~ Use any formatting features you want to complete the 
header or footer. 

~ Choose Hide Page Ruler 
or Don't Preview Pages 
from the Page Layout 
menu. 

v'Preview Pages 
Don't Preview Pages 

Show Page Ruler 
.imr..=mi·· . 
.......... " .................................................................. P.t ........ .. 

Insert Page Number 
Insert Page Mark 

..................... " ....... ==c=: 
/' 
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Headers and 
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To move the header and footer text within the top and 
bottom margins 

~ Choose Show Page Ruler. 

~ Scroll the text so that you can see the header or 
footer you want to reposition. 

~ Move the pointer to the header or footer marker; 
press and hold the mouse button, pulling the marker 
to its new position in the ruler. 

~ Move any other markers in the same way. 

You may add repeating text in the form of headers and 
footers to each page of a document. Headers print 
across the top of each page, above the body of the 
document. Footers print across the bottom of each page, 
below the body of the document. As an example, look at 
the footer at the bottom of this page. In this case, the 
footer contains a page number as well as text. For how to 
insert page numbers as part of a header or footer, see 
the Page Numbers procedure, under Format, in this 
chapter. 

You insert only one header or footer per document, and 
you may insert or modify it on any page of the document. 
Once inserted, headers and footers are automatically 
placed on all pages of the document. Like other text, you 
may edit, change the font, type style, paragraph spacing, 
margins, and tab settings in a header or footer. Changing 
the left and right margins or other format settings in the 
text of a document does not automatically change them 
for header and footer text. If you change margins in a 
document and want header and footer text to align with 
them, you must also change the margins in the header 
and footer. 



You may type as many lines of text in a header or footer 
as you wish. However, only the lines that fit between the 
header marker and the top margin marker and the footer 
marker and the bottom edge of the page will appear on 
the screen and print. To display header text hidden below 
the text of the document, move the top margin marker 
down the screen. To display hidden footer text, move the 
footer marker up within the bottom margin. 

Example 

Suppose you want to add a header and footer to the draft 
of a marketing report. You want "Preliminary Draft" to 
appear at the top right margin of each page, and the 
project name and the date to appear at the bottom. 

1. You choose Show Page Ruler from the Page Layout 
menu. The ruler that appears shows current top and 
bottom margins for the body of text and the current 
header and footer positions. However, only the top of 
the ruler is visible. 

2. You place the insertion point on the line following the 
header symbol and type "Preliminary Draft." 

Preliminary Drafti 

Format 

Headers and 
Footers 
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3. Now select the header 
and choose Right Flush 
from the Format ~ menu 
to place it at the right 
margin. 

I ........ · .................................. ·· .............. ·· .... ········· 

Show Margin/Tab Ruler 
Hide Margin/Tab Ruler 

II Tho" \/nll C'"".,."II +h" +""+ ",.: +h" ,...,,""" ........... ,,_+ ......... 1._+:1. __ •• 
-r. 111'-'" IVY "'"'VI ""'II ILllv Lv"''' VI \llv UV\JUIII'Vlll \AtJ UIILII yvu 

can see the end of the page and the bottom of the 
page ruler. 

5. You place the insertion point on the line following the 
footer marker in the ruler and type your footer, "Barley 
Soda Account." Then press (Return) and type today's 
date. 

Barley Soda Account 
April 13, 198~ 

6. When you finish entering the footer text, you choose 
Don't Preview Pages from the Page Layout menu to 
dismiss the ruler and its menu. 



To set horizontal margins 

~ Select the text you want to change margins for, or 
place the insertion pOint where you want the new 
margins to take effect. 

~ Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. 

~ If you want to change the 
scale shown on the ruler, 
choose Inch Scale or 
Metric Scale from the 
Ruler menu. 

Inch Scale 

~ Set paragraph margins: move the Lt., Lt., and &. 
markers in the ruler to the correct positions. 

~ Choose Hide Margin/ 
Tab Ruler from the 
Format ~ menu. 

[enter 
Right Flush 
JustiFy 

CL 

Show Margin/Tab Ruler 

Format 

Horizontal 
Margins 
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Each paragraph has three margins: a first-line left 
margin, a subsequent left margin, and a right margin. 
The samples below demonstrate the versatility of three 
margins; each sample is the same paragraph with only 
the first-line margin changed. 

Text that ends with a paragraph RETURN is a paragraph that can have its own 

spacing, tabs, and margins. This paragraph uses the same left and right 

margins in all examples, but the first-line margin differs. 

First Line Flush Left - No Indent 

Text that ends with a paragre,ph RETURN is a paragraph that can have its own 

spacing, tabs" and margins. This paragraph uses the same left and right 

margins in all examples, but the first-line margin differs. 

First Line Hangs - Hanging Indent 

Text that ends with a paragraph RETURN is a paragraph that can have its 

own spaDing, tabs, and margins. This paragraph uses the same left and right 

margins in all examples, but the first-line margin differs. 

First Line Indented - Indented without Tabs 

Since you can set the first-line margin marker where you 
want your paragraph indents, you don't press (Tab) to 
indent your paragraphs as you do on a typewriter. 

The horizontal ruler can show incremental markings as 
inches or centimeters. You can set the scale to your 
preferred measurements. 



The width of the horizontal ruler is normally 8-1/2 inches, 
based on a paper size of 8-1/2 x 11 inches. If you change 
the paper size in the Format for Printer dialog box, the 
width of the ruler automatically changes to match the 
new width. 

You can copy margin settings from one paragraph to 
another with the menu item Same as on Clipboard. For 
how to copy this and other formatting styles, see the 
Copy Paragraph Style procedure, under Format, in this 
chapter. 

Example 

Suppose you want to indent the first line of several 
contiguous paragraphs by 1/2 inch. 

1. You select the paragraphs and choose Show Margin/ 
Tab Ruler from the Format ~ menu. 

Single Space Lines 
1-1/2 Space lines 
Double Space lines 
Triple Space lines 

1E~2r.::::II]~[LfL •• ~· ·same as on [Ii 
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2. When the ruler appears, 
you move the first-line 
marker 1/2 inch to the 
right. 

£ X 
& -3. When you release the mouse button, the first line of 

the paragraph moves to the right. 

4. You choose Hide 
Margin/Tab Ruler from 
the Format ~ menu. Center 

Right Flush 
JustiFy 

I .. · .. · .... ······················· ........ · .... · ........ · ............................................... . 

Show Marg i niT ab Au I er 



To keep lines of text on the same page 

~ Select the lines you want to keep together. 

~ Choose Keep on Same 
Page from the Page 
Layout menu. 

To cancel 

~ Select the lines with the keep property. 

~ Choose Allow to Cross 
Pages from the Page 
Layout menu. 

Format 

Keep Lines 
of Text 

on Same Page 
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When you print a document or preview it, lines of text 
appear on a page according to the document's page 
margins and line and paragraph spacing; any lines that 
do not fit on one page are automatically moved to the 
next. However, you may ensure that lines will stay 
together on one page or all move to the next page by 
choosing Keep on Same Page. This setting remains with 
text even if it is moved or copied. 

When you want some text to always start printing on a 
new page, use Insert Page Mark rather than "keeping" 
text together. See the Page Breaks procedure, under 

Example 

Suppose your document contains several subject 
headings and you want to keep each heading with at 
least two lines of the text that follows. 

1. You select the first heading and at least two lines of 
accompanying text. 



2. You choose Keep on 
Same Page from the 
Page Layout menu. 

3. Repeat for all headings. 

Preview Pages 
..,IOon't Preview Pages 

, .• I' 

4. When there isn't enough room on one page for the 
heading and the text you kept with it, the heading will 
start a new page. 

5. A check mark now 
appears beside the 
menu item Keep on 
Same Page, showing 
that it is in effect for the 
current selection. 

..,IKeep On Same Page 
Allow to (ross Pages 

Format 

Keep Lines 
of Text 

on Same Page 
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To set the spacing between lines in a paragraph 

~ Select the text you are changing the spacing for, or 
place the insertion pOint where you want the new 
spacing to begin. 

~ Choose a line-spacing 
option from the 
Format ~ menu. Center 

Right Flush 
JustiFy 

:';Single Space lines 

1-1/2 Space lines 

Double Space Lines 
Triple Space Lines 

Sal'ne as on Clipboard WS 



You may increase or decrease the space between lines in 
a paragraph without changing the space between 
paragraphs. To change the spacing between paragraphs, 
see the Paragraph Spacing procedure, under Format, in 
this chapter. The samples below show the available line­
spacing options. 

These p8r8.,~raphs use the S1 ngl e L1 ne 
Spacing option. Single line spacing 
provides a very small space between each 
line IJf t ex t \i.Ji t hi n 8. pere.l~re.ph. 

Here is another p8Ia,~raph wi tfi sin'~le 
spacing. However; there is a double space 
bet0.leen per8.'~lraphs. 

Single Spacing 

This pe.re.graprl uses the 1-1/2 line-spe.cing 

option. A hal f-chaIe.cter spa.ce is added 

to the bottom of each line. 

Here is a.nether pars.'~ra.ph wi th 1-1/2 

spacing. However there is still a double 

sps.ce bet1fJeen p8Ia.l~rs.prls. 

1-1/2 Spacing 

Format 

Line Spacing 
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Here is a paragra.ph t hat uses the Doubl e 

line-spe.cing option. A full character 

space is added to the bottom of each line. 

To change the line spacing within any 

paragraph, just place the insertion point 

in that paragraph, and choose a new line 

spacing option from the Format !P menu. 

Double Spacing 

This peragre.ph uses triple line spe.cin~~. 

That means that bAIO full charact er spa.ces 

8Ie 8.dc~ec~ to the bottom of each line. 

Triple Spacing 



To start a new page 

~ Place the insertion point where you want the new 
page to begin. 

~ Choose Insert Page 
Mark from the Page 
Layout menu. 

To cancel 

~ Select the page mark in 
your document. 

~ Choose Cut from the 
Edit menu. 

Insert Page Number 

Keep On Same Page 
.,fAllow to (ross Pages 

Select All of Document aA 

Format 

Page Breaks 
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New pages start automatically whenever necessary, 
based on the length of the page, top and bottom 
margins, and the line and paragraph spacing used in 
your document. You may also control where pages end 
by inserting a page mark. Text after the page mark will 
start printing on the next page. 



To insert page numbers 

~ Choose Show Page Ruler or Previous Pages as you 
normally would to begin inserting a header or footer. 

~ Place the insertion point in the header or footer where 
you want page numbers to appear. 

~ Choose Insert Page 
Number from the Page 
Layout menu. 

. ,-
Insert Page Mark 

Keep On Same Page 
v'Allow to [ross Pages 

To remove page numbers from a document 

~ Choose Preview Pages or Show Page Ruler from the 
Page Layout menu so that you can see the top and 
bottom margins and the header and footer text. 

~ Select the page number 
on any page of the 
document and cut it 
from the text of the 
header or footer. 

• 

Format 

Page Numbers 
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You may use the Insert Page Number menu item on any 
page of your document and you may style page numbers 
like any other text. Since page numbers are part of a 
header or footer, you may align the paragraph any way 
you wish or include tabs and set tab stops to align the 
number. 

You may only insert page numbers into a header or 
footer. All pages are numbered sequentially, in the same 
spot, beginning with page one. Page numbers cannot be 
spelled out, or shown as roman numerals. 

page number, and you can have page numbers that 
include chapter, section, or other numbering. For 
example, you can have a page number such as "Section 
4-1." Just type the text that doesn't change as regular 
footer text, and choose Insert Page Number where you 
want the incrementing page number. To have another 
section with page numbers such as "Section 5-1," create 
a separate document. Only the page number can vary 
between headers and footers in a single document. 



Example 

Suppose you want to center page numbers at the bottom 
of each page of a document. Since page numbers can 
appear only as part of a document footer or header, you 
begin by setting up the footer: choose Show Page Ruler 
from the Page Layout menu. 

1. When the ruler appears, 
you scroll to the end of 
the page until you can 
see the footer marker. 

2. You select the point of insertion immediately below the 
footer marker. A blinking bar shows where inserted 
text will go. Most often this will be at the left margin. 

3. You choose Insert Page 
Number from the Page 
Layout menu. A page 
number appears at the 
insertion point in the 
footer. 

• I· 

Insert Page Mark 

Keep On Same Page 
..,fAllow to (ross Pages 
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4. You select the page 
number by triple clicking 
the mouse button, or 
clicking the button and 
pulling through the 
number, and then 
choosing Center from 
the Format ~ menu. 

5. Each page of the document is numbered in the same 
spot, in sequence. 

6. Since this is all you want in the footer, you choose Hide 
Page Ruler or Don't Preview Pages from the Page 
Layout menu to dismiss the ruler and its menu. 



To change a paragraph's alignment 

~ Select the paragraph(s) that you want to align. 

~ Choose an alignment 
style from the Format ~ 
menu. 

"(Left Flush 
Center 
Right Flush 
JustiFy 

Paragraph alignment refers to how the text is arranged 
between its left and right margins. The sample 
paragraphs below show the available alignments within 
identical margins. 

Left flush text has an even left margin, 
and a ragged right margin, like this 
paragraph. If the first line margin is 
indented or out dented from the left 
margin,. the first line will follow that I 
setting. All other lines begin at the 
left margin marker. 

Left Flush 
Aligned on Left Margin 

Justified text has even left and riaht 
margi ns throughout t he paragraph. Onl y 
the last line of text is not extended 
between margins. To justify text, 
LisaWrite spaces the words out on eacrl 
line between the left and right margin 
settings. This is an example of a 
justified paragraph. 

Justified 
Aligned on Left and Right 

Page ~ 

Right flush text has an even right 
margin, and an uneven left margin. 

You'll find it useful when 'y'ou want a 
few lines to print even with the right 

margin. In this example, the header 
containing "Page 2" 1S flush right, 
above a paragraph of text which is 

flush left. 

Right Flush 
Aligned on Right Margin 

A Centered Ti tle 

Centered text is placed equidistant 
between left and right margins. It is 
useful for titles. headinas. and header 

and footer information. - This is an 
eX8fnple of a flush left paragraph I;ith 

B. centered title line. 

Centered between Margins 

Format 

Paragraph 
Alignment 
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Left flush is the standard alignment on LisaWrite 
stationery until you change it to something else. 

Like other paragraph format styles, the alignment of text 
can be copied to other paragraphs by using Same as on 
Clipboard from the Format ~ menu. 



To set the spacing between paragraphs 

~ Place the insertion point where you want the new 
spacing to begin, or select the paragraph(s) that you 
want to change the spacing for. 

~ Choose a paragraph 
spacing option from the v'left Flush 
Format ~ menu. 

Center 

Right Flush 

Justi Fy 

Show Margin/Tab Ruler 

Hide Margin/Tab Ruler 

Sing I e Space 1r 
1-1/2 Spoce 1f 

v'Double Space ,r 
Triple Space 1f 

Format 

Paragraph 
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You may increase or decrease the amount of white space 
between paragraphs without affecting the spacing 
between lines in the paragraphs, so you only have to 
press (Return) once after paragraphs, regardless of how 
many lines you want. The paragraphs below show 
available paragraph spacing. 

Pars.graph Spacing sets the amount of whi te 
sps.ce to be left between psragrs.phs when 
you press RETURN. You can have single, 
one and e.-hal f. doubl e and tri 01 e soaCF! ( I -1-- --- -

paragre.ph spacing. 
Single Space: This is e.n example of two 
paragraphs with single space paragraph 
spacing. 

Single Paragraph Spacing 

1-1/2 Space: Here are two paragraphs with 
1-1/2 space paragraph spaci ng . 

You can see that more white space is left 
between the paragraphs. In addi tionl the 
insertion point extends below the last 
line, to show you the approximate size of 
the spacing.1 

1-112 Paragraph Spacing 



Double Space: Here are two para.graphs 
separated by double spaces. 

With Double Space Paragraphs chosen on the 
Format !P men~ the insertion point looks 
even 1 angeLI 

Double Paragraph Spacing 

Triple Space: Here are two paragraphs 
separated by triple spacing. Triple 
paragraph spa.cing leaves the most white 
space between para.graphs t hat you can get 
by pressing the RETURN key only once. 

In addition to seeing more space between 
paragraphs, you can tell that paragraph 
spacing is greater by looking at the 
insertion point. Dnce again, it has 
grown. 

Triple Paragraph Spacing 

In each of these examples, the length of the insertion 
point on the last line of the paragraph shows you how 
much space is left before the next paragraph. 
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Example 

You can vary paragraph spacing in your documents. For 
example, you may want to use single space paragraphs 
for address information at the top of a letter, and double 
space paragraphs for the main text of the letter. Just 
change the spacing as you enter the text. 

1. Open the Format ~ menu 
and look at it. If Double left Flush 

Page layout .l 
Space ~ is already -ICenter 
checked, just release the Right Flush 
mouse button. !f another 
paragraph spacing is set, 
choose Double Space ~. 

2. Type the date and 
press (Return). 

Justify 

Show Marg i niT ab Ru I er 
Hide Margin/Tab Ruler 

Single Space 1f 
1-1/2 Space 1r 

-IDouble Space U 
Triple Space 1r 

-ISingle Space lines 
1-1/2 Space lines 
Double Space Lines 
Triple Space lines 

Same as on C Ii pboard .S 

FebruarY' 13/ 1983 



3. Choose Single Space ~ from the Format ~ menu. 

4. Type the address lines of 
the letter, pressing 
(Return) at the end of 
each one. 

February 13, 1983 

t1r. John Jones 
Vice President of Marketing 
Crabtree Hardware Stores 
1539 So. ~'~ashington St. 
Oak Hill, CA 94786 

5. Choose Double Space ~ from the Format ~ menu. 

6. Type the rest of the letter. 
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To change the alignment of an existing tab stop 

~ Select the paragraph that contains the tab. 

~ Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. 

~ In the ruler, select the marker of the tab to be 
changed. 

~ Choose a new tab 
alignment option from 
the Ruler menu. 

. 
Inch Scale 
Metric Scale 

Clear Tab Stop 
_1"'_~11 I_-

Set Centered Tab '\ 
Set Right Flush Tab 
Set Oecinlal Tab 

V 



~ Choose Hide Margin/ 
Tab Ruler from the 
Format 11 menu. 

Center 
Right Flush 
JustiFy 

Show Margin/Tab Ruler 

When you choose a new alignment option, the tab is 
realigned immediately in the selected paragraphs. To 
make the same change to other paragraphs, do one of 
the following: 

1. Select each paragraph one at a time and repeat the 
procedure above. 

2. Change multiple paragraphs by selecting them all and 
then using the Copy Paragraph Style procedure, 
under Format, in this chapter. 

3. Select all the paragraphs, clear the existing tab stop, 
and set a new one with the tab alignment you want to 
use. 

It is important to note that tab alignment settings only 
affect text at tab stops. To change the alignment of full 
lines and paragraphs of text, see the Paragraph 
Alignment procedure, under Format, in this chapter. 
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Here are the tab alignments you can choose from: 

Normal Tab Right Flush Tab 

I I I 

I' I '~ ':' I' I '~ ~ " , I '~' I '~ 'i' I • I • ~ .~ III 
Centered Tab Decimal Tab 



When in use, the different tab alignments look like the 
example below. The tab stop is in the same position for 
each column. Only the alignment is different. 

Right Flush Tab Stop 

12345 
123.45 
12.345 

Text 

r\lormal T ab ~:top 

12345 
123.45 
12.345 
Text 

Centered Tat, Stop 

12345 
123.4:) 
12.345 
Text 

Decimal Tab Stop 

12345 
123.4:" 
12.34:', 

Text 

Format 
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If differently aligned tab stops are set close to one 
another, you may sometimes see overlapping text appear 
on the screen. 

1234~3.12 123.12 

i,1~8 .45676 

If you ever see text appear something like the above 
illustration, select it, call up the horizontal paragraph 
ruler, and move the tab stops further apart. More 

Stops procedure, under Format, in this chapter. 



To clear a tab stop 

~ Select the paragraph that contains the tab. 

~ Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. 

~ In the ruler, select the marker of the tab to be cleared. 

~ Choose Clear Tab Stop ..-I.Ii'.JT~nl;r-~ ____ __ 

from the Ruler menu. Inch Scale 

Metric Scale 

Set Normal Tab '\ 
Set Centered Tab 
Set Right Flush Tab 
Set Decimal Tab 
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~ Choose Hide Ruler from 
the Format ~ menu. 

Center 
Right Flush 
JustiFy 

I .. , .. , .... """ ...... , ...... , ...... " ........ , .. , .. , .. , .............. , 

Show Margin/Tab Ruler 

The tab stop is cleared although no tab characters are 
removed from the paragraph. You may either delete the 
tab character from the paragraph or set a new tab stop. 

Example 

1. You have header text in your document that looks like 
this: 

Addendum tel Berg Contract 
Page ~ 

2/15/83 

2. You want the date to appear right flush near the right 
margin, so you will clear the current tab stop, and set a 
new one. 



3. You select the header 
text and choose Show 
Margin/Tab Ruler from 
the Format ~ menu. 

4. Then you place the 
insertion point above the 
current tab setting, and 
click the mouse button 
to select the tab stop. 

5. You choose Clear Tab 
Stop from the Ruler 
menu. 

. .................................................................................................. 11 

Inch Scale 
Metric Scale 

Set Centered Tab 
Set Right Flush Tab 
Set Decimal Tab 

6. With the tab stop cleared, the date moves back on the 
line to just after "Berg Contract." 
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7. To place it at the right 
margin, you move the 
tab marker near the right 
margin and choose Set 
Right Flush Tab from the 
Ruler Menu. 

Inch Scale 
Metric Scale 

Clear Tab Stop 
Set Normal Tab 
Set Centered Tab 

- • I 

Set Decimal Tab 

8. The date moves to thp. right, ~H1d your header text 
looks like this: 

Adder,dum to Berg Contract 
Page 4 

2/15;83 

I '11 ' I ' I ' I '21 ' I ' I ' I ' 1 ' I ' I ' I ' 1 ' I ' I ' I ' 1 ' I ' I ' I ' 1 ' I ' I ' I ' I' 'I' 
3 4 5 6 7 ... ! 

I 



To change the pattern of an existing tab stop 

~ Select the paragraph that contains the tab stop. 

~ Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. 

~ In the ruler, select the marker of the tab to be 
changed. 

~ Choose the pattern you 
want from the Ruler 
menu. 

Inch Scale 
Metric Scale 

Clear Tab Stop 
Set Normal Tab 
Set Centered Tab 
Set Right Flush Tab 
Set Decimal Tab 

No Tab Fi II Pattern 
., Tab Fill Pattern 
-- Tab Fi II Pattern 

Tab Fill Pattern 

Format 
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~ Choose Hide Margin/ 
Tab Ruler from the 
Format ~ menu. [enter 

Right Flush 
Justify 

Show Margin/Tab Ruler 

Tab patterns fill the space between previous text and the 
text at a tab stop. Dot leaders in a table of contents are 
an example of how tab patterns can be put to use. 

The table below employs all available tab patterns. 

Date 

Apr 1 
Apr 2 
Apr 5 
Apr 15 
Apr 21 
Apr 28 
Apr 30 

Expenditure $ Amount 

Consulting, Maverick & Sons 250.00 
Printing, Ink spot Printers ........ 9.98 
Distributin~ Overnight Express Co .. 18.00 
Advert i si ng, Leo G. Carroll ,&; Assoc. 150.83 
Convention Hall, Community Center . 250.00 
Catering, Fred IS Fa.vorities ..... 1250.00 
Service, Equipment Maint ......... 250.00 

Apr 30 Total ------------------- --- 2178.81 

Plain I Underlined Dashed Dotted 



To set tab stops 

~ Place the insertion point where you want the new tabs 
to begin, or select the text you want the tab stops to 
apply to. 

~ Choose Show Margin/ 
Tab Ruler from the 
Format ~ menu. 

~ In the horizontal ruler that appears, move the black 
set-tab marker to the position where you want a tab 
set. 

~ Choose a tab alignment 
option from the Ruler 
menu. 

Inch Scale 
Metric Scale 

Clear Tab Stop ---
Set Centered Tab '\ 
Set Right Flush Tab 
Set Oecilllal Tab 

v 
~ If you want a pattern to fill the tab stop, choose the 

one you want from the Ruler menu. 

~ Repeat the last two steps until all tabs are set. 
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~ Choose Hide Margin/ 
Tab Ruler from the 
Format ~ menu. 

Center 
Right Flush 
Justify 

Show Margin/Tab Ruler 

LisaWrite provides the aligned tab stops shown at the 
right. In this example, each tab stop is set at the same 
point in the ruler. Only the tab-stop alignments differ. 

Right Flush Tab Stop 

12345 
123.45 
12.345 

Text 

Normal Tab Stop 

12345 
123.45 
12.345 
Text 

Centered Ta.b Stop 

12345 
123.45 
12.345 
Text 

Decimal Tab Stop 

12345 
123.45 
12.345 

Text 



You can also fill tabs with a pattern from the beginning of 
the tab to the tab's right margin. For more information, 
see the Tab Patterns procedure, under Format, in this 
chapter. 

You can enter text and tab characters before setting tab 
stops, or you can set the tab stops and then type your 
text. And of course you can adjust the tab stops at any 
time if they're not where you want them. 

When you press the (Tab) key, a special tab character is 
inserted in your text. If tab stops are already set for the 
current paragraph, the insertion point moves to the first 
tab stop. If no tabs have been set on the ruler, the 
insertion point moves a little bit, just so you can tell that 
the tab character has been inserted. 

When you want to change the position of a tab stop, you 
have two choices. You can: 

1. Clear the existing tab stop and set a new one. 

2. Place the pointer in the tab stop, click the mouse 
button, and pull the tab stop to a new position. 

When you move a tab stop by dragging it with the pointer, 
any tab stops to the right of it will also move. The moving 
tab stops remain the same distance from each other. This 
allows you to manipulate columns of tabbed numbers 
easily. 
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Occasionally you'll want to set tabs for use with 
paragraphs of text. You'll find this particularly useful 
when using outline formats, which have numbered or 
bulleted items where the first-line left margin £. is set to 
the left of any subsequent-line left margin £. When you 
have an "outdent" of this sort, set a tab stop above the 
£. symbol. Then when you enter the text, type the 
number or bullet and press (Tab) before typing the main 
text of the paragraph. The example below shows a 
numbered paragraph and the margins and tabs that have 
been set to ensure accurate alignment in it. 

i 
1. This is an example of numbered items, such as you might use in an 

outline. 

2. The first-line left mergin is set at 1" on the ruler, while the 
subsequent-lines left :1Iargin is set at 1-112". 

3. To line the text up properly, a tab stop is also set at 1-112". 

4. After typing each number.,) press the TAB key before typing the text that 
goes next to it. 1. 

'~ , 1'1'1 '21 ' I ' I ' 11'31 ' I ' I ' I '41' I ' I ' I '~ , 1'1 ' I 'd ' I ' I ' I '~ , 1'1 

£ "-
& £ 

Example 

1. You have two columns of 
information to enter. You 
select an insertion point 
on a blank line where you 
want to enter the 
information, and choose 
Show Margin/Tab Ruler 
from the Format ~ menu. 

"2,100 

11,350 

/, ~OO 
'f50 
'175 



2. You want the two columns indented from the margins, 
so you move the set-tab marker to 2 inches on the 
ruler and choose Set Normal Tab from the Ruler 
menu. Then you move the set-tab marker to the 4-1/2 
inch mark and choose Set Decimal Tab from the Ruler 
menu. The ruler looks like this: 

, I ' 1'1'1'1'1'1'1'1'1'1'1'1'1'1'1'1' '1'1'1'1 
1 2 3 4 5 

L ~ 

3. You choose Hide 
Margin/Tab Ruler from 
the Format ~ menu, and 
then type in your 
columns of information, 
pressing (Tab) before 
each item, and (Return) 
at the end of each line. 

Center 
Right Flush 
Justify 

Show Margin/Tab Ruler 

4. When complete, your text looks like this: 

Rent 

Payroll 

Cost of Sales 

Utilities 

Hisc. 

$2100.00 
I 

$11/350.00 

$1800.00 

$450.00 

$97C on ,'.'. ... 
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and page numbers. The text on your screen looks like 
this: 

Table of Contents 

What's in Chapter 17 3 

The Lisa~'Jri te Screens 3 

The Basi c U f:;FiWri t e Screen 3 

The Horizontal Pare.gre.ph Ruler 5 

The Vertical Page Ruler 6 

Li s8~vri t e Concept s 8 

Enterin~ Editin~ and Formatting Text 8 

~Jord ~IJrap 9 

~ext, Pari3.graprls, and Pages 9 

x 
2. You pressed (Tab) before the number at the end of 

each line. However, you did not set any tab stops first. 

3. You select the text you 
entered, and choose 
Show Margin/Tab Ruler 
from the Format ~ menu. 

v'left Flush 
Center 
Right Flush 
JustiFy 

.. -

til 
trK 
tiR 
trJ 

Hide Margin/Tab Ruler 



4. You move the the tab 
marker to the 6 inch 
mark on the ruler and 
choose Set Right Flush 
Tab from the Ruler 
menu. 

5. Then you open the Ruler 
menu again and choose 
.. Tab Fill Pattern. 

Inch Scale 
Metric Scale 

Clear Tab Stop 
Set Normal Tab 
Set Centered Tab 

Inch Scale 
Metric Scale 

Clear Tab Stop 
Set Normal Tab 

Set Centered Tab 
Set Right Flush Tab 

Set Decimal Tab 

No Tab Fill Pattern 

Tab Fill Pattern 

Format 
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6. When you hide the ruler, your table of contents looks 
like this: 

Table of Contents x 

What I 8 in Chapter 1" ............................. , 3 

The Li s8.v,lri t e Screens . . . . . . . . . . . . . . . . . . . . . . . . . . . .. 3 

The Basic Lisa~~rite Screen . . . . . . . . . . . . . . . . . . . . . . . .. 3 

The Horizontal Paragraph Ruler ..................... , 5 

The Vertice.l Page Ruler ................. _ 

Li88.l'~rite Concepts ............................... , 8 

Entering, Editing, and Formatting Text ........ , ...... , 8 

Word Wrap ..................... , ...... , .. , , .. , , .. 9 

Text, Pel's.graphs, and Pages ... , ... , ... , , , ... , , .. , , " 9 



To set the top and bottom margins on the page 

~ Choose Show Page 
Ruler from the Page 
Layout menu. A vertical 
ruler appears at the right 
side of your document 
and the Page Ruler 
menu appears on the 
menu bar. 

~ If you want to change the 
measurement scale 
shown on the ruler, 
choose the scale you 
want from the Page 
Ruler menu. 

~ Move the pointer to the 
top margin marker in the 
ruler and pull it to the 
new position. 

.:.:,IL .... , • l_ 
Preview Pages 

-.lOon't Preview Pages 

_1I11111i11111=ziT •• . 
Hide Page Ruler ~ 

.. " ..... ,", ....... " ...... , ... " .............. " ...... , 

Insert Page Number 

Insert Page Mark 

Keep On Same Page 

-.lAllow to (ross Pages 

~ Scroll the document up until you can see the bottom 
margin of the page and the ruler. 

Format 
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~ Move the bottom margin 
marker to the new 
position. 

~ Choose Don't Preview 
Pages from the Page 
Layout menu. 

Top and bottom margins let you specify the amount of 
white space to be left at the top and bottom of each page 
when you print your document. The standard top and 
bottom margin settings on the LisaWrite stationery pad 
are 1 inch each. 

The top margin specifies where on a page the text of your 
document begins printing; the bottom margin specifies 
where the last line of text will print. Actual bottom 
margins may differ from page to page, however. For 
example, bottom margins may differ when text you kept 
together doesn't fit on one page and moves to the next 
page or when you insert a page mark to start a new page. 



You can also change the positions of header and footer 
text within the top and bottom margins by moving their 
respective markers. They are initially set at 112 inch from 
the top and bottom of the page. For more information, 
see the Headers and Footers procedure, under Format, 
in this chapter. 

The length of the page ruler is normally 11 inches long, 
based on a paper size of 8-112 x 11 inches. If you change 
the paper size in the Format for Printer dialog box, the 
length of the ruler automatically changes to match the 
new width. 

Example 

Suppose you want to increase the amount of white space 
at the top and bottom of each page of a document from 
the standard 1 inch to 1-1/2 inches. 

1. You choose Show Page 
Ruler from the Page 
Layout menu. 

Preview Pages 
..,lOon 't Previ ew Pages 

Hide Page Ruler ~ 

Insert Page Number 

Insert Page Mark 

Keep On Same Page 
v'Allow to (ross Pages 
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Top and 
Bottom Margins 

(continued) 

Chapter 2 ::: C101 
Procedures ••• 



Format 

Top and 
Bottom Margins 
(continued) 

• • • LisaWrite Reference Guide 
C1021: : : Section C 

2. When the ruler appears, 
you move the pointer 
into the top margin 
marker and move it to 1-
1/2 inches in the ruler. 

3. Yuu scroii to the end of 
the page ruler and move 
the bottom margin 
marker to 9-1/2 
inches. 

4. When you print the document, the body of the 
document will begin printing at 1-1/2 inches from the 
top of the page and end at 1-1/2 inches from the 
bottom of the page. Unless, of course, pages end prior 
to the bottom margin to satisfy a keep property or a 
new page mark. 



To change type styles 

~ Select the text to be changed. 

~ Choose a style from the 
Type Style menu. Wp 

Underline WU 
Bold WB 
Italic Wi 
Superscr i pt 
Subscript 

15 Pitch Gothic 
"12 Pitch Modern 

12 Pitch EI ite 
10 Pitch Modern 
10 Pitch Courier 
PS Modern 
PS Executive 
1/4 inch Modern 
1/4 inch Classic 
1/3 inch Modern 
1/3 inch Classic 

The Type Style menu includes both styles of type and 
type fonts available for your use in LisaWrite documents. 

The type styles shown at the top of the Type Style menu 
can be combined. For instance, you may bold, italicize, 
and underline the same text. In addition, you can 
combine any of the available fonts on the menu with the 
available styles. Text can appear only in one font at any 
one time; however, multiple fonts can be used in the 
same document. For example, one word can appear in 12 
Pitch Modern next to a word in 1/4 Inch Modern. 
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Type of one size and face or "shape" is called a font. On 
the Type Style menu, some font names are preceded by a 
number that indicates character size. This number 
indicates how many characters will print per inch when 
you use that type font. "PS" in front of a font name 
stands for proportionally spaced. 

LisaWrite provides several sizes of both serif and sans 
serif typefaces. Serifs are the fine lines that finish off the 
main strokes of a character, sometimes called "feet." A 
sans serif typeface is simply one without serifs, or feet. 

Guidelines for Type Fonts 

You can create a wide range of effects in your documents 
by varying type style and font. However, too many 
variations can be distracting. Professional printers 
usually choose one face for a document, but may vary 
the size to provide emphasis. 

Some of the LisaWrite fonts are shown below. All 
LisaWrite fonts appear in Appendix 3, Type Fonts, in this 
manual. 
Th1S 1S the 15 p1 tch GothiC type font. 

This is the 12 pitch Modern type font. 

This is the 10 pitch courier type font. 
This is the proportional spaced modern type font. 

This is the 1/4 inch Classic font. 



Guidelines for Type Styles 

Any style combination is possible - for example bold 
and italic look good when combined - though some 
combinations are distracting. Use type styles judiciously 
to aid the reader rather than distract. For example, 

• Bold text is good for head ings, titles, and strong 
emphasis. 

• Italic text is good for quotations and subtle emphasis. 
If you italicize a quote, you may drop the quotation 
marks. 

• Underlining is good for emphasis with a daisy wheel 
printer. 
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Combinations of styles of type are shown below. 

This is Plain Text. 

This is Underlined Text. 

This is Bolded Text. 

This is It,5.1ic Te,.),',t. 

C" ~-.' t ~uper~Lrlp, Normal Text 

Typestyles should add impact to y'our 
words. Avoid distracting cOIIIbinations. 

Super- and subscripted styles help wi th 
scienti fic formulae and raised footnote 

reference numbers: E=mc2i 2 x l017i 

R = RXi + RYj + RZk 

To remove bolding, underlining, or italics from text, 
select the text and then choose Plain Text from the Type 
Style menu. 



Some type styles and fonts can only print on a dot matrix 
printer, or with a special print wheel on a daisy wheel 
printer. If a daisy wheel printer is selected for this 
document in the Format for Printer dialog box and you 
choose type styles or fonts for the dot matrix printer, or 
for a print wheel that you haven't told the Lisa you are 
using in Preferences, you will get an alert message that 
looks like this: 

• 

The font you chose will be associated with 
the selected text. However, that font wi II 
not be displayed or printed until you 

• I specify a different printer or print wheel 
by choosing Format for Printer from the 
File/Print menu. 

( Cancel J 

OK 

For more information, see the Format for Specific 
Printers procedure, under Print, in this chapter. 

If you are adding finishing touches to your document and 
have already made your vertical page layout 
adjustments, you may want to preview your document 
again if you change type fonts. Changing the font size of 
existing text may cause some realignment of text in your 
document, because the number of characters that fit 
between the left and right margins changes. 
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C118 Print a Document 
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To format your document for a specific printer 

~ Choose Format for 
Printer from the File/ 
Print menu. 

Set Aside Everything 
Set Aside "Typestyles" 

Save & Put Away 
Save & Continue 
Revert to Previous Version 

Monitor the Printer, .. 

~ Check the type of printer that this document will 
print on. 

~ If you are using a dot matrix printer, check the 
orientation and resolution that you want to use for this 
document. 

~ If you are using a daisy wheel printer, check the paper 
size and print wheel style that you want to use for this 
document. 

~ Check the response you want the Lisa to make if no 
printer matches the settings you've picked. 

lr.Jhat do you want done if the printer y'ou've specified 
does not appear to be connected to this machine? 

o Tell Me • Pick an Available Printer for Me 0 Disregard it 

~ Click OK. 
( OK J 



It's a good idea to choose the Format for Printer settings 
for a document before you add other formats to your 
document, because some Format for Printer settings 
limit the other formatting settings available to you. These 
are discussed under the individual settings, below. 

Printer format settings take effect in the text of your 
document after you click OK in the dialog box. 

The settings you check in the Format for Printer dialog 
box work with the formats you set in your document as 
you enter and edit text. These printer settings are saved 
with each document and become part of the settings that 
determine how your document displays on the screen, as 
well as how it prints out. 

Settings in the Format for Printer Dialog Box 

The Format for Printer dialog box lets you check the kind 
of printer you want this document to print on, and then 
lets you specify some details on size of paper and type 
style. 

You can tell the Lisa to print your document on a dot 
matrix or daisy wheel printer. The items that follow Print 
Method in the dialog box change when you change your 
printer preference from dot matrix to daisy wheel, or 
back. 

Print 

Format for 
Specific Printers 
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Dot Matrix Printer Settings 

When you choose Dot Matrix printer in the Format for 
Printer dialog box, you see these additional choices: 

Format For Printer .. , 
On which printer do you intend to print this document? 

Print Method:. Dot Matrix 0 Daisy Wheel 

Paper Length: Ill" 014" 
Orientation: I Portrait (tall) 0 Landscape (wide) 

Resolution: • Normal 0 High 

What do you want done if the printer you've specified 
does not appear to be connected to this machine? o Tell Me • Pick an AV8.ilable Printer for Me 0 Disregard it 

Paper Length: With a dot matrix printer, you can print 
on 11 or 14 inch paper. The length you choose is 
automatically shown on the page ruler when you 
display it. 

Orientation: This setting tells the Lisa whether to print 
your document horizontally or vertically on the paper in 
your printer. When the orientation is Portrait, the Lisa 
prints the text of your document across the 8-112 inch 
width of your paper, from left to right. When the 
orientation is Landscape, the Lisa treats the length of the 
paper (11 or 14 inches) as the width. In other words, it 
treats the paper as though you had 11 x 8-112 inch paper 
in the printer. The horizontal page ruler automatically 
extends its width to 11 inches when you check 
Landscape. 

Resolution: This tells the Lisa what quality you want the 
document to print with. Normal resolution gives you a 
standard character image. High resolution produces a 
much finer quality character image but takes longer to 
print. 

When using landscape orientation and normal 
resolution, the font size of the text will be smaller when it 
is printed than it was shown on the screen. 



Daisy Wheel Printer Settings 

When you choose Daisy Wheel printer in the Format for 
Printer dialog box, you see these additional choices: 

Format For Printer ... 
On which printer do you intend to print this document? 

Print Method: 0 Dot Metrix • Daisy Wheel 
Paper Size: D S.Sx11" -l1xS.S" 

OS.Sx14" 0 14xS.S" D 14xll" 
Print Wheel: .GotMc lS DElite 12 DCourier 10 DExecutive PS 

o PS plus italics Dl0/12/PS 0 10/12+Addn' 1 9heJ:iiQters 

What do you Vlant done if the printer you've specified 
does not appear to be connected to ~is machine? 

o Tell Me • Pick an Availab·te Pnnter for ~1e o Disregard it 

Paper Size: When you print with a daisy wheel printer, 
you have five choices for paper size: 8-1/2 x 11 inches; 11 
x 8-1/2 inches; 8-1/2 x 14 inches; 14 x 8-1/2 inches; and 
14 x 11 inches. The size you choose is reflected in your 
document when you use the horizontal paragraph ruler 
and the vertical page ruler. The length of each ruler 
reflects the size of the width and length of the paper you 
have set. 

Print Wheel: You have a range of choices in print 
wheels. The wheel you decide to use does limit the range 
of type styles and fonts that you may use in your 
document. For instance, if you check 15 pitch as your 
print wheel, text will not display in 10 pitch on your 
screen, even if you've chosen it on the Type Style menu. 
With any print wheel, however, you also can use 1/4 and 
112 inch type fonts. When you try to use a type style or 
font that is incompatible with the current printer settings, 
you'll see this alert box: 

The font you chose will be associated with 
the selected text. However, that font wi II 
not be displayed or printed until you 
specify (l different printer or print wheel 
by choosing Format for Printer from the 
File/Print menu. 

( (ancel ) 

OK 

Print 
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When Settings Don't Match a Printer 

In order for the Lisa to follow your instructions in this 
Format for Printer dialog box, two other factors must be 
true: Preferences must show that the type of printer with 
the settings you choose here is attached to the Lisa, and 
such a printer must be attached. 

Whenever you click OK in the Format for Printer dialog 
box, the Lisa checks the new settings against the printer 
settings listed in Preferences. If they don't match, the 
Lisa then looks at the bottom line of the dialog box to see 
what you want done. Here are your choices: 

Tell Me: When Tell Me is checked, the Lisa notifies you 
that no printer specified in Preferences meets the 
settings you have checked. An alert box appears, so that 
you can decide what you want to do next. Here is what it 
looks like: 

Intended Printer Unavailable! 
Accordmg to the F'references Window's list of Device Connections, the 
Intended Printer for this document is not connected to this machine. 

On which printer do you intend to print this document? o A printer that is not listed in Preferences right now . 
• Slot 2 Upper -- Dot Matrix -- 11" 

What do you want done if the printer you've specified 
does not appear to be connected to this machine? 

.Tell Me DPick an Available Printer for Me o Disregard it 



Pick an Available Printer: When Pick an Available 
Printer is checked, the Lisa will choose an alternative 
printer if one doesn't match exactly the settings you 
requested. For instance, if you've specified a daisy wheel 
printer but only a dot matrix is attached and checked in 
Preferences, the Lisa formats your document for the dot 
matrix printer, rather than for a daisy wheel printer. 

Disregard It: When Disregard It is checked, the Lisa 
notes the difference in printer settings and available 
printers, but doesn't do anything. This allows you to 
continue working with your document without being 
interrupted to make a decision about print formats now. 
You should check this box when you intend to print the 
document on a different printer from the one that is 
connected to your Lisa now. 

Print 
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To preview a document 

~ Choose Preview Pages 
from the Page Layout 
menu. 

To cancel 
...... r'&""""",,....,,,,, n,,_'+ n ... _ .. :_ ... 
II""'" ~I IVVvV' VVII l r I V'V IV'YY 

Pages from the Page 
Layout menu. 

Preview Pages shows you how your document will look 
when printed, based on the current printer specifications 
and the current page layout settings. Top and bottom 
margins, headers and footers, and page numbers are all 
incorporated into the text of your document, to give you 
the total effect. Choosing Show Page Ruler also turns on 
preview. 



The top of the first page of your document shows on your 
screen when you choose Preview Pages. Use the view 
controls to see the rest of your text. 

You may enter, edit, and format text while preview is on, 
just as at any other time while using LisaWrite. You may 
find that working on your documents is somewhat slower 
when Preview Pages is on, however. 

When you have a long document and choose Preview 
Pages, the hourglass pointer may appear, telling you to 
wait temporarily. While you wait, LisaWrite is paginating 
the text of your document so that you can see it on the 
screen correctly. For very long documents, this process 
may take a few minutes. 

Print 

Preview a 
Document 
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~ Set up your printer and connect it to your Lisa. For 
assistance, see the manual that came with your 
printer. 

~ If you have not previously specified the printer(s) you 
use in Preferences, do so now. For assistance, refer to 
Section D, Desktop Manager Reference Guide, in the 
Lisa Owner's Guide, under Set Printer Configuration. 

~ Get or activate the document. 

~ If you need to change 
any of the options in the Set Aside Everything 
Format for Printer dialog Set Aside "Typestyles" 
box for this document, . ... ...... .. . 
choose Format for 
Printer from the File/ 
Print menu. 

Save [, Put Away 
Save [, Continue 
Revert to Previous Version 

Monitor the Pr inter ... 

~ Make any necessary changes in the Format for Printer 
dialog box that appears. 

~ Click OK. 



~ Choose Print from the 
File/Print menu. Set Aside Everything 

Set Aside "Top and Bottom 

Save & Put Rway 
Save & (ont i nue 
Revert to Previous Version 

Format for Printer ... 

~ Make any necessary changes in the Print dialog box 
that appears. 

~ Click OK. 

Using the current printer settings and the formats you 
specified in the text, your document begins printing. 

For how to make changes in the Format for Printer dialog 
box, see the Format for Specific Printers procedure, 
under Print, in this chapter. 

If the printer settings and printer don't match, an alert 
box appears. Alert boxes resulting from a mismatch are 
discussed in the Format for Specific Printers procedure, 
under Print, in this chapter. 

Sometimes a Monitor the Printer dialog box will appear. 
See While You Work, later in this procedure, for 
information on this alert box. 

Print 
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Print... • Finished Quality D Quick Draft (Text Only) 

DOne Copy While You y,'ait • While You Work , ....................................... " .. " ... " 

• All Pages D Only ~ """ .... " ...... , ...... "., ....... , .. ,., .. , ... , .. , .. , ... ; 

Number of Copies: .001Il[D000[D~ 

The Print dialog box lets you specify some final details 
about how your document will print. The choices in the 
Print dialog box are discussed below. 

Quality 

Finished Quality: Finished Quality prints your 
document as you have formatted it on the screen, 
including special type styles and fonts. 

Quick Draft: Quick Draft lets you get a printed copy of 
the text faster, but without any special type styles and 
fonts used in your document. On a dot matrix printer, the 
built-in font is used for Quick Draft. On a daisy wheel 
printer, whatever print wheel is on the printer wi" be 
used, even if you've specified a different one in your 
document. With a Quick Draft, words wi" still begin 
printing where they will in finished quality, but the 
spacing within the words may differ. 

Speed 

While You Wait: You can have the Lisa use most of its 
attention to print your document while you wait. A 
document wi" print more quickly if you choose While You 
Wait, but you won't be able to use the Lisa for any other 
tasks. 



While You Work: You can have the document print while 
you continue to use the Lisa for other tasks. Some 
printing conditions make printing while you work 
inconvenient, however. For example, if you are single 
sheet feeding paper into your printer, and printing a 
Quick Draft, you won't have time to do other activities on 
the Lisa. 

When you choose While You Work, the Monitor the 
Printer dialog box appears. 

Monitor the Printer .. 

Document being printed: Untitled 
Copy being printed: 1 OF 
Page being printed: 0 OF 

If you went to do other work while the document is being printed, 
click Proceed. Otherwise, just wait. 

If you do decide to Proceed, you can get back here by choosing 
Honitor the Printer from the FilelPrint menu. You should do that if 
\'DU hear e whistle or if you want to terminate printing. 

This dialog box tells you the name of the document, the 
copy, and the page now being printed. Click Proceed to 
return to LisaWrite and to continue working. Click 
Terminate if you want to stop the printing. If you decide to 
proceed, you can return to this dialog box at any time to 
stop the printing by choOSing Monitor the Printer from 
the File/Print menu. 

Note that if you hear a whistle, there is a problem with 
printing while you work. Choose Monitor the Printer from 
the File/Print Menu to see what the problem is. 

Print 
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Number of Pages 

All Pages: You can print all pages of a document. Just 
make sure All Pages is checked in the Print dialog box. 

Selective Pages: To print selective pages of a 
document, check Only Pages and then fill in the boxes 
with the starting and ending pages to print. 

When you want to print from the beginning of a 
document through some page number, say 8, you enter 
"8" in the second box after Through. Similarly, if you 
want to start at a given page number and print to the 
end, you need to enter the starting page number in the 
box after Only Pages. 

Number of Copies 

You can print from 1 to 10 copies of any document. Just 
check the box with the number of copies you want 
printed. 



C124 Find Text 
C127 Find and Change Text 
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To find text 

~ Choose Find What? 
from the Search menu. 

~ In the brackets next to 
Find in the diaiog box, 
type or paste the text 
you want found. If you 
don't know the exact 
phrase, choose Insert 
Wild Card from the 
Search menu in place of 
the unknown text. 

~ Choose Find Next 
Occurrence from the 
Search menu. 

Change This Occurrence 
Change & Find Next , 

Find & Change All 

Find 
C~18.nge t I] 

·m ',I.' 

{ } 



You can identify any word or phrase and LisaWrite will 
find it, select the text, and display it on the screen. When 
the exact phrase is unknown, you can insert a "wild card" 
in place of the unknown text. In addition, you may match 
upper- and lowercase characters or ignore their case and 
find text regardless of capitalization. 

Each search begins with the text following the selection 
or insertion point. When LisaWrite finds the text you 
specified, it is highlighted on the screen. If LisaWrite 
can't find the text you want, Not Found appears in the 
lower right corner of the dialog box. 

If you want to search through an entire document, be 
sure to place the insertion point at the top of it. 

Search Dialog Box as a Window 

The Search dialog box can be treated as a window in 
itself. The size control box in the lower right-hand corner 
lets you increase the size of the box, and the scroll arrows 
let you move the text up and down in it, just like in your 
document windows. 

Scroll arrows---.... 

Find {M!. Clement} 
Change to {} 

This dialog box allows you to enter large amounts of text 
to be searched for by typing or pasting, and to view all of 
it at once. 

Search 
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(continued) 

Chapter 2 ::: C125 
Procedures ••• 



Search 

Find Text 
(continued) 

• • • LisaWrite Reference Guide 
C126j: : : Section C 

Wild Cards 

Use wild cards to help you locate text when you don't 
remember it exactly. You can choose Insert Wild Card in 
the middle of text you are searching for. You might want 
to use a wild card to help locate a word you think you 
have misspelled, or as part of a phrase you don't 
remem ber exactly. 

For example, suppose you want to change all 
occurrences of the color "gray" to "black" in a 
document. Sometimes the word was spelled "grey" and 
sometimes it was spelled "gray." In the Search dialog 
box next to "Find," you type "gry." Then you place the 
insertion point between the "r" and the "y," and choose 
Insert Wild Card from the Search menu. Three dots 
appear between the "r" and the "y." Now when you 
choose Find What?, LisaWrite locates both spellings of 
the word. 



To find and change text 

~ Choose Find What? from 
the Search menu. 

~ In the brackets next to 
Find in the dialog box, 
type or paste the text 
you want found. If you 
don't know the exact 
phrase, choose Insert 
Wild Card from the 
Search menu in place of 
the unknown text. 

Change This Occurrence 
Change & Find Next tiN 
Find [, Change All 

Find 
Change to 

~ Place the insertion pOint in the brackets next to 
Change To by pressing (Enter) or by moving the 
pointer within the new brackets and clicking the 
mouse button. 

~ In the Change field, type 
or paste the replacement 
text. 

~ Choose a change option 
from the Search menu. 

Fi nd ( ~1r. Clement)· 
C~I8.nge to {Mr. Clemant} 

Find k/hat? • 

Find Next Occurrence .F 
Change This Occurrence 

Change & Find Next tiN 
Find & Change All 

Search 

Find and 
Change Text 
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The Search menu provides options to change the text 
you've found, to change this occurrence and find the 
next, and to change all occurrences. 

Each search begins with the text following the selection 
or insertion point. When LisaWrite finds the text you 
specified, it is highlighted on the screen. If LisaWrite 
can't find the text you want, Not Found appears in the 
lower right corner of the dialog box. 

If you want to search through an entire document, be 
sure to place the insertion pOint at the top of it. 

1. Suppose the phrase 
"Solar Energy 
Commission" appears 
repeatedly in your 
document and you want 
to change it to "SEC." 
You choose Find What? 
from the Search menu. 

Change This Occurrence 
Change & Find Next " 
Find & Change All 
. · .................... · ........................ · .................................................. 11 

Cases Must Agree 
uses Need Not Agree 

2. You type "Solar Energy Commission" and press the 
(Enter) key. 

Find {Solar Energy C~mmission) 
Change to {) 

3. You type "SEC," which appears in the Change field of 
the dialog box. 

Fi nd {Solar Energy Commission} 
Change to {SEC) 



4. You choose Find Next 
Occurrence and the first 
occurrence following the 
insertion pOint is located 
and displayed on the 
screen. 

5. You choose Change This 
Occurrence and "SEC" 
is substituted into your 
document. 

6. You choose Find & 
Change All from the 
Search menu and all 
other occu rrences are 
found and changed. 

Change Th is Occ 
Change & Find Next tiN 
Find & Change A II 

Cases Must Agree 

Need Not Agree 

Insert Wild Card ( ... J 

Hide Dialog Box 

Find What? 

Find Next Occurrence 
Change Th is Occurrence 
Change & Find Next tiN 

Cases Must Agree 

ases Need Not Agree 

Search 

Find and 
Change Text 
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To copy LisaCalc cells to a LisaWrite document 

~ Get or activate the LisaCalc spreadsheet. 

~ Select the cells that you want to copy. 

~ Choose Copy from the 
Edit menu. 

Select All of Document etA 

~ Get or activate the LisaWrite document. 

~ Place the insertion point where you want to place the 
LisaCalc data, or select the text in the LisaWrite 
document that you want to replace. 

~ Choose Paste from the 
Edit menu. 

~ Make any formatting changes you want to the new 
text. 



When you copy cells from a LisaCalc spreadsheet to a 
LisaWrite document, only the values are copied. The cells 
are arranged in the LisaWrite document in the same 
positions as in the LisaCalc spreadsheet. Each column 
becomes a tab stop, including the first one. Tab 
alignments are set to match the alignments that were 
specified in LisaCalc. 

Other Tools 

LisaCa/c 
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Appendix 1 
Menu Items 

File/Print Menu 

Set Aside 
Set Aside 

Save & Put Away .... ---M-....J 

Returns all windows to their icons 
without saving the contents. 

Returns the current document to 
its icon without saving the 
contents. 

Saves the contents of the 
document, closes the window, and 
returns the icon to its original 
location. 

Save & Continue ... ---....... -Saves the contents of the 
Revert to Previous Version document and leaves the window 

open. 

Format for Printer ....... ---ili---t 
Print ....... ------...., 
Monitor the Printer ... 

Returns the document to its state 
as of the last time you saved it. 

Sets formats in the document 
based on the printer that will be 
used. 

Prints the document. 

Shows the status of the 
document(s) printing. 

Appendix 1 
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Edit Menu 

last Change.4-----II1-- Restores the document to its state 
before the last operation. 

Cut 

Copy 

Paste 

eix 
eiC 
eiv 

Select All of Document eiA 

Search Menu 

Find at? ei 
Find Next Occurrence 
Change This Occurrence 
Change & Find Next tiN 
Find [, Change All 

Cases Must Agree 
-.lCcues Need No~ Agree 

Indicate basic editing functions. 

Selects entire document. 

Shows the dialog box containing 
what to search for and what to 
replace it with. 

Finds the next occurrence of the 
specified text and selects it. 

Indicate what LisaWrite will do 
with the selected text. 

Indicate whether to check 
capitalization or not when 
,...-"' ... _ ..... :_- ,,- ...... _ ... , ... 
.;J";;if;"'''IIIII~ IVI '"vA ... 

Insert Wild Card ( ... )4--II---Searches for unknown characters 
in the middle of the text you want 

Hide Dialog BOx4----4----.. to find. 

Removes the dialog box from the 
screen. 



Type Style Menu 

'PIII+ __ Removes any bolding, underlining, 'U and italics from the text. Under I ine 

Bold 

Italic 

Superscript 

Subscript 

.B . , 
15 Pitch Gothic 

12 Pitch Modern 

12 Pitch Elite 

10 Pitch Modern 
10 Pitch (our i er 

PS Modern 
PS Executive 

v'1/4 inch Modern 

1/4 inch Classic 

1/3 inch Modern 

1/3 inch Classic 

Format ~ Menu 

v'Center 
Right Flush 
Justify 

Show Margin/Tab Ruler 

Hide Margin/Tab Ruler 

Single Space 1r 
1-1/2 Space 1r 

.JDOllb I e Space ,r 
Triple Space 1r 

v'Single Space Lines 

1-1/2 Space Lines 

Double Space Lines 

Triple Space Lines 

Same as on Clipboard .S 

Customize text with underlining, 
bolding, and italics . 

Create subscripts or 
superscripts-text that is set 
above or below the line. 

Indicate type fonts available on 
the Lisa. See Appendix 3, Type 
Fonts, for examples. 

Align paragraphs of text between 
left and right margins. 

Shows or hides the margin/tab 
ruler. 

Set paragraph spacing . 

Set line spacing. 

Formats the selected paragraph(s) 
like the one now on the Clipboard. 

Appendix 1 
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Ruler Menu 

Inch Scale 
Metric Scale 

}-
Change the scale shown on the 
ruler. 

Clear Tab stop .... --fl-- Clears the selected tab stop from 

Set Normal Tab }-the ruler. 

Set Centered Tab Set an aligned tab stop. 
Set Right Flush Tab 

Set Decimal Tab 

No Tab Fi" Pattern 
.. Tab F iI/Pattern 
-- Tab Fi II Pattern 

Tab Fill Pattern 

1 Set a fill pattern at the selected 
,jtabstop. 

""IIIIlii~ _____ • 

Page Layout Menu 
Shows how text is placed on each 
page, including top and bottom 

s .---f!l-- margins and header and footer 
..,IDon't Previ ew Pages text. 

Show Page Ruler 

Hide Page Ruler 

I nsert Page Number 

Insert Page Mark 

Page Ruler Menu 

'" Hides the vertical margin spacing 
~ from the text on the screen. 

i~ "\ Shows or hides the vertical page 
ruler. 

Inserts the current page number 
at the insertion point. 

Inserts a page marker that causes 
a page break. 

Causes text to always print 
together on the same page. 

Allows text to print on whatever 
page it falls on. 

Change the scale shown on the 
1---- vertical page ruler. 



Appendix 2 
Apple Keys 

Some LisaWrite menu items contain the Apple key 
symbol @ followed by a character. 

Menu items that appear with the Apple key symbol can 
be chosen by using the mouse or by pressing the @ key 
and the character associated with that menu item. For 
example, to use the Cut menu item, you first select what 
you want to delete, press the @ key, and while holding it 
down, press the X key. 

The following list shows the characters that can be used 
in combination with the @ key in LisaWrite: 

A Select All of Document 
B Bold 
C Copy 
F Find Next Occurrence 
I Italics 
J Justify 
K Center 
L Left Flush 
N Change & Find Next 
P Plain Text 
R Right Flush 
S Same as on Clipboard 
U Underline 
V Paste 
W Find What? 
X Cut 

Terminate 
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Appendix 3 
Type Fonts 

Type of one size and face is called a font. The "face" is 
the portion of the character that displays and prints. On 
the Type Style menu, some font names are preceded by a 
number that indicates character size. This number 
indicates how many characters will print per inch when 
you use that type font. "PS" in front of a font name 
stands for proportionally spaced. 

The list below shows the fonts as they print. The type 
style of each font is "plain." Each of these fonts also may 
be bold, underlined, and italic. 

You can print any combination of type fonts and styles on 
a dot matrix printer. In order to use them with a daisy 
wheel printer, however, you must have the appropriate 
print wheel for each type font. If you choose a font that 
your printer is not set up to use, an alert message is 
displayed on the screen. 
15 Pi tch Cothic 
12 pitcn Modern 
12 Pitch Elite 
10 pitcn Modern 
10 Pitch Courier 
PS Modern 
PS Executive 

1/4 inch Modem 
1/4 inch Classic 
1/3 inch Modern 
1/3 inch Classic 
Serif faces Sans serif faces 

15 Pitch Cothic 
12 Pitch Elite 12 pitcn Modern 
10 Pitch Courier 10 pitcn Modern 
PS Boldface PS Modern 

1/4 inch Classic 1/4 inch Classic 
1/3 inch Classic 1/3 inch Modern 
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Index 

A 
Add text, B12 
Alert boxes, C21 

Caution message, C22 
Note message, C22 
Printing, B 19 
Stop message, C22 
Wait message, C21 
? message, C22 

Alignment, paragraph, B34, C73 
Alignment, tab, B104, C80 

Overlapping, C84 
Allow to Cross Pages, B95, C61 
Apple keys, 07 
Apple symbol next to menu item, C19 
Arrow, scroll, C15 
Arrow pointer, C12 
Automatic return, see Wordwrap 

B 
Backspace key, B 11, B8, C34, C35 
Bar, scroll, C14 
Boilerplate, 8124 
Bold text, B47, C105 
Box at top of screen, C20 

... LisaWrite Index ::: I E1 
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C 
Capital letters, 87 
Cases Must Agree, 867 
Cases Need Not Agree, 867 
Caution message, C22 
Centered tabs, 8104, 8113, C82 
Centered text, 834, 851, C73 
Change 

Existing text, 88 
Formats, 830, C6 
Left and right margins, 830, 851 
Margins, C59 
Page layout, 884 
Scale of ruler, 886, 898, C57 
Tab alignments, C80 
Tab stops, 8118 
Top and bottom margins, 888, 898, C99 
Type fonts, 847, 848, C 1 03 
Type styles, 852, C 1 03 

Change & Find Next, 871 
Change This Occurrence, 871 
Changing text, automatic, see Find & Change Text 
Character size, see Type fonts 
Check mark next to menu item, C19 
Check pOinter, C 12 
Choose a menu item, C18 
Clear tabs, 8107, 8115, 8118, C85 
Clipboard, 89, 810, 815, 817, 818, C33, C34, C35 
Close multiple views in a document, 863 
Close split view of document, C17 
Complete document, 820, 849 
Copy, 815 

8etween documents, 8127, 8131, C32 
Format style of paragraphs, 844, C33, C48 
LisaCalc into LisaWrite, 8128, 8132, C132 
Margin settings, 844 
Outline format, C49 
Paragraph style, C33, C48, C59 
Text, 815, 823, C32 
Text within a long document, C33 

Create 
New document, 84 
New folder, 849, 852 
Stationery, 8122, 8131 

Cut, 89, 817, C34, C38 



D 
Daisy wheel printer settings, C113 
Decimal tabs, 8104, 8110, C82 
Delete 

8ackspace key, 811, C34 
Return character, C35 
Text, 89, 811, 822, C34 

Delete tab stops, see Clear tabs 
Deselect, 841,846, C14 
Dialog box, C20 

Print, 819 
Search,865 

Disk window, opening, 84, 828 
Display page ruler, 885, 898 
Dividing document, 861, C17 
Document names, 84, 828, 856,C24 
Document window, 857 
Don't Preview Pages, 884, 892, C116 
Dot matrix printer settings, C 112 
Double click, 847 
Double space lines, 840, C66 
Double space paragraphs, 841, C77 
Draft print, C 120 
Duplicate, see Copy 

E 
Edit 

Copy text, C32 
Cut text, C34 
Insert text, C36 
Move text, C38 
Replace text, C41 
Revert to Previous Version, C42 
Undo Last Change, C44 

Edit menu, 89, D2 
Edit text, C5 
Elevator, 858, 860, C 15 
End 

Document, 820, 849 
Paragraph, 87 
Text, C5 

Enter key, 871 
Erase text, see Delete text 
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F 
File document in folder, 849, 852 
File/Print menu, D 1 
Final draft quality, C120 
Find & Change All, 872, C130 
Find & Change Text, 869, 872, C127 
Find Next Occurrence, 866, 867, 869, C124 
Find text, 864, C 124 
Find What, 865, 870, C 124, C 127 
Finished quality print, 819 
Finished with document, 820, 849 
Footer text, 890 
Forced page break, 896, C67 
Format, C47 

Changing, C6 
Copy paragraph style, C48 
Document, 827, 881 
Header and footer text, 889, 890, C53, C56 
Horizontal margins, C57 
Keep lines of text on same page, C61 
Line spacing, C64 
Page breaks, C67 
Page numbers, C69 
Paragraph alignment, C73 
Paragraph spacing, C75 
Stationery pad, C51 
Tab alignment, C80 
Tab clearing, C85 
Tab patterns, C89 
Tab stops, C91 
Text, C5 
Top and bottom margins, C99 
Type styles, C 1 03 

Format for Printer, C110, C118 
Format Paragraph menu, 830, D3 

G 
Get 

Existing document, 828, C25 
Filed document, C25 
New document, 84, 822, C24 
New folder, 849 

Global search and replace, 872, C127 
Go to text, C124 



H 
Header and footer text, 889, C10, C11, C53 

Format, 889, 890, 891 
Move, C54 

Hide dialog box, 866 
Hide Margin/Tab Ruler, 834, C81 
Horizontal margins, 87, C57 
Horizontal paragraph ruler, C8, C9 
Horizontal scrolling, 860 
Hourglass, 815, C12 

I 
Ignore case, 867 
Inch scale, 886 
Indent paragraph, 832, C58 
Insert 

Header and footer text, 889, 898, C53 
Page Mark, 895, 899, C67 
Page Number, 890, C69 
Text, 88, 811, 822, C36 
Wild card, C126 

Insertion point, C12 
Italics, 848, C105 

J 
Justify text, 834, 851, C73 

K 
Keep lines of text on same page, 893, 899, C61 
Keyboard commands, 05 
Keys, Apple, 05 

L 
Left and right margins, C8, C9, C57 
Left flush 

Paragraphs, 834, 851 
Tabs, 8104, 8109,C82 
Text, C73 

Left justified text, 834, 851 
Line spacing, 837, 851, C64 
LisaCalc with LisaWrite, 8128, C 132 
LisaTerminal with LisaWrite, 8130 
LisaWrite concepts, C4 
Locate text, 864, 877, C124 
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M 
Make Stationery Pad, 8123, 8131, C51 
Margin markers, C57 

Left, right, and first line, 832, C8, C9 
Top and bottom, 887, C10, C11 

Margins 
Changing, 830 
First line, 832 
Horizontal, 87 
Left and right, 830, 832, C57 
Standard, 87 
Top and bottom, C99, 885 

Margin/tab ruler, 831, 8106 
Match case, 867 
Menu bar, C4 
Menu item, 01 

Choosing, C18 
Metric scale, 886 
Move 

Header and footer text, C54 
Icons, 849 
Tab stops, C93 
Text, 816, 823, C38 
Text from LisaCalc to LisaWrite, C132 
Text from one document to another, C38 
To bottom of document, 860 
To top of document, 860 
Within document, 856, 858, 864 

Multiple documents, viewing, 8123, 8131 

N 
Name 

Document, C24, 84, 828, 856 
Folder, 849 

Normal tabs, C82 
Note message, C22 
Number pages, C69 

o 
One and one-half space lines, C65 
One and one-half space paragraphs, C76 



Open 
Clipboard, 810 
Disk window, C24, 84, 828, 856 
Document window, C24, 84, 828, 856 
Folder, 828, 856 

Orientation, paper, C112 
Other tools, C 132 
Outline format, C49, C94 

p 
Page, C7 
Page breaks, 892, C67 
Page layout, 881 

Change, 884 
Menu, 882, D4 

Page length, standard, 884 
Page marks, 895 
Page numbers, B90, 891, C69 
Page ruler, B85, 886, C10, C11 

Inch or metric scale, 886 
Length, C101 
Menu, C10, C11, D4 

Paper length, C112 
Paper orientation, C 112 
Paper size, C 113 
Paragraph 

As unit of text, 87, 833, C7 
Definition, C7 
Dividing, B16 
Format, C7 
Indenting, 832 
Merging two, C7 
Selecting, 816 

Paragraph alignment, 834, C73 
Paragraph ruler, C8, C9 
Paragraph spacing, 87, 837, 852, C75 

Double space, C77 
One and one-half space, C76 
Single space, C76 
Triple space, C77 

Paste, 816,818, C38 
Patterned tabs, C89 
Pitch, see Type fonts 
Pointers, C 12 
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Preview document, 883, 898, C10, C116 
Preview Pages, 883, C116 
Print, C109, C118 

Dialog box, 819 
Document, 818, 824, C118 
Format for specific printers, C110 
Menu, C110 
Number of copies, C 122 
Preview a document, C116 
Print document, C 118 
Quick draft, 819 
Text on same page, 893, 899, C61, C67 
Which pages, C122 
While you work, 819 

Print document on specific printer, C 11 0 
Print quality, C120 

Quick draft, 819, C120 
Print speed, C120 

While you wait, C120 
While you work, C121 

Print wheels, C113 
Printing, problems with, C113, C114 
Put document away, 820, 849 

Q 
Quick draft, 819, C120 

R 
Remove page numbers, C69 
Replace text, 811, 823, C41 
Resize document, 89, 8125 
Resolution, C112 
Retrieve document, 828, 851 
Revert to Previous Version, 875, C42 
Right flush, 851 

Paragraph, 834, 851 
Tab, 8104, C82 
Text, C73 

Right justified text, 834, 851 



Ruler, C8, C9, C10, C11 

S 

Display, see Show Margin/Tab Ruler 
or Show Page Ruler 
Horizontal, 832, C57 
Horizontal, width, 861, C59 
Inch and metric scales, 886 
Markers, 832 
Menu, 8106, C8,C9, D4 
Scale, C8, C9, C57 
Vertical, 885 

Same as on Clipboard, 844, 845, C59 
Save & Continue, 815, 873 
Save & Put Away, 8116, 820, 849, 897, 8129 
Save documents, 814, 823 
Scroll, 857, 877, C14 

Automatic, 857 
Document, 836 
Text, 817 
To the bottom, C17 
To the top, C17 
Vertically, 836 

Scroll arrow, 858, 859, 861, C 15 
Scroll bar, 858, C4, C14 
Search, C 123 

Dialog box, 865, C125 
Find and change text, C127 
Find text, C124 
For text, 864, C 124 
Menu, 866, 02 

Search and replace, 870, C 127 
See top and bottom margins, see Preview Pages 
See two parts of document at once, C 17 
Select, C12 

All of Document, 830, 839 
Insertion point, C13 
One word, C 13 
Paragraph, 816, C13 
Text, 89 
Words, 847 
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Set 
Centered tab, 8113, 8117 
Decimal tab, 8110, 8117 
Header and footer text, 889 
Line spacing, 851 
Margins, C57 
Normal tab, 8109, 8117 
Paragraph spacing, 852 
Patterned tabs, C89 
Right flush tab, 8107 
Tab alignments, C80 
Tab fiJI pattern, 8111, 8118 
Tab stops, 8105, 8117, C91 
Top and bottom margins, C99 
Type styles, C103 

Set aside document, 8128 
Show Margin/Tab Ruler, 8106, 831, C57, C80 
Show Page Ruler, 885, 898 
Show two documents at once, 8126 
Single space lines, 841, C65 
Single space paragraphs, 839, C76 
Space between paragraphs, see Paragraph spacing 
Spacing 

Available settings, 839 
Double space lines, 840 
Double space paragraphs, 841 
Line, 837, 851, C64 
Paragraph, 837, 852, 87, C75 
Single space lines, 839, 841 
Single space paragraphs, 839, 841 

Split control, 858, 861, C4, C15 
Split document window, 861, C17 
Standard formats, stationery pad, C52 
Standard margins, 87 
Standard page length, 884 
Start 

New document, C24, 84 
New page, C67 

Stationery pad 
Make, 8122, 8131,C51 
Standard formats, C52 
Using, 84 

Stop message, C22 
Subscripts and super scripts, C103 



T 
Tab,8104 

Centered, 8113 
Clearing, C85 
Decimal, 8110 
Fill patterns, 8111 
Left flush (normal), 8109 
Marker, 8107, C8, C9 
Patterns, 8111, C9, C89 
Right flush, 8107 

Tab alignment, 8104, C9, C80 
Overlapping, C84 

Tab stops, C8, C9, C91 
Moving, C93 

Text, definition, C7 
Top and bottom margin markers, 887, C10, C11 
Top and bottom margins, C10, C99 
Top and bottom margins, hide, 884, 892, C116 
Top and bottom margins, viewing, 883, C 116 
Triple click, 816, C13 
Triple space lines, C66 
Triple space paragraphs, C77 
Type fonts, 845, C103, D9 

Changing, 847, 848 
Guidelines, C104 

Type in document, 87 
Type Style menu, 846, C103, D3 
Type styles, C 1 03 

8old,847 
Changing, 852 
Guidelines, C105 
Ital ics, 848 
Underline, 846, 847 

U 
Underline text, 846, 847, C105 
Undo all changes, 875, C42 
Undo Last Change, 817, 823, C35, C44 
Uppercase text, 87 
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V 
Vertical page ruler, 885, C10, C11 
Vertical scrolling, 858 
View 

Multiple documents, 8123, 8131 
Top and bottom margins, C 117 

View button, 858, 859, C15 

W 
Wait message, C21 
Wild cards, C126 
Window, document, 857 
Wordwrap, 813, C5 
Work with more than one document, 8123 
Write in document, 85, 87 

? message, C22 



029-0460-A 

LisaWrite Update 
Release 2.0 

Read This First 
Please insert these pages in front of the table of contents of 
your Lis8Write manual. 

INTRODUCING THE LISA 2 

New Hardware on the Lisa 2 
As you go through the Lis8Write manual, you'll notice a few 
differences between your Lisa 2 and the Lisa shown. Because 
most changes from the Lisa to the Lisa 2 involve new hardware 
and a new Lisa operating system, your owner's guide has been 
completely rewritten. Few changes have been made to LisaWrite; 
those changes are described in the next few pages. 

New Icons on the Desktop 
Some of the icons on the desktop of the Lisa have changed since 
the Lis8Write manual was written. The table on the next page 
shows the differences between the icons shown in the manual 
and those you see on the Lisa screen. 

For a complete explanation of the· functions of the new icons, 
refer to Section B, Desktop Manager Reference Guide, in the 
Lis8 2 Owner's Guide. 



COMPARISON OF LISA ICONS 

Use the table below to identify differences between your Lisa 2 
desktop and the desktop shown in the LisaWrite manual. 

Manual 

I·· .1 
PrOFile 

W·-
• 1 

Diskette 

v'Pictorial 
Alphabetical 
Chronological 

Straighten up Icons 

Lisa 2/10 

[[j 1 
Internal Hard Disk 

DiSkette 

Eject "D iskette" 

v'Pictorial View 
Alphabetical View 
Chronological View 
Straighten up Icons 

Repair "DiSkette" 
Erase "Diskette" 

Lisa 2/5 

I.. ·1 . .. 

Diskette 

ictorial View 
Alphabetical View 
Chronological View 
Straighten up Icons 

Repair "Diskette" 
Erase "Diskette" 
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Lisa Wri te Enhancements 

MARGIN/TAB RULER DESIGN 

The new margin/tab ruler is slimmer, and it uses two kinds of 
brackets instead of triangles with letters. 

( 
[ 

Left margin of ~ line OfC!) 
I I I I I II I I I I I I ~ I I I I I I Iii I I I I I I I ~ I I I I I I I II I I I :mmm 

Left mor:in of all other lines of~:ght mergin for all lines O:<D ~1 
PAGE RULER DESIGN 

The new page ruler is slimmer, and it uses various bracket 
designs instead of triangles with letters. 

Header line 

First line of every page 1 
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RULER MENU ITEMS 

There are two new ruler items. The Set Decimal"." Tab menu 
item uses a period as a decimal point (US). The Set Decimal" ," 
Tab menu item uses a comma as a decimal point (European). 

Metric Scale 

Clear Tab Stop 
Set Normal Tab 
Set Centered Tab 
Set Right Flush Tab 
Set Decimal "," Tab 
Set Decimal "," Tab 

No Tab Fi II Pattern 
.. Tab Fi II Pattern 
-- Tab Fill Pattern 

Tab Fill Pattern 

CHANGES IN RULER MEMORY 

If you change to metric ruler measurements and then save a 
document, you'll still have metric rulers the next time you open 
the document. In the original LisaWrite, the ruler had to be 
changed back to metric each time the document was opened. 

When you change the measurement for one ruler, LisaWrite 
automatically changes the other ruler to that measurement. For 
example, if you change the Margin/Tab Ruler to metric, the Page 
Ruler will also display in metric. 
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NEW NONBREAKING SPACE FOR KEEPING WORDS ON THE SAME LINE 

If you wish to keep all words of a phrase or expression on the 
same line, press and hold down the [OPTION] key while 
pressing the space bar between words. 

For example, using just the space bar, words in the phrase 
computer generated might be split over two lines. Using the 
space bar plus [OPTION], the words computer generated can be 
kept together on the same line. 

CHANGE TO SEARCH MENU 

If you type an a in the dialog box that appears when you choose 
Find What? from the Search menu, and then choose Cases Need 
Not Agree, you will find all the forms of a that might be 
contained in your document; that is, a and A. 

If you want to find only lowercase a, choose Cases Must Agree 
from the Search menu, and you'll just find all the a's. That is, 
you will find exactly what you type in the dialog box. Note that 
LisaWrite ignores typestyle in searches; it just looks for the 
letters. 

PRINTER FORMATS 

You now can select common metric sizes for printing paper in 
the dialog box that appears when you choose Format for Printer 
from the File/Print menu. 

Also, some printing terminology has changed. You now have a 
choice of High Resolution (better quality but slower) or Low 
Resolution (faster). 
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BE AWARE 

Figures in the Manual 
The figures in the manual may not always match what you see on 
your screen. You need not be concerned about this 
discrepancy. 

Tutorial Changes 
LisaWrite paper provides 1-1/2 blank lines between 
paragraphs. However, Chapters 1 and 2 of the LisaWrite 
tutorial assume two blank lines between paragraphs. As soon 
as you start a new document in Chapter 1, choose Double Space 
from the Format menu. 

On page B45 of the LisaWrite tutorial, triple-click before you 
choose Same as on Clipboard from the Format menu. 

Right Margin Versus Paper Size 
Do not set the right margin beyond 8 inches when printing on 
8-1/2 by 11 inch paper or on 8-1/2 by 14 inch paper, because 
the Lisa doesn't print beyond 8 inches. In landscape printing, 
the document will not print below 8 inches on any page. 

Page Marks 
If you insert a page mark in the first line of a paragraph whose 
first-line and left margins differ, the first line will align against 
the left margin, and not against the first-line margin. To 
correct this misalignment, type a paragraph return after the 
page mark. To add paragraph return, set an insertion point to 
the left of the first character following the page mark and press 
the [RETURN] key. 
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To remove any page mark, set the insertion point to the left of 
the character at the beginning of the line following the page 
mark and press the [BACKSPACE] key. 

Printing a Range of Pages 
When page marks fall at the end of pages in the range that you 
specify in the Print dialog box, an alert message may appear 
saying that there are no pages in that range. 

To print the pages anyway: 

1 ~ Choose Preview Pages from the Page Layout menu. 

2 ~ Scroll to the end of the document. 

3 ~ Choose Print from the File I Print menu and fill in the dialog 
box, as usual. 
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